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2 CHAPTER

Note: Visit our website at www.blackbaud.com for the latest documentation and information.

Accounts Receivable includes many standard reports to help you produce and view information you need quickly
and easily. Reports in Accounts Receivable are valuable tools for monitoring, evaluating, and distributing
information about your billing and customer information.

This chapter explains the basics of Reports, including procedures for creating, printing, previewing, exporting, and
sending reports as email. Each report is described in detail in the chapter for that report category, except for
pivot reports which are discussed in the Pivot Reports Guide for The Financial Edge.

Basic Reporting

The Reports page is the central location for reporting in Accounts Receivable. From the navigation bar, select
Reports to access the Reports page. This page contains links to each report category. When you select a link, the
program displays a list of the reports in that category.

[FE| The Financial Edge (Sample Data) [_ O[]
File Edit Wiew Go Favorites Tools Help
# Back % Forward | Community Services Inc. * Accounts Receivable - |
a Reports
Reports I
b Action Reports P Deposit and Receipt Reports P
b Analysis Reports b Pivot Reports Reparts
b Banrk Account Reports b Product and Billing Itern Reports Analysis
¥ Client Reparts Pk Reconciliation Reports Reparts
b Custom Reports b Transaction Reports Bank
Account
Reparts
Client
Manage Tags... Open Delete.. Find... Reports
Mame Categaory Tvpe |Created Customn
Reports
Deposit and
Recept
Reports
Pivak
Reports
Product and
Billing Item
Reports
Reconcili,..
Reports
Transackion
Reports
KV ol
[~ Orly show my reports
‘Welcome to Accounts Receivable | ]

Accessing Reports

Note: Report tabs appear so you can select other report categories. You can right-click to align the tabs on the
left, right, top, or bottom. If tabs are hidden, select View, Navigation Tabs from the menu bar.
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To select a report, click the link for the category of reports you need from the Reports page. For example, click
Client Reports.

=]

TE The Financial Edge (Sample Data)
File Edit Wew Go Favorites Tools Help

# Back % Forward | Cormmunity Services Inc. ' Accounts Receivable = | Resource Center
I2 Reports « Client Reports
Client Account Activity List New Open Delete.. Find... Reports
Client Account Activity Report % R

ey -pEse | Client Statistics Report

Client Profile Report
; i et eor Mame ‘Date Created ‘Created Ey |Process Time |Others May Madify | Analysis
LB Client Report Reparts

i}

Action
Reports

B

Bank
Account
Reports

Client
Reports

Cuskarn
Reports

U

Manage Tags...

Deposit and
[ an Receipt
“[~ Untagged Reports

Pivok
Reports

i

Product and
Billing Ttem
Reports

Reconcili,.,.
Reparts

Transaction
Reports

i

L] | il

[~ Only show my reports

ﬂ The Client Statistice Report provides a tally of clients by specific criteria

‘Welcome o Accounts Receivable |

B

On the Client Reports page, select Client Account Activity Report from the list on the left. If any client account
activity reports have been saved, they appear on the right of the screen. You can open one of the saved reports or
create a new report. To open a saved report, select the report type and double-click the report in the frame on
the right.

Manage Tags

The Manage Tags feature allows you to better organize and filter your Financial Edge report parameters. For
example, you can filter all of your saved report parameters by tags and categories, such as “Reconciliation” or
“Fiscal Year 2012.” When you mark the checkbox to show a tag or category on a reports page, only the report
parameters with that specific tag and category display.

To create and manage report parameter tags, simply select Manage Tags below the list of reports on any Reports
page. You can create as many categories and tags as you need, and when necessary, mark tags inactive.

To tag a report parameter, simply right-click an existing parameter and select Tags from the menu. Every
category and tag you have created in that module appear on the list.
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» Manage report tags

From Reports, select Manage Tags. The Manage Tags screen appears. From here, you can add new tags

and categories, or edit and delete existing tags and categories. You can also use the arrows in the top
right corner of the screen to move items up or down in the list.

48 New Edt 7 Delete

-Year
2012

- Purpose
Auditars
Recaonciliation

EHsave | Cancel |

2. Select New to add a new tag and category. The Add Tag screen appears.

LCateqgony: ||
Tag |
[V Active
[E save | Cancel |

Enter a report category and name for the tag. If you want the tag to be active, mark the checkbox.
4. Select Save. You return to the Manage Tags screen.

You can also edit and delete tags, as well as organize your list of categories and tags. You can change the
name or delete categories and tags at any time.

6. Once you have made your changes, select Save.
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» Tag areport parameter

1. To tag a report parameter, simply right-click an existing parameter and select Tags from the menu. Every
active category and tag you have created in that module appear in the menu list.

€ The Financial Edge {Sample Data) [_ O] x

File Edit Vew Go Favorites Tools Help

4 Back # Forward | Community Services Inc. * General Leclger '|

@ Reports+Journal and Batch Reports

E Batch Det: : Mew Oper Delete.. Find | Reports |
(3 Batch Summany Feport 7 Account
EEEOS LR e Batch Retail Report Reports
R Batch & R
1 PEUTING Baten SUMMEWRER |y me ‘Date Created |Crsated Ey ‘Prucsss Time |Others May Modiry | Allocation
j Tranzaction Journal Reports
‘ Tags ‘ ‘ear 2013 Budget
o Reparts
1 Mew Batch Detail Report PUrpose " 201z B
L R Custam
L5 Open Manage Tags 4F MewTag Reparts ‘
X Delete... Financial
Save As... Statements
Manage Tags. ag; Rename... GASE 34
_— 7 Repotts
|_7 All =% Print Grant
L =
: ~ lagged Wl Preview Reports
Yeal r,
ﬁ Export Journal and
send as Mail gaetcgrts
Purpose E ? L
¥ Auditors :Vﬂt 3
¥ Reconciliation & Eind... Qrl+F SRS
}_Q} Export Batch Detail Report List Grid.. . :ro]ectt
eports
Export Batch Detail Report List Grid to Excel... s
Columns, ..
[+ Properties

Prrog LI
I~ Only show my reports

The Batch Detail Report provides detailed information about selected batches and the
tiansactions within those batches

|\Nelc0me to General Ledger |

RS

2. Select the category and tag. You return to the Reports page.

Tabs

Whether you create a new report or open a saved report in Accounts Receivable, a screen appears with tabs to
specify how the report should look and the information included in the report. The reports include the General,
Filters, and Format tabs. To navigate among a report’s tabs, select the tab itself or use Back and Next. Once you
learn to run one report, it is easy to run other reports because many of the tabs have similar features.

Reports in each category have common tabs with similar selections. Remember that records must satisfy all
parameter settings you select for the report before they are included in the report. If you select to include clients
with a zero balance on the General tab, this does not mean all clients with a zero balance appear on the report. A
selected date range or a filter can eliminate some clients.

Note: Keep in mind that options, fields, and other selections vary from report to report.

Following are pictures of each tab in Reports in Accounts Receivable. Keep in mind that options, fields, and other
selections vary from report to report. See the chapter in this guide for the report category for more details about
each report.
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General Tab

On the General tab, define parameters and select information to include in the report. All Accounts Receivables
reports use the General tab. Typical selections on General tabs include setting date ranges, creating an output
query of records included in the report, and setting the report orientation.

lﬂ Mew Client Account Activity Report E |
File Edit Wiew Favorites Tools Help

HRS RS 2 |

1: General | 2 Filtersl = Fnrmatl

Include transactions with these dates.

Transaction date: [ IEEEEE S

-Include clients with:
v Mo activiby
¥ A balance over: |$EIIJD—
v & credit balance
¥ A zero balance

[~ Display a summary balance for ransactions before: I

Show client balance a3 of: | Today v | 05/23/2003

[~ Create an output query of clients

Report arientation: IF'urtrait 'I

< Hack I Meuxt » | Cancel I Frrint Presiew Layout

Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply a
clients filter, only clients you select are included in the report.
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On the Filters tab, you include records based on selected criteria. For example, you can run a Client Account
Activity Report and include only transactions with a post status of Not Yet Posted. Transactions with other post
statuses, such as Posted or Do Not Post, do not appear on the report. All Accounts Receivable reports use the
Filters tab except the Bank Register Report, which uses the Filters button found on the General tab. For more
information about filtering criteria, see the Program Basics Guide.

A& New Client Account Activity Report
File Edt “iew Favonter Tools Help
W& SR 2 |

1: General e Formatl

Filkers I Include Selected Filkers

Payer Clients all <l Payver Clients =

Paver Client Statuses all <hll Payer Client Statuses =

Recipient Clients all =all Recipient Clients =

Recipient Client Statuses all <Al Pecipient Client Skatuses =

Payer Client Attributes all <l Payver Client Attributes =

Recipient Client Attributes Al <Al Recipient Client Attributes =

Charges all <Al Charges =

Credits all il Credits =

Payrments all <Al Paymentsz

Post Statuses all <Al Post Statuses=

Transaction Attributes all <Al Transaction Attributes =

Products and Biling Items all <l Products and Gilling Items =

Product and Billing Item At... Al <Al Product and Billing Item Attributes =

< Back | Ment » | Cancel Frint Prewiew Layout

Format Tab

On the Format tab, you designate the format of the report. Settings on this tab determine the appearance of the
report. You can create headings, page footers, and report footers. You can select to include the list of report
criteria on the report, select the format for displaying monetary amounts, select the font size, and select colors
for the report. On some reports, you can select additional report details and order information on the report. All
Accounts Receivable reports use the Format tab.
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The list on the left of the screen displays formatting options for the report. When you select an item in the list,
the right side of the screen changes to present selections for that section of the report. Formatting options can
vary for each report. For information about formatting a specific report, read about the report in its respective
chapter.

I Hew Client Account Activity Report 1]
File Edit “iew Fawvoiter Tools Help

BRE R0 |
|

Headings Detail

1. General I 2: Filterz

Criteria
Repotty [Poper =]

ﬁorta’BFrear Repartin: |Detail =] and | show | recipient details
age Footer

Repart Footer Shiow IF'ayment reference j in the payment detail column
Mizcellaneous
Color Scheme

[~ Show credits/payments with their associated charges
[~ Show invoicedretum line item detail

Show Ilnvuice information "I

Clent S alutation: IEIienl narne j

< Back | HEwts Cancel Frint Prewiew Layout

Report Categories

In Accounts Receivable, reports are divided into categories: Action Reports, Analysis Reports, Bank Account
Reports, Client Reports, Deposit and Receipt Reports, Pivot Reports, Product and Billing Item Reports, and
Transaction Reports.

Action Reports

e Action Listing

e Action Summary Report

¢ Actions by Association Report
Analysis Reports

Aged Accounts Receivable Report

Open Item Report

¢ Service and Sales Analysis Report

¢ Service and Sales Trend Analysis Report
Bank Account Reports

¢ Bank Profile Report

¢ Bank Reconciliation Report

¢ Bank Register Report
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Client Reports

Client Account Activity List

Client Account Activity Report

Client Account Balance Report

Client Profile Report

Client Statistics Report
Custom Reports

Deposit and Receipt Reports
¢ Cash Receipts Report

e Deposit List

e Deposit Report

Note: Pivot reports are available in The Financial Edge only if you have Microsoft Excel 2000 or Excel XP
installed on your computer. For more information about Pivot Reports, see the Pivot Reports Guide for
The Financial Edge.

Pivot Reports

Product and Billing Item Reports

¢ Product and Billing Item List

¢ Product and Billing Item Report

Reconciliation Reports

¢ Account Distribution Report

¢ Aged Accounts Receivable Report

e Open Item Report

Transaction Reports

¢ Account Distribution Report

¢ Invoice Report

¢ Project Distribution Report

e Recurring Invoice Report

¢ Sales Tax Report

e Transaction List

¢ Unapplied Credit Report

Reporting Procedures

Note: You can use a variety of parameters to define the output for reports in Accounts Receivable. Saving
these parameters also makes future reporting easier.

The following procedures provide instructions for creating, printing, previewing, exporting, and sending reports
as email. While these procedures are written specifically for client reports, you can use these same basic steps as
a model for all reporting in Accounts Receivable. For specific information about tabs, fields, options, and
checkboxes for a particular report, see the chapter for that category of reports.
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Creating Reports

Creating a report is a quick and easy process. For this procedure we focus on creating a Client Account Activity
Report.

» Creating a report in Accounts Receivable

Note: An action bar containing links for creating a new report, opening a report, and deleting a report appears
above the list of reports. These links are common to all Reports pages.

1. From the Reports page, click Client Reports. The Client Reports page appears with a list of all client
reports on the left.

2. Inthe list on the left, select Client Account Activity Report.

File Edit view Go Favorites Tools Help

4 Back % Forward | Community Services Inc, * Accounts Receivable-|

\2 Reports - Client Reports
) Client Account Activity List New Open Delete. . Find
3 Client Account Activity Feport = R
3 Client Account Balance Fieport Client Statistics Report
é Clent Mame |Date Created |Created By |Process Time |0thers May Madi
Manage Tage...
I Al
L~ Untagged
K| {
[~ Only show my reports
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3. On the action bar, click New. The New Client Account Activity Report screen appears.

l@ Mew Client Account Activity Report I
Eile Edit Wiew Favorites Tools Help

RS R0 e 2 |

1: General |2: Filters | & Formatl

Include tranzactions with these dates.

Transaction date:

|nclude all dates

Include clients with:

v Mo activity

¥ & balance over: |$IJ.DD

¥ & credit balance

v A zero balance

[~ Dizplay & surnmary balance for tansactions before: I
Show client balance as of: Inga}. vl 05/23/2003

[~ Create an output quem of clients

Report arientation; I Partrait % I

< Bach | Mext = | Cancel | Print | Freview | Layout

4. In the Transaction date field, select a date or date range for the transactions to include in the report.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all
activity is included up to the end date. If the End date field is blank, all activity from the start date
forward, including items with a transaction date in the future. If both fields are blank, all activity is
included.

5. Inthe Include clients with frame, you can mark checkboxes to include clients with no activity; designate a
minimum balance the client must have to be included; include clients with a credit balance; and include
clients with a zero balance.

6. Toinclude a summary balance on the report, mark Display a summary balance for transactions before [ ]
and enter a date up to which to summarize transactions.

7. Inthe Show client balance as of field, enter the end date for reporting the client’s balance.
8. To create a static query of the clients include in the report, mark Create an output query of clients.

9. In the Report orientation field, select “Portrait” for the report to appear vertically or “Landscape” for the
report to appear horizontally.
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10. Click Next or select the Filters tab.

File Edit Yiew Favortes Tools Help
== R el |
1: General 2 Format |
Filters | Include I Selected Filkers
Paver Clients all <Al Payer Clients=
Paver Client Statuses all <all Paver Client Statuses >
Recipient Clients all <All Recipient Clients >
Recipient Client Statuses all <Al Recipient Client Statuses =
Paver Client Attributes all <All Payer Client Attributes =
Recipient Client attributes Al <l Recipient Client Attributes:
Charges all <Al Charges=
Credits all <Al Credits =
Payments all <All Payments =
Post Statuses all <Al Post Skatuses=
Transaction Attributes al <Al Transaction Attributes >
Products and Billing Ttems all <Al Praducts and Billing Ttems=
Product and Eilling Item At... Al <All Product and Billing Item Attributess
< Back | Hest » | Caticel | Brirt | Preview | Lapout |
|

11. You can filter information appearing in the report. For example, you may want to include only post
statuses of “Not Yet Posted”. In the Include column in the Post Statuses row, choose “Selected”. The Post
Statuses screen appears.

Post Statuses

Post Statuses

Posted
Do not post

2l ¥+

Ok I Cancel |

12. Select “Not yet posted” and click the right arrow to move it into the Post Statuses box. Only transactions
with the post status of “Not yet posted” are included in the report. Click OK to return to the Filters tab.

13. When you finish selecting filters, click Next or select the Format tab. The Format tab appears. On the
Format tab, the right side of the screen changes as you make selections in the list on the left.

14. From the list, select Headings. The program assigns a name in the Title field based on the record type; in
this case, “Client Account Activity Report”. You can change this title.



15. In the Subtitle field, enter a subtitle for the report.

u MNew Client Account Activity Report
File Edit Yiew Favortes Tools Help

== = ?-

1: General ] 2 Filters ~ 3: Format l

=] Criteria

2 Detail Heading Format
5] Sort/Break Title:  [Clisnt Account Activity Report

5] Page Focter Subfitle: [July Rreport
] Report Footer

=] Mizcellaneous Aligr;  [Center -

Calar Sch . . .
=] Lolor Scheme [ Print organization name in header

[v Frint Page Number in Heading [V Fiint Feport Date in Heading
Farrnat: |F'age 1 j Farrat: |Short [rate and Time ﬂ
Align: [Right =] | Al [Lett =

[ Print report heading on each page

< Back | | Caticel | Brirt | Preview | Lapout |
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16. You can select other formatting options from the list on the left. For example, select Detail.

u New Client Account Activity Report
File Edit View Favortes Toolz Help

H &2 %W Y

1: General ] 2 Filters

Z] Headings Detail

] Criteria
Repottby [P 7]
=] Sort/Break

5 Page Fool Report it |Detail j and |Show j recipient details.
age Footer

=] Report Footer Show |Fayment reference | = | in the payment detail column

2] Miscellanzous

5 Calar Sch [~ Show credits/payments with their associated charges
olor Scheme

[ Show invoicedreturn line item detail
Shaw

Clignt Salutation: | Client name ﬂ

< Back | | Cancel | Print Preview Lapout

17. Inthe Report by field, select “Payer” or “Recipient”.

18. In the Report in field, select “Detail” or “Summary” and whether to show or not show payer or recipient

details.
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Note: If you have the appropriate security rights, you can use credit card, bank account, and Social Security
numbers to sort report data and to identify records included in the report. The Sort by option is hidden for any
user without these rights. For more information, see the Security chapter of the Administration Guide for The
Financial Edge.

19. If you are reporting by payer, select to show the payment reference or payer information in the payment
details.You can also mark a checkbox to include applied credits and payments immediately after their
associated charges.

20. Invoices are summarized on the report. To show the invoices broken down to line item details instead,
mark Show invoice/return line item detail. In the Show field, you can select for the line item description
to be invoice information (invoice and line item number) or the billing item description.

21. Inthe Client Salutation field, select a client salutation to determine how client names appear on the
report.

Note: Click Preview to view the report as it will print using your selections and filters. Click Layout to view a
sample layout of the report without data.

22. When you finish making formatting selections, click Preview to preview your report. A message appears
indicating the program is processing the report. The report preview screen appears.

23. When you are finished viewing the report, you can print the report and click the red X to close the report.
24. Click Save on the action bar to save the new report. The Save Report as screen appears.

Save Report as

Report name: I

Description:

V¥ Others can wn thiz report
™ Others can modify this repart

Egave | Caricel |

25. In the Report name field, enter a descriptive name for the report. For example, “Recipient, detail by
payer”.

26. In the Description field, you can enter more details about the report. For example, “Month-to-date”.
27. You can mark checkboxes to allow other users to run or modify the report.

Note: You can set an option to save selections made on report tabs when you close. In Reports, select Tools,
Options and mark Automatically save report parameters on close.

28. Click Save. You return to the Client Reports page.

Printing Reports

You can print a hard copy of a saved report without opening the report. Your selections on the Format tab of the
report determine the information that prints on the report and how it is formatted.

Note: The user who created the report controls the right of others to modify or run the report.

For this procedure, we focus on printing a Client Account Activity Report. For more information about setting up
your printer, see “Setting Up Printers” in the Program Basics chapter of the Program Basics Guide.
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» Printing an Accounts Receivable report

1. From the Reports page, click Client Reports. The Client Reports page appears. A list of all client reports
appears on the left of the page.

2. Inthe list on the left, select Client Account Activity Reports. A list of saved client account activity reports
appears in the grid on the right.

Note: You can set an option to print the report using the orientation defined either in Print Setup or on the
report’s General tab. In Reports, select Tools, Options and mark As defined in Print Setup or As defined for the
Report.

3. Inthe grid on the right, select the report to print.

Eile Edit View Go Favorites Tools Help

Bl

4 Back # Forward ‘ Commmunity Services Inc, * Accounts Receivable '|

12 Reports « Client Reports

EIlsntAccuuntAclMly List New Open Delete.. Find

2] Clignt & t Activity Feport
CENNRAISIN | it Statistics Report
B

Marme |Date Created ‘Created By |Pmcess Tirme |0thers May Modi

Manage T ags...

Al
L-[T Untagged

[« |

[~ Only show my reports

4. From the menu bar, select File, Print. A message appears indicating the report is printing. After the report
prints, you return to the Client Reports page.

Previewing Reports

You can preview the format and information in a report without opening the report. We recommend previewing
a report before printing or sending it to another person. By previewing, you can make sure you included the
required information and that the report is formatted as you want it. For this procedure, we focus on previewing
a Client Account Activity Report.

» Previewing an Accounts Receivable report

1. From the Reports page, click Client Reports. The Client Reports page appears. A list of all client reports
appears on the left of the page.

2. Inthe list on the left, select Client Account Activity Reports. A list of saved client account activity reports
appears in the grid on the right.
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3. Inthe grid on the right, select the report to preview.

File Edit View Go Favorites Tools Help

4 Back # Forward ‘ Community Services Inc, * Accounts Receivable -|

12 Reports - Client Reports

Client Account Activity List New Open Delete... Find...

Client Account Activity Report = e

BT e el Client Statistics Report

= fi _" Mame: |Date Created ‘Created By |Process Time |0thers May Modi
LS Client £ tepor

Manage Tags.

Al
L.[” Untagged

K|

[~ Only show my reports

Note: You can set an option to maximize the preview window when you preview a report. In Reports, select
Tools, Options and mark Automatically maximize preview window.

4. From the menu bar, select File, Preview. A message appears indicating the program is processing the
report. The report preview screen appears.

5. When you are finished previewing the report, click the red X to close the screen. You return to the Client
Reports page.

Exporting Reports

To use report information in another software application, for example, Microsoft Excel or Crystal Reports, you
can export the report. When you export a report, you send report information from the database to another
software application using a data file. You can export a report without opening the report.

For this procedure, we focus on exporting a Client Account Activity Report in spreadsheet format.

» Exporting an Accounts Receivable report

1. From the Reports page, click Client Reports. The Client Reports page appears. A list of all client reports
appears on the left of the page.

2. Inthe list on the left, select Client Account Activity Reports. A list of saved client account activity reports
appears in the grid on the right.



REPORTS BAsIcs 17

3. Inthe grid on the right, select the report to export.

File Edit View Go Favorites Tools Help

4 Back % Forwarnd ‘ Community Services Inc, * Accounts Receivable -|

42 Home 2 Reports - Client Reports
L Client Account Activity List MNew Open Delete.. Find...

Client Account Activity Report = e

BT e el Client Statistics Report

= i MNarne: |Date Created ‘Created Ey |Process Time |0thers May Madi

i epor

Manage Tags

Al

L.[” Untagged
dministration

L« | I
[~ Only show my reports

4. From the menu bar, select File, Export. A message appears indicating the program is processing the
report. When processing is complete, the Export screen appears.

In the Format field, select the file format. For this example, select “Excel 5.0 (XLS)".
6. Inthe Destination field, select the file destination. For this example, select “Disk file”.

Export [ X]

Format:

|Excel 5.0[<LS) =l

L Cancel |
Destination:
[Disk file =l

7. Click OK.
The Choose Export File screen appears. The program assigns a name in the File name field based on
report type and system information. You can change this name.

Choose Export File HE
Savein: [y Temp =l e ®merE-

@
[ op

[y
#

1] y Do

File nare: IEIienMccounL&ctivit}l.Hls j Save I
j Cancel |
7

Save as type: IEHCE| 5.0 (%)
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9. Navigate to the folder in which to save the export file.

10. Click Save. A message appears indicating the program is exporting the data. Once the data has been
exported to your file, you return to the Client Reports page.

Sending Reports as Email

Note: Sending report results by email can be particularly useful when an individual needs to quickly refer to
report results but does not need to access or edit the report.

In Accounts Receivable, you can share report information with other users through electronic mail. For example,
you can send the results of a report to another user for further analysis or to use in other applications.

Before you can send a report to another user, you must first select a format (dBase, Lotus 1-2-3, Microsoft Excel)
for the data file. The format determines the appearance of the report and the software applications in which you
can open the data file.

You can send report information by email without opening the report. For this procedure we focus on sending the
Client Account Activity Report created in “Creating Reports” on page 10.
» Sending an Accounts Receivable report as email

1. From the Reports page, click Client Reports. The Client Reports page appears. A list of all client reports
appears on the left of the page.

2. Inthe list on the left, select Client Account Activity Reports. A list of saved client account activity reports
appears in the grid on the right.

3. Inthe grid on the right, select the report to send in an email.

FE The Financial Edge {Sample Data)

Elle Edit ¥ew &o Favorites Tools Help

* Back # Forward | Community Services Inc. * Accounts Recewablev|

12 Reports - Client Reparts

Client &ccount Activity List Mew Open Delste.. Find
Client Accaount Activity Repart

BT L el | Client Statistics Report
Client Profile Report
Client Stalistics Fleport

Narne ‘Date Created |Created By |Process Time ‘Others Wy Modi

Manage Tags...

[ al
L. Untagged

KT

[~ Only show my reports
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4. From the menu bar, select File, Send as Mail. A message appears indicating the program is processing the

10.

11.

report. When processing is complete, the Export screen appears.

Export [ X]
Format:
|Excel 5.0[<LS) =l
L Cancel |
Destination:
[ Microsot Mail (aP) =l

In the Format field, select the file format. For this example, select “Excel 5.0 (XLS)".
In the Destination field, select “Microsoft Mail (MAPI)”.
Click OK. The Send Mail screen appears.

Send Mail
Send I Check Mames | Address | Cancel |
Ta: |
Ce: I
Subject: I
Message
=l
-

In the To field, enter an email address. For example, enter “cjones@internet.com”.
In the Subject field, enter “Client Account Activity Report”.

In the Message box, enter a message to the recipient. For example, “Here’s the activity report to date for
this month.”

Click Send. The report is sent an attachment to your email message. You return to the Client Reports
page.
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Reporting categories in Accounts Receivable include Action Reports, Analysis Reports, Bank Account Reports,
Client Reports, Custom Reports, Deposit and Receipt Reports, Pivot Reports, Product and Billing Item Reports,
and Transaction Reports. This chapter discusses Action Reports. For information about other report categories,
see the chapter for that category. For information about Pivot Reports, see the Pivot Reports Guide for

The Financial Edge.

Note: We recommend you read the documentation for The Financial Edge thoroughly. Information presented
here provides you with basic information about action reports in Accounts Receivable. Hands-on experience is
the best way to learn, so we encourage you to try various options with your database.

Action Reports in Accounts Receivable include:

e Action Listing

e Action Summary Report

¢ Actions by Association Report

Action Listing

The Action Listing provides a list of details about actions you select. This report is useful for tracking upcoming
actions, for example, you can run the Action Listing at the beginning of the month to see what actions are
scheduled for that month.

Glossary: An action is a task or activity that needs to be completed for a client. Actions, for example, can
include mailings, phone calls, and email messages.

The Action Listing has tabs on which you set parameters: General, Filters, and Format. To move among the tabs,
click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to include
in the report and how the report should look. For more information about creating a report, see “Creating a
report in Accounts Receivable” on page 10.
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General Tab

On the General tab, define parameters and select information to include in the report.
A& New Action Listing
File Edt “iew Favonter Tools Help
EH &2 & W ?-

1. General ]g: Filters] 2 Format]

Include actions with these dates
Action date: |Include all dates j

Ihciude actions with these action prionties
I+ High v Momal [ Low

Include. ..

W Incomplete actions [T Complete actions

[~ Create an output query of clients

Report anientation: | Portrait -

| Ment » ‘ Cancel | Frint Prewiew Layout

Include actions with these dates. In the Action date field of the Include actions with these dates frame,
select a date or date range for actions to include in the report. If you select <Specific range>, you can specify
starting and ending dates in the Start date and End date fields.

Include actions with these action priorities. You can mark High, Normal, and Low to include actions only
with certain priorities. You can select one, two, or all three priorities.

Include Incomplete actions or Complete actions. You can mark checkboxes to include incomplete or
complete actions, or both.

Create an output query of clients. If you mark Create an output query of clients, the program creates a
qguery of the clients included in the report. You can use the query later in other areas of Accounts Receivable.

Report orientation. In the Report orientation field, select Portrait or Landscape.

Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Action Statuses filter, only actions with the statuses you select appear in the report.
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On the Filters tab, you can filter the records appearing in the report. For more information about filtering in
The Financial Edge, see the Program Basics Guide.

I New Action Listing E
File Edit “iew Favortes Tools Help
FlEE = |

1. General IE: Furmatl

&0 0pen 7 Clear &ll Filkers

Filkers I Include Selected Filkers

Action Types all =all Action Types:=

Action Statuses all <Al Action Statuses =

Ackion Aktribukes all <hll Action Atkributes=

Clients all <Al Clients=

Client Attributes all <Al Client attributes=

< Back | Mext » | Cancel | Brint | Preview | Layout

Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting
options for the Action Listing. When you select an item in the list, the right side of the screen displays selections
for that section of the report.

Note: The heading defaults to Action Listing in the Title field. You can leave this as the title for your report or
enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

I Mew Action Listing
File Edit “iew Fawvortes Toolz Help

S & =2

1 Generall 2: Filters 3 Farmat |

B esor

Criteria :
Sort/Break — Heading Format
Page Footer Title: Iﬂ.CtiDn Lisling

Report Faater Subiitle:
Miscellaneous

Colar Scherme Aligr: IEenter 'I

[¥ Print organization name in header

W Print Page Mumber in Heading [¥ Frirt Report Date in Heading
Format: IF'age 1 j Format: IShDrt Date and Time j
Mligr: [ Right =l signe [Lett =l

[¥ Print report heading on each page

< Back et Cancel Frrint Freview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the
report.

I Mew Action Listing
File Edit “iew Fawvortes Toolz Help

S & =2

1 Generall 2: Filters 3 Farmat |

Criteria
Sont/Break v Piint these criteria on Ia separate page 'I

Pane Footer Saved report name
Fepart Footer Dutput query name
Miscellaneous Action dates to include
Color Scheme Action priorities ta include

Action completion statuges to include
Action types to include

Action statuzes to include

Action attributes to include

Clients ta include

Client attributes to include

< Back | | (= | Cancel | Frrint | Freview | Layout |

Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall
between sets of information.

To order the information, you can select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break?
for a category, fields are enabled for you to specify more information about the break for the selected sorting
category.

In the Text before value and Text after value fields, you can enter up to 30 characters to print directly before
and after the value for the selected sorting category.
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To print the number or percentage for the selected category in the footer, mark Print count per or Print count

as a percentage of total for the selected sorting category. To start the selected sorting category on a new
page, mark Page break on each new.

I Mew Action Listing
File Edit “iew Fawvortes Toolz Help

S & =2

1 Generall 2: Filters 3 Farmat |

Headings Sort{Break
Criteria

B Sort/Break Sart by | Order by I Break? I
Page Footer Cliert 1D Agcending ol
Report Foater r
Miscellaneous r
Colar Scheme =

-

Break Header for Client [0

Text before value: |

Text after value: |

Break Footer for Client 1D -
[~ Print count per Client 1D

[ Print count as a percentage of tatal
™ Page break on each new Client D

< Back | | (= | Cancel | Frrint | Freview | Layout |

Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align
the text. You can include the page number and date in the footer.

I Mew Action Listing
File Edit “iew Fawortes Toolz Help

SR el |

1 Generall 2 Filters 3 Farmat |

Headings Page Footer

Litera Page Footer Text
Sort/Break, B

B Page Footer Text:
Report Footer
Miscellansous
Colar Scheme

Aligr: IEentel 'I

[ Print Page Murmber in Footer

[~ Print Report Date in Footer
Format: IF'age 1 j Farmat: IShDrt Date and Time j
Aligre | Fight B e et =
< Back et Cancel FErrint Freview Layaut
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

1@ Mew Action Listing
File Edit “iew Fawvortes Toolz Help
H (&S 3G ?-

1 General] 2 Filterz 3 Format l

5] Headings Report Footer

] Criteria
5] Sort/Break Report Footer Text
2] Page Foater Text:

I Repart Foater

2] Mizcellaneous
] Color Scheme

< Back | | Cancel | Frrint | Freview | Layaut |

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

1@ Mew Action Listing
File Edit “iew Fawvortes Toolz Help
n jl. % —ﬁ |||¢.I ? -

1 General] 2 Filterz 3 Format l

] Headings Miscellaneous

] Criteria
=] Sort/Break Show currency character an All amounts
Z] Page Footer Show percent sigh on Al amounts
=] Report Footer Meqative amount format [1234.5E)
) Color Scheme Mumber of digits after decimal for amounts 2

Mumber of digits after decimal for percentages 2

Show 1000'z zeparator Yes

Show blanks instead of zeroz Mo

Fant size 8

Sample amaunt;
Arnount [$1.234.56)
Percent 100.00%

< Back Cancel Frrint Freview Layaut
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to

the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

I Mew Action Listing
File Edit “iew Fawvortes Toolz Help

S & =2

1 Generall 2: Filters 3 Farmat |

Headings Color Scheme

Criteria

Sart/Break ™ &pply a Color Scheme Report Name
;Zizrfzzﬁ;r M Colurnn heading back colar Subtitle

Miscsllaneous e ] 0! Heodings

B Colar Scheme

[~ Group heading back colar Group Headings

. Group heading fore color

Hrestore [Vefaults |

< Back | (= Cancel Frrint Freview Layout

Action Summary Report

The Action Summary Report provides a count of actions by action type, action status, or the user assigned to the
action. Because this report is a summary, client names do not appear.

Glossary: An action is a task or activity that needs to be completed for a client. Actions, for example, can
include mailings, phone calls, and email messages.

The Action Summary Report has tabs on which you set parameters: General, Filters, and Format. To move among
the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to

include in the report and how the report should look. For more information about creating a report, see “Creating
a report in Accounts Receivable” on page 10.
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General Tab

On the General tab, you can select parameters specific to the report and make selections about the information
included in the report.

I New Action Summary Report
File Edt “iew Favonter Tools Help

H (&S W L=
1. General ]g: Filters] 2 Format]

Include actions with these dates
Action date: |Include all dates j

Include actions with these action priorities
[+ High v Mommal v Low

Ihclude. .

W Incomplete actions [~ Complete actions

[~ Create an output query of clients

Fepart arientation: | Fortrait b

| Memt » ‘ Cancel | Frint Prewiew Layout

Include actions with these dates. In the Action date field of the Include actions with these dates frame,
select a date or date range for actions to include in the report. If you select <Specific range>, you can specify
starting and ending dates in the Start date and End date fields.

Include actions with these action priorities. You can mark High, Normal, and Low to include actions only
with certain priorities. You can select one, two, or all three priorities.

Include Incomplete actions or Complete actions. You can mark checkboxes to include either incomplete
or complete actions, or both.

Create an output query of clients. If you mark Create an output query of clients, the program creates a
guery of the clients included in the report. You can use the query later in other areas of Accounts Receivable.

Report orientation. In the Report orientation field, select Portrait or Landscape.

Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Action Statuses filter, only actions with the statuses you select appear in the report.
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On the Filters tab, you can filter the records appearing in the report. For more information about filtering in
The Financial Edge, see the Program Basics Guide.

IQ Mew Action Summary Report E
File Edit “iew Favortes Tools Help
FlEE = |

1. General IE: Furmatl

&0 0pen 7 Clear &ll Filkers

Filkers I Include Selected Filkers

Action Types all =all Action Types:=

Action Statuses all <Al Action Statuses =

Ackion Aktribukes all <hll Action Atkributes=

Clients all <Al Clients=

Client Attributes all <Al Client attributes=

< Back | Mext » | Cancel | Brint | Preview | Layout

Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting
options for the Action Listing. When you select an item in the list, the right side of the screen displays selections
for that section of the report.

Note: The heading defaults to Action Summary Report in the Title field. You can leave this as the title for your
report or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

IE Mew Action Summary Report
File Edit “iew Fawvortes Toolz Help

S & =2

1 Generall 2: Filters 3 Farmat |

B esor

Criteria
Detsil — Heading Format
Pane Foater Title: If-‘n.ction Summary Report

Report Faater Subiitle:
Miscellaneous

Colar Scherme Aligr: IEenter 'I

[¥ Print organization name in header

W Print Page Mumber in Heading [¥ Frirt Report Date in Heading
Format: IF'age 1 j Format: IShDrt Date and Time j
Mligr: [ Right =l signe [Lett =l

[¥ Print report heading on each page

< Back et Cancel Frrint Freview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the

report.

n Mew Action Summary Report

File Edit “iew Faworites

H &2 %W

Toolz Help
2 -

1 Generall 2: Filters 3 Farmat l

] Headings

2] Detail

] Page Footer
£] Report Footer
2] Miscellaneous
] Color Scheme

Criteria
Iv Print these critenia on | a separate page -

v| Saved report name

w| Dutput query name

W] Action dates to include

v| Action pricrities to include

w| Action completion statugzes to include
v Action types to include

w| Action statuzes to includs

W] Action attributes to include

| Clients to include

W] Client attributes to include

< Back | |

Cancel | Frrint Freview Layout |

Detail. Use Detail to summarize the report by action type, action status, or to whom the action is assigned.

n Mew Action Summary Report

File Edit “iew Faworites

H &2 %W

Toolz Help
2 -

1 Generall 2: Filters 3 Farmat l

2] Miscellaneous
] Color Scheme

2 Heedigs
=] Criteria

Summarize report by |Action Type | ™

=] Page Footer

2] Report Footer

< Back

Cancel Frrint Freview Layout
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Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align
the text. You can include the page number and date in the footer.

lB Mew Action Summary Report [ ]

File Edit “iew Fawvortes Toolz Help
SR -2 |

1 Generall 2 Filterz 3 Format |

Headirgs Page Footer
Criteria —
Dretail — Fage Footer Tex

Test:

Report Foater
Miscellaneous
Calor Scheme

Aligr: IEenter 'l

[ Print Page Murmber in Footer [~ Print Report Date in Foater
Forrnat: IF'age 1 j Format: IShort Date and Time j
Align | Right 2 [ e =
< Back | | (= | Cancel | Frrint | Freview | Layaut |

Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to
align the text. The report footer appears at the end of the report.

IE Mew Action Summary Report
File Edit “iew Fawvortes Toolz Help

S & =2

1 Generall 2: Filters 3 Farmat |

Headings Report Footer

Criteria
Detail Report Footer Text
Page Footer Text:

E Report Footer

Miscellaneous
Colar Scheme

Aligr: ILeft vl

< Back et Cancel Frrint Freview Layout
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

lQ Mew Action Summary Report

File Edit “iew Fawoites

Toolz Help

= D= N gl R

1 Generall 2: Filters  2: Farmat |

Headngs
Criteria
Detail Show currency character on All amaounts
Page Foater Show percent sign an All amounts
Report Footer Megative amount format [1234.56]
Color Sohems Mumber of d?g?ts after dec?mal for amaunts 2
Mumber of digits after decimal for percentages 2
Show 1000%: separator Tes
Show blanks instead of zeros Mo
Font size 2
Sample amaunt:
Amount [$1.234.56)
Percent 100.00%
< Back | Herts | Cancel | FErint | Preview | Layout |

Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

IE Mew Action Summary Report

File Edit “iew Faworites

Toolz Help

S & =2

1 Generall 2: Filters 3 Farmat |

Headings
Criteria

Detail

Page Footer
Report Foater
Miscellaneous

Color Scheme

I~ Apply a Colar Scheme

. Column heading back color
|_ Column heading fore caolor

I_ Group heading back color

. Group heading fore color

Hiestore [Wefaults

Report Name
Subtitle

Group Headings

< Back et

Cancel

Frrint Freview Layout
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Actions by Association Report

The Actions by Association Report lists action details by client association.

Glossary: An action is a task or activity that needs to be completed for a client. Actions, for example, can
include mailings, phone calls, and email messages.

The Actions by Association Report has tabs on which you set parameters: General, Filters, and Format. To move
among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify
information to include in the report and how the report should look. For more information about creating a
report, see “Creating a report in Accounts Receivable” on page 10.

General Tab

On the General tab, you can select parameters specific to the report and make selections about the information
included in the report.

n Mew Actions by Asszociation Report
File Edit “iew Favortes Tools Help

u _5- % —ﬁ |||¢.I ? -
{1, General| 2 Fiters | 3 Fomat
Include actions with these dates

Action date: [Include all dates 7

Include actions with these action priorities
v High W Momal v Low
Include. .

v Incomplete actions [~ Complete actions

[T Create an output guen of clientz

Report arientation: | Portrait -

| Mext » ‘ Cancel | Brint Preview Layout

Include actions with these dates. In the Action date field of the Include actions with these dates frame,
select a date or date range for actions to include in the report. If you select <Specific range>, you can specify
starting and ending dates in the Start date and End date fields.

Include actions with these action priorities. You can mark High, Normal, and Low to include actions only
with certain priorities. You can select one, two, or all three priorities.

Include Incomplete actions or Complete actions. You can mark checkboxes to include either incomplete
or complete actions, or both.

Create an output query of clients. If you mark Create an output query of clients, the program creates a
guery of the clients included in the report. You can use the query later in other areas of Accounts Receivable.
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Report orientation. In the Report orientation field, select Portrait or Landscape.

Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Action Statuses filter, only actions with the statuses you select appear in the report.

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the
Program Basics chapter of the Program Basics Guide.
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Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting
options for the Action Listing. When you select an item in the list, the right side of the screen displays selections
for that section of the report.
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Note: The heading defaults to Actions by Association Report in the Title field. You can leave this as the title for
your report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.
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Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the
report.
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Sort/Break. Sort/Break. Use Sort/Break to select the order for information to appear on the report and where
breaks fall between sets of information.

To order the information, you can select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break?
for a category, fields are enabled for you to specify more information about the break for the selected sorting
category.

In the Text before value and Text after value fields, you can enter up to 30 characters to print directly before
and after the value for the selected sorting category.
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To print the number or percentage for the selected category in the footer, mark Print count per or Print count

as a percentage of total for the selected sorting category. To start the selected sorting category on a new
page, mark Page break on each new.
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Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align
the text. You can include the page number and date in the footer.
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Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to

align the text. The report footer appears at the end of the report.

n Mew Actions by Association Report
File Edit “iew Fawvortes Toolz Help
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

n Mew Actions by Association Report
File Edit “iew Fawvortes Toolz Help
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Arnount [$1.234.56)
Percent 100.00%
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to

the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

IE Mew Actions by Association Report
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Reporting categories in Accounts Receivable include Action Reports, Analysis Reports, Bank Account Reports,
Client Reports, Deposit and Receipt Reports, Pivot Reports, Product and Billing Item Reports, and Transaction
Reports. This chapter discusses Analysis Reports. For information about other report categories, see the chapter
for that category. For information about Pivot Reports, see the Pivot Reports Guide for The Financial Edge.

Note: We recommend you read the documentation for The Financial Edge thoroughly. Information presented
here provides you with basic information about analysis reports in Accounts Receivable. Hands-on experience
is the best way to learn, so we encourage you to try various options with your database.

Analysis Reports in Accounts Receivable include:
¢ Aged Accounts Receivable Report

e Open Item Report

¢ Service and Sales Analysis Report

¢ Service and Sales Trend Analysis Report

The Aged Accounts Receivable Report and Open Item Report are versatile reports that offer your organization
numerous reporting options. To understand the full capacity of these reports, see “Payer and Recipient Details”
on page 61.

Aged Accounts Receivable Report

Use the Aged Accounts Receivable Report to list balances distributed in aging periods defined in Configuration.
This report is useful in determining past due and current balances of clients.

The Aged Accounts Receivable Report is different than the Aged Accounts Payable Report. In Accounts Payable,
payments are included or excluded based on the “age as of date”. In Accounts Receivable, charges, payments,
and credits are included based on the transaction date filters. The “aging as of date” is independent of the
transactions.

For example, you have a $200 charge dated 03/15/05 that has a $100 payment dated 04/15/05. In the report, if
you include transactions through 03/31/05 and use an aging date of 03/31/05, the client has a balance of $200. If
you include transactions through 04/15/05 and use an aging date of 03/31/05, the client has a balance of
$100.00. The aging date only determines the aging bucket in which balances will fall; it is not used as a filter.

You can use this report whether you use a single-party billing system or third-party billing system. If you use a
third-party billing system, keep the definitions of payer and recipient clients in mind:

¢ A payer is a person or organization responsible for paying a bill.

¢ Arecipient is a person or organization that receives a product or service, or has its balance reduced by a
payment or credit.

The Aged Accounts Receivable Report has tabs on which you set parameters: General, Filters, and Format. To
move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify
information to include in the report and how the report should look. For more information about creating a
report, see “Creating a report in Accounts Receivable” on page 10.



ANALYSIS REPORTS 45

General Tab

On the General tab, define parameters and select information to include in the report.

lE Mew Aged Accounts Beceivable Report E3
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Calculate aging as of. In the Calculate aging as of field, select Today or select <Specific date> and enter a
date.

Include transactions with these dates. In this frame, you can select a date or date range for the

transactions to include in the report. Make your selections in the Transaction date, Due date, and Post date
fields.

If you select <Specific range>, specify start and end dates. If you leave the Start date field blank, all
activity is included up to the end date. If you leave the End date field blank, all activity from the start
date forward, including transactions with a date in the future, is included. If you leave both fields
blank, all activity is included.

Only include clients with a balance greater than [ ] in aging period [ ]. You can limit clients to include
in the report with a minimum balance in a specific aging period.

Reduce balances by unused payments/credits beginning with [ ]. You can select which aging period
receives unapplied payments or credits first, either the oldest period or the most recent period.

Include these aging periods. Mark checkboxes to select the aging periods include. Aging periods are defined
in Configuration in Accounts Receivable.

Create an output query of [ ]. If you mark Create an output query of, select Clients or Charges. The program
creates a query of the clients or charges included in the report. You can use the query later in other areas of
Accounts Receivable.

Report orientation. In this field, select Portrait or Landscape.
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Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Post Statuses filter, only transactions with the post statuses you select appear on the report.

On the Filters tab, you can include information based on selected criteria such as clients, post statuses, and
account attributes. For example, you can include the selected post status Not Yet Posted, and only unposted
transactions appear on the report. For more information about filtering in The Financial Edge, see the Program
Basics Guide.

On the Filters tab, you can filter by both payer and recipient clients. For example, if an organization, such as an
insurance company, pays some portion of a bill for many clients, you can select the insurance company as the
payer client and select the clients that are paid by the company as the recipient clients.
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Tip: You can also double-click a filter in the grid to open the selection screen.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can
select specific filters for the report.

Clear All Filters. To reset each filter to include all, click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
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On the Format tab, you select how you want the report to appear. The list on the left of the screen displays
formatting options for the Aged Accounts Receivable Report. When you select an item in the list, the right side of
the screen displays selections for that section of the report.

Note: The heading defaults to Aged Accounts Receivable Report in the Title field. You can leave this as the title

for your report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.
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Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on

the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of
the report.
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Note: The Detail panel is important in determining the output of the report. For more information about this
panel, see “Aged Accounts Receivable Report Detail Panel” on page 62.

Detail. The Detail panel is significant to the output of the report. In the Report by field, you can select
“Assignment” or “Ownership”. You can then select to show or not show details. For more information about
this panel, see “Aged Accounts Receivable Report Detail Panel” on page 62.

Mark Show transaction detail to list the transaction date, type, ID, due date, aging period and amount for
each transaction that composes a client’s balance.

Note: If you are using a single-party billing system, it does not matter whether you report by payer or recipient. To
prevent useless lines in the report, do not show payer or recipient details.

To summarize aging by product and billing item, mark Include summary by product and billing item. This
creates a chart on the last page of the report totaling the amount due for each product and billing item under
the appropriate aging period.
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For both individual and organization clients, you can select to include contact information and specify the
address and number type to use. To determine how client names appear on the report, select a client
salutation. Salutations are defined in Configuration.
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GL Sort/Break. Use GL Sort/Break to select the order for information to appear on the report and where breaks
fall between sets of information. The GL Sort/Break applies to the overall report and allows for easier

reconciliation with General Ledger, whereas the Transaction Sort/Break applies to each client section within
the report.

To order the information, you can select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break?

for a category, fields are enabled for you to specify more information about the break for the selected sorting
category.

In the Text before value and Text after value fields, you can enter up to 30 characters to print directly before
and after the value for the selected sorting category.
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To print the number or percentage for the selected category in the footer, mark Print count per or Print
count as a percentage of total for the selected sorting category. To start the selected sorting category on a
new page, mark Page break on each new.
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Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align
the text. You can include the page number and date in the footer.
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Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to

align the text. The report footer appears at the end of the report.
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.
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Transaction Sort/Break. Use Transaction Sort/Break to select the order for information to appear on the
report and where breaks fall between sets of information. The Transaction Sort/Break applies to each client
section within the report, whereas the GL Sort/Break applies to the overall report and allows for easier
reconciliation with General Ledger.

To order the information, you can select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break?
for a category, fields are enabled for you to specify more information about the break for the selected sorting
category.

In the Text before value and Text after value fields, you can enter up to 30 characters to print directly before
and after the value for the selected sorting category.

To print the number or percentage for the selected category in the footer, mark Print count per or Print
count as a percentage of total for the selected sorting category. To start the selected sorting category on a
new page, mark Page break on each new.

Open Item Report

The Open Item Report lists charges that have not been completely paid and the amount remaining to be paid as
of a selected date. This report is useful for reconciling to the general ledger.

To view activity for a specific date range, run an Account Activity report, which is designed to filter all activity for
a specific date range. Keep in mind, the Open Item and Aged Accounts Receivable reports are designed to view
the balance of your outstanding charges. The date ranges you select are for charges only—unapplied payments
prior to the date range are included in your beginning balance.
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The Open Item Report has tabs on which you set parameters: General, Filters, and Format. To move among the
tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to
include in the report and how the report should look. For more information about creating a report, see “Creating
a report in Accounts Receivable” on page 10.

General Tab

On the General tab, define parameters and select information to include in the report.
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Show charges open as of. In the Show charges open as of field, specify a date for charges to include. Select
Today, or select <Specific date> and enter a date. All charges open as of this date are included.

Base charge open date on. In the Base charge open date on field, select Transaction date or Post date to
specify the date the charge is considered open.

Include charges with these dates. In this frame, you can select a date or date range for the charges to
include in the report. Make your selections in the the Transaction date and Post date fields.

If you select <Specific range>, specify start and end dates. If you leave the Start date field blank, all activity is
included up to the end date. If you leave the End date field blank, all activity from the start date forward,
including transactions with a date in the future, is included. If you leave both fields blank, all activity is
included.

Include unapplied payments and credits in [ ]. You can mark this checkbox to include payments and
credits that have not been applied to a charge. Select:

e Detail to show each payment and credit as an additional line item.

Summary to add the payments and credits and show a negative total in the balance column. The report
displays payments and charges that are unapplied as of the date defined in the Show Charges as of field.
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Create an output query of [ ]. If you mark Create an output query of, select Clients or Charges. The program
creates a query of the clients or charges included in the report. You can use the query later in other areas of
Accounts Receivable.

Report orientation. In the Report orientation field, select Portrait or Landscape.

Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Post Statuses filter, only transactions with the post statuses you select appear on the report.

On the Filters tab, you can include information based on selected criteria such as payers, recipients, and post
statuses. For example, you can include the post status Not yet posted, and only unposted transactions appear on
the report. For more information about filtering, see the Program Basics chapter of the Program Basics Guide.

If you use a third-party billing system, keep the definitions of payer and recipient clients in mind:
e A payer is a person or organization responsible for paying a bill.

e Arecipient is a person or organization that receives a product or service, or has its balance reduced by a
payment or credit.

On the Filters tab, you can filter by both payer and recipient clients. For example, if an organization, such as an
insurance company, pays a portion of the bill for many clients, you can select the insurance company as the payer
client and select the clients that are paid by the company as the recipient clients.

@ New Open Item Report I
File Edit Wiew Favorites Tools Help
RS R0 -2 |
: Format I
#@0pen 7 Clear All Filkers
Filters I Include Selected Filkers Iﬂ

Paver Clients all <Al Paver Clients=

Recipient Clients Al <Al Recipient Clisnks =

Paver Client Attributes all <Al Payer Client Atkributes =

Recipient Client Aktributes Al <Al Recipient Clisnt Attributes =

Charges all <Al Charges =

Invoices All <All Invoices =

IUnapplied Credits all <Al Unapplied Credits=

Unapplied Payments all <Al Unapplied Payments=

Posk Statuses All <All Post Skatuses >

Transaction Attributes all <Al Transaction Attributes >

Products and Billing Items Al <Al Products and Billing Items =

Product and Billing Item A... Al <Al Product and Billing Ikemn Aktribukes =

Accounts all <All Accounts > ;I

< Back Hewt » Cancel Print Preview | Layout |

Tip: You can double-click a filter in the grid to open the selection screen.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can
select specific filters for the report.

Clear All Filters. To reset each filter to include all, click Clear All Filters.
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Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you select how you want the report to appear.The list on the left of the screen displays
formatting options for the Open Item Report. When you select an item in the list, the right side of the screen
displays selections for that section of the report.

Note: The heading defaults to Open Item Report in the Title field. You can leave this as the title for your report
or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

1@ Mew Open Item Report [ ]

File Edit “iew Fawvortes Toolz Help
SR -2 |

1 Generall 2 Filterz 3 Format |

B Hoadr

Criteria
Datail — Heading Format
GL Sort/Break Title: |D|:-en Item Feport
Fage Footer Sublitle: I

Report Foater
Miscellaneous Aligr: Il:enter 'I
Calor Scheme

Transaction Sot/Break [V Print arganization narme in header

v Print Page Number in Heading [¥ Piint Report Date in Heading
Format: IF'age 1 j Farmat: IShort Date and Time j
Aligr: IHight j Aligr: ILeft j

[¥ Prirt report heading on each page

< Back Hewts Cancel Frint Preview Lapout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the
report.

I Mew Open Item Report
File Edit “iew Fawvortes Toolz Help

SR el |

1 Generall 2: Filters 3 Farmat |

Criteria
Detail [v Fiint these criteria on Ia separate page 'I

GL Sort/Break

Saved report name -
Page Faoter Output query name [
Fepart Footer Show charges open az of
Miscellaneous Base charge open date on
Color Scheme Transaction dates bo include

Transaction Sort/Break. Post dates to include

Include unapplied papments and credits

Accounts to include

Arcount attributes to include

Funds to include

Classes to include

Post statuses to include —
Frojects to include

Project attributes to include

Payer clients to include

Fecipient client attributes to include LI

< Back | (= Cancel Frrint Freview | Layout |

Note: If you are using a single-party billing system, it does not matter whether you report by payer or recipient. To
prevent useless lines in the report, do not show payer or recipient details.

Detail. Use Detail to select details specific to the Open Item Report. If you mark Include open item information,
you can select how to report open items. In the Report by field, you can select Payer or Recipient. In the
Report in fields, you can select Detail or Summary and whether to show or not show payer or recipient
details.

If you select to report by recipient and not to show payer details, and mark Group transactions by General
Ledger receivable account information, the report gives a total for each receivable account and a grand total.
This can be helpful when you reconcile if you have multiple receivable accounts.

Mark Include summary by product and billing item to summarize aging by product and billing item.
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In the Salutation field, select how to display client names on the report. Salutations are defined in
Configuration.

M@ New Dpen Item Report I

File Edit View Favorites Tools Help
RS R0 - - |

1: General' 2 Filters 3 Format |

Headings Detail

Criteria
¥ Include client apen item information

GL Sort/Break
=] Page Foater : :
Rrepart Faater Report in: IDetaiI j and IDD niot show j payer details.
Miscellaneous r Group tranzactions by General Ledaer receivable account infarmation

Caolor Scheme [choosing this option will ignare atw Payer Clisnt filters]

Transaction Sort/Break [~ Include summary by product and billing item

Client Salutation: | Client name j

< Back | Ewt | Cancel | Brint | Freview | Layout |

GL Sort/Break. Use GL Sort/Break to select the order that information appears on the report and where breaks
fall between sets of information. When you select GL Sort/Break on the Format tab, a grid displays the
categories you can sort in the report. Select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

In the Break Header for <Sort by category> frame, to create breaks between the sections you have sorted by,
you can mark the checkbox in the Break? column. In the Text before value and Text after value fields, you can
enter up to 30 characters in each field for information that prints immediately before and after each break.
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In the Break Footer for <Sort by category> frame, you can mark Print count per <Sort by category> or Print
count as percentage of total to print the information in the footer. To start a new page for the highest level
break, mark Page break on each new <Sort by category>.

I Mew Open Item Report
File Edit “iew Fawvortes Toolz Help
= Jie= R = e |
1 Generall 2: Filters 3 Farmat |
Headings GL Sort/Break
Criteria
Detail Sart by | Order by | Break? |
B GL Sort/Break Account Mumber Agcending ol
Page Footer r
Report Foater r
Miscellaneous
Color Scheme r
Transaction Sort/Break. r
Break Header for Account Mumber-
Text before value: |
Text after value: |
Break Footer for Account Mumber-
[~ Print count per Account Murnber
[ Print count as a percentage of tatal
[ Page break on each new Account Murmber
< Back | | (= | Cancel | Frrint | Freview | Layout |

Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align
the text. You can include the page number and date in the footer.

i@ Mew Open Item Report
File Edit %iew Favortes Toolz Help

eI el |

1 Generall 2 Filters 2 Farmat |

Headings Page Footer
Criteria ——
Detail — Fage Footer Tex

GL Sort/Break Text:
B Page Faoter

Report Footer
Miscellansous

Calor Scljeme Aligre Im
Transaction Sort/Break,

[ Print Page Murnber in Footer

[~ Print Report D ate in Footer
Format: IF'age 1 j Farmat: IShDrt Date and Time j
Aligre [ Right Bl || Al L =

< Back | THERt Cancel FErint Preview Layout
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Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to
align the text. The report footer appears at the end of the report.

1@ Mew Open Item Report
File Edit “iew Fawvortes Toolz Help
H &= %W B

1 General] 2 Filterz 3 Format l

5] Headings Report Footer

] Criteria

5 Detail Report Footer Text

2 GL Sort/Break Tent:

2] Color Scheme l—_|

2] Transaction Sort/Break

< Back | | Cancel | Frrint | Freview | Layaut |

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

1@ Mew Open Item Report
File Edit “iew Fawvortes Toolz Help
EH &E %W & =
1 General] 2 Filterz 3 Format l
] Headings Miscellaneous
] Criteria
=] Detail Show currency character an All amounts
=] GL Sort/Break Show percent sigh on All amaounts
=l Eage F'o:oter Meqative amount format [1234.5E)
- portoter Murnber of digits after decimal for amaunts 2
an
5 Color Scheme Mumber of digits after decimal for percentages 2
2] Transaction Sort/Break Show 1000's separator Yes
Show blanks instead of zeroz Mo
Fant size 8
Sample amaount:
Arnount [$1.234.56)
Percent 100.00%
< Back Cancel Frrint Freview Layaut
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

I Mew Open Item Report
File Edit “iew Fawvortes Toolz Help

SR el |

1 Generall 2: Filters

Headings Color Scheme

Criteria

Diatsil ™ &pply a Color Scheme Report Name
g';gio';if;ak M Column heading back colar Subtitle

Feport Footer I™" Column heading fore color _
Miscellenus ™ Group heading back calor Group Headings

Tranzaction Sart/Break . Group heading fore color

Hrestore [Vefaults |

< Back | | (= | Cancel | Frrint | Freview | Layout |

Transaction Sort/Break. Use Transaction Sort/Break to select the order for information to appear on the
report and where breaks fall between sets of information. When you select Transaction Sort/Break, a grid
displays categories you can sort in sections within the report. Select a sorting category in the Sort by column
and select Ascending or Descending in the Order by column. To create breaks between the sections you have
sorted by, you can mark the checkbox in the Break? column.

In the Break Header for <Sort by category> frame, in the Text before value and Text after value fields, you
can enter up to 30 characters in each field for information that prints immediately before and after each
break.
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In the Break Footer for <Sort by category> frame, you can mark Print count per <Sort by category> or Print
count as percentage of total to print the information in the footer. To start a new page for the highest level

break, mark Page break on each new <Sort by category>.

I Mew Open Item Report
File Edit “iew Fawvortes Toolz Help
= Jie= R = e |
1 Generall 2: Filters 3 Farmat |
Headings Transaction SortfBreak
Criteria
Detail Sart by | Break? |
GL Sant/Break Payer Hame i
Page Footer Recipient Mame v
Report Foater r
Miscellaneous
Color Scheme r
E Tranzaction S5 I-
Break Header for Payer Hame:-
Text before value: |
Text after value: |
Break Footer far Payer Mame:
[ Print count per Payer Mame
[ Print count as a percentage of tatal
[" Page break on each new Paper Name
< Back | (= | Cancel | Layout

Payer and Recipient Detalils

This section elaborates on the Detail panel on the Format tab of the Aged Accounts Receivable and Open Item
reports. The Detail panel is a determining factor in the output of these reports. Hands-on experience is the best
way to learn, so we encourage you to try various options with your database.

Note: If you are using a single-party billing system, it does not matter whether you report by payer or recipient. To

prevent useless lines in the report, do not show payer or recipient details.

You can use these reports whether you use a single-party billing system or third-party billing system. If you use a
third-party billing system, keep the definitions of payer and recipient clients in mind:

e A payer is a person or organization responsible for paying a bill.

¢ Arecipient is a person or organization that receives a product or service, or has its balance reduced by a

payment or credit.
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Aged Accounts Receivable Report Detail Panel

The Detail panel of the Aged Accounts Receivable Report plays a key role in the output of the report. With this
screen, you determine the quantity of information on the report. For more information about this report, see
“Aged Accounts Receivable Report” on page 44.

N3 New Aged Accounts Receivable E3 I
File Edit View Favorites Tools Help

dada@ a2 |

1 Gereral 2 Format |

Headings Detail
Criteria

‘B Detai Repart by: I.t’-‘-.ssignment j andIDg not shaw j recipient details.
GL Sort/Braak

Group ransactions by General Ledger recervable aceaunt infarmatian

Fage Faater [~ [(choosing this option will ignere amy Faper Elient filters and exclude
Repart Footer unapplied pavments and credits]

Mizcelaneaus [~ Shaow tranzaction detail

Color Scherne [ Include summary by praduct and billing item

Transaction Sort/Break For individual clients:

[~ Shaow the contact information for this addiess: IHDme 'I
Show thiz contact number: IHDme vI

For organizational clients;

[~ Shaow the contact information for this address: IHDme 'I
Show thiz contact number: |H0me vI

Client 5 alutation: ICIient Mame j

< Back | Hewt > | Cancel | FPrint | Prewview Layout |

In the Report by field, you select to group transactions by payer or recipient. Selecting Payer groups recipients
who contribute to a payer’s balance. Selecting Recipient groups payers who make up a recipient’s balance.

By selecting Show or Do not show payer/recipient details, you decide the amount of detail you want to see. Show
lists payers or recipients with their individual transaction information and balances. Do not show lists
transactions without giving recipient or payer information.

Reporting by Payer

Reporting by payer lists payers’ balances broken into aging buckets. By selecting Show or Do not show, you
determine the amount of information you want to see.

Show recipient details. Select Show recipient details to show payers’ balance broken down by recipients who
make up the balance. If you want to see the clients who compose another’s balance, you must select Show.

Report by IPa-"'E' j andIShgw j recipient details.
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When you select these field entries, the report will be formatted similar to this sample report:

to which recipients make up the balance.

j and ID.;. ot show j recipient details.

Report by IPa-"'E'

Community Services Inc. Pags 1
Aged Accounts Receivable Report

Aging Balance For Last Paid current 3160 61-90 ower 90 Ealance
City Youth Program

City Youth Program 0471672003 S0 S o0 S0 $325.00 $329.00

doka Wikiam 5 047162003 (E20.00) 000 000 $0.00 (320 00

Totals for City Youth Program: (k2000 So00 000 $325.00 $205.00

Grand Totals ($z0.00) $0.00 $0.00 $325.00 $305.00

Do Not Show recipient details. Select Do not show recipient details to show payer’s balance without regard

When you select these field entries, the report will be formatted similar to this sample report:

Reporting by Recipient

Community Services Inc. Page 1

Aged Accounts Receivable Report
Aging Balance For L=st Paid currerit 21-E0 £1-90 oer 90 Balsnce
City Youth Program 0471672003 ¢B20.00) 000 000 $325.00 $305. 00
Grand Totals ($z0.00) $0.00 $0.00 $az5.00 $305.00

Reporting by recipient lists recipients’ balances broken into aging buckets. By selecting Show or Do not show, you
determine the amount of information you want to see.

Show payer details. Select Show payer details to show recipients’ balance broken down by payers who make

up the balance. To see the clients who compose a payer’s balance, you must select Show.

j and Ishgw j payer details.

Repart by: I Recipient

When you select these field entries, the report will be formatted similar to this sample report:

04212003 10:25:24 A Community Services Inc. Page 1
Aged Accounts Receivable Report

Aging Balance For Last Paid current 31-80 61-90 ower 90 Balance

City Youth Program

City Youbh Progra 04/16/2003 d0.00 .00 d0.00 $325.00 $325.00

Totals for City Youth Program: 3000 000 3000 $329.00 $329.00

John Williams

City Youth Progras 04/16/2003 £20.00) 000 3000 000 fB20.00)

Totalsfor John Williams: (2000 .00 d0.00 .00 ¢B20.00)
Grand Totals: ($20.00) $0.00 $0.00 $325.00 $305.00
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Do Not Show payer details. Select Do not show payer details to show a recipient’s balance without regard to

which payers make up the balance.

Report by: | Recipient | and|Donatshow x| payer details.

When you select these field entries, the report is formatted like this sample report:

Community Services Inc.

Aged Accounts Receivable Report

Page 1

Open Item Report Detail Panel

Aging Balance For Last Paid current 21-80 E1-80 over 80 Balance
City Youth Program 04716/2003 i oo o0 o0 3325.00 325,00
dohn williams 04/16/200% (E20 000 000 000 Fo.00 ($20.00)

Grand Totals: ($20.00) $0.00 $0.00 $2265.00 $205.00

The Detail panel of the Open Item Report plays a key role in the output of the report. With this screen, you
determine the quantity of information on the report. For more information about this report, see “Open ltem

Report” on page 52.

I New Open Item Report
File Edit Yiew Favorites Tools Help

H S Rmo = ?-

1 Generall 2 Filters  3: Format |

[¥ Include client open item information
GL Sort/Braak
Page Footer

Headings Detail
Criteria

Report Footer Report in: IDetaiI j and IDD ot zhow j payer details,
Mizcellaneaus r Group tranzactions by General Ledger receivable account information
Colar Scheme [choozing this option will ignore any Payer Clignt filters]
Tranzaction Sart/Break [~ nclude summary by product and billing item
Client Salutation: | Client name j
< Back | et s | Cancel | Brrint | Prewview | Layout |

In the Report by field, select to group transactions by payer or recipient. Selecting Payer groups recipients who
contribute to a payer’s balance. Selecting Recipient groups payers who make up a recipient’s balance.

The Report in field determines the layout of the report. Detail lists individual transaction information. Summary
creates a column for each transaction type charge, payment, and credit, and issues a total for each.



ANALYSIS REPORTS 65

By selecting Show or Do not show payer/recipient details, you decide the amount of detail you want to see. Show
lists payers or recipients with their individual transaction information and balances. Do not show lists
transactions without giving recipient or payer information.

Reporting by Payer in Detail

Reporting by payer groups transaction by recipients that make up a payer’s balance. Selecting to report in Detail
lists individual transaction information. Use Show/Do not show functionality to determine the amount of
information you want to see.

Show recipient details. Select Show recipient details to show payers’ balance broken down by recipients who
comprise the balance. To see clients who comprise a payer’s balance, you must select Show.

¥ Include client open item infarmatian

Report by IPa-"'E' vl

Report in: IDetaiI j and Ishgw j recipient details.

r Eroup transactions by General Ledger receivable aeeaunt information
[choosing this optian will ignore any Payer Client Hlters]

[ Include summary by product and billing item

When you select these field entries, the report will be formatted similar to this sample report:

D5/13/2003 03:12:45 Phi Community Services Inc. Pags 1
Open Item Report

Transaction Transaction Transaction Charge
Transactionsfor  Date Due Dste Type o ttem Armount Payments Credits Balznce % Unpaid

City Youth Frogram
City Youth Prgram

127222002 04042003 CH 5 EEP $10000 F000 000 £10000 10000 %
1242352002 12/23/2002 LI 2 Me £20000 §000 000 F20000 10000 ¥
0141042003 01/04/1900 LI 13 50 F10000 §000 000 F10000 10000 ¥
Totals for Gity Youwth Progran: . 00,00 000 000 00,00 J00.00 %8
Grand Totals for City Youth Program: #0000 £0.00 £0.0a £F00.00 10000 %

Do Not Show recipient details. Select Do not show recipient details to show payers’ balance without regard
to which recipients make up the balance. Individual transactions appear on the report, but not recipient
information.

[ Include client open itern infarmatian

Repart by: IPE'PE' vl

Report it IDE[an j and ID.;, [ j recipient details.

r Group fransactions by General Ledaer receivable account information
[choosing this optior will ignore; any Paver, Client filters]

[ Include summary by product and billing item
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When you select these field entries, the report will be formatted similar to this sample report:

D5N3003 01:57:00 P Community Services Inc. Fage |
Open Item Report

Transaction Transaction Transaction Charge
Transactionsfor _ Date Due Date  Type I ttem Amount  Payments Credits Bslance % Unpaid

City Youth Pragram

OSSN0 OSSO0 CH 21 M £10000 £7500 1000 1500 1500 %

LIEANT MAMA00E CH 3 BEP 10000 000 000 10000 oo %%

12/2352002 12/2352002 LI 8 s $200 00 $0 00 $000 $20000 10000 ¥,

DUIAN0E  DLAAAS0D LI 1 30 10000 $000 $000 10000 oo o %

Grand Totalsfor City Yauth Program £500.00 $75.00 £10.00 #2500 R
Grand Totals: 50000 #7500 $10.00 41500 £200 5

Reporting by Recipient in Detail

Show payer details. Select Show payer details to show recipients’ balance broken down by payers who
comprise the balance.

¥ Include client open item infarmatian

Report by: IHecipient 'I

Report in: IDetaiI j and Ishgw j paver details.

r Eroup transactions by General Ledger receivable aeeaunt information
[choosing this optian will ignore any Payer Client Hlters]

[ Include summary by product and billing item

When you select these field entries, the report will be formatted similar to this sample report:

Community Services Inc. Page 1
Open Item Report

Transaction Transaction Transaction Charge
Transadtionsfor  Date Due Date Type [11] ttem Amount  Payments Credits Balance % Unpaid
John Williams
City Youth Pogram

04/16:5200F 041652004 CH 1 EEP F10000 000 000 £100.00 10000 ¥
Totalsfor City Youth € mgran E00.00 F0.00 Fo.00 £o0.00 F00.00%
Grand Totals for John Williams: £200.00 000 do.00 100,00 2000098

Grand Totals $100 00 000 000 $100 00 1000 %

Do Not Show payer details. Select Do not show payer details to show recipients’ balance without regard to
which payers make up the balance.

¥ Include client open item infarmatian

Report by: IHecipient 'I

Report in: IDetaiI j and ID.;. ot show j paver details.

Group tranzactions by General Ledager receivable account information
[choosing thiz option will ignore any Payer Client filkers)

[ Include summary by product and billing item
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When you select these field entries, the report will be formatted similar to this sample report:

Community Services Inc. Page 1
Open Item Report

Transaction Transaction Transaction Charge

Transactions for  Date Due Date Twpe 0 tem Armournt Payments Credits Balznoce % Unpaid
John Williams

04162003 0416/2004 CH 19 EEP $10000 F000 000 £10000 10000 %

Grand Totals for John Williams: £100.00 £0.00 £0.0a £100.00 10000 %

Grard Totals: 100 00 $000 $0.00 $100 00 L0000 %

Reporting by Payer in Summary

Reporting by payer groups all recipients who make up a payer’s balance. Selecting to report in Summary shows a
total for each transaction type. Use Show/Do not show functionality to determine the amount of information you

want to see.

Show recipient details. Select Show recipient details to show payers’ balances broken down by recipients who
comprise the balance. To see the clients who make up a payer’s balance, you must select Show.

[ Include client open itern infarmatian

Repart by: IPE'PE' vl

Report it ISummary j and Ishgw j recipient details.

Group fransactions by General Ledaer receivable account information
[choosing this optior will ignore any Paver, Client filters]

[ Include summary by product and billing item

When you select these field entries, the report will be formatted similar to this sample report:

Community Services Inc. Page 1
Open Item Report

Charge

Transactions far Amourt Paymants Credits Ealance % Unpsid

City Youth Frogram

dak William 5 $200.00 #0000 $0.00 $200 00 200,00 %

Grand Totals for City Yeuth Frogram: $200.00 $0.00 $0.00 $200 00 200,00 %
Grand Totals: $100 00 $0.00 000 $100 00 100 00 %

Do Not Show recipient details. Select Do not show recipient details to show payers’ balances without regard
to which recipients make up the balance.

[ Include client open itern infarmatian

Repart by: IPE'PE' vl

Report it ISummary j and ID.;, [ j recipient details.

r Group fransactions by General Ledaer receivable account information
[choosing this optian will ignore any Payer Client Hlters]

[ Include summary by product and billing item
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When you select these field entries, the report will be formatted similar to this sample report:

Community Services Inc. Page 1
Open Item Report

Charge

Transactions for Arnourt Payments Credits Balance % Unpaid
dohin Williams 200,00 Fo.00 000 £r00.00 0000 %
Grand Totals: $100.00 oo 000 $100 00 10000 o4

Reporting by Recipient in Summary

Reporting by recipient groups all payers who make up a recipient’s balance. Selecting to report in Summary

shows a total for each transaction type. Use Show/Do not show functionality to determine the amount of

information you want to see.

Show payer details. Select Show payer details to show recipients’ balances broken down by payers who
comprise the balance.

¥ Include client open item infarmatian

Report by: IHecipient 'I

Report in: ISummar}l j and IShDW j paver details,

r Group fransactions by General Ledaer receivable account information
[choosing this optior will ignore; any Paver, Client filters]

[ Include summary by product and billing item

When you select these field entries, the report will be formatted similar to this sample report:

Community Services Inc. Page 1
Open Item Report

Charge

Transactions for Amount Py ments Credits Balance %4 Unpaid
John Williams

Gty Youth Program $100.00 $0.00 3000 #0000 100,00 %

Grand Totals for John Williams: $200.00 $000 000 $i00 00 20000 %

Grand Totals: $10000 $000 $0.00 $100.00 10000 %

Do Not Show payer details. Select Do not show payer details to show recipients’ balances without regard to
which payers make up the balance.

Detail
¥ Include client open item infarmatian
Report by: IHecipient vl

Report in: Isummaf.'ﬂ j and ID.;. ot show j paver details.

Group tranzactions by General Ledager receivable account information
[choosing thiz option will ignore any Payer Client filkers)

[ Include summary by product and billing item
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When you select these field entries, the report will be formatted similar to this sample report:

04/21/2003 00:50:05 A

Open Iltem Report

Charge

Transactions for Amount

Fayments

Community Services Inc.

Credits Ealance % Unpaid

Johim Willizms £r00.00 000

Grand Tedals: $100 00 000

fo.00 100,00 00,00 %

00 10000 100,00 %o

Fage 1

Service and Sales Analysis Report

The Service and Sales Analysis Report provides transaction information for clients and products. For example, use
this report for an analysis of sales by specific products or client attributes.

The Service and Sales Analysis Report has tabs on which you set parameters: General, Filters, and Format. To
move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify
information to include in the report and how the report should look. For more information about creating a
report, see “Creating a report in Accounts Receivable” on page 10.

General Tab

On the General tab, define parameters and select information to include in the report.

IE Hew Service and Sales Analysiz Beport
File Edit “iew Favorites

= D= = ey

Toolz: Help

?-

1: General |2: Filtersl 2 Formatl

Include tranzactions with these dates.

Transaction date: IIncIude all dates

~

Fririt a IDetaiI vI 1eport in IF'nrtrait vl orientation

Analyze by: IProductHEillingItem j SDftil.t'—"«scnancling

j [~ Page break

Then by: IEIient j Sork: I.t'-‘«scending

j [~ Page break

Sort by:

I Tranzaction Date j Sart: I.f-\scending

j [~ Page break

Awailable Information

City » -
County < 'Iu'sgl'lmy
State

Countmy ;I

[~ Create an output guerns of IEIients "I

Frint these columns [maxirmum 7

< Hack | Hewut » | Cancel |

Frint | F'revieml Layout |

Include transactions with these dates. In the Transaction date field of the Include transactions with these
dates frame, select a date or date range for the transactions to include in the report.
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If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date forward, including
transactions with a date is the future, is included. If both fields are blank, all activity is included.

Print a [ ] report in [ ] orientation. Select to create a either a Detail or Summary report, then select either a
Portrait or Landscape orientation.

Analyze by. In the Analyze by field, select the primary analysis criteria. In the Sort field, select to sort the
criteria in ascending or descending order. You can mark Page break to print each on a separate page.

Then by. In the Then by field, select the secondary analysis criteria. This is optional. In the Sort field, select to
sort the criteria in ascending or descending order. You can mark Page break to print each on a separate page.

Sort by. If you are creating a detail report, in the Sort by field, you can select a sort criteria for the transaction
detail. This is optional. In the Sort field, select to sort the criteria in ascending or descending order. You can
mark Page break to print each on a separate page.

Available Information, Print these columns. You can include up to seven columns of information on the
report. The available options change depending on if you have chosen to print the report in summary or
detail. Use the right arrow to move a selected item from the Available Information box to the Print these
columns box.

Create an output query of [ ]. If you mark Create an output query of, you can select for the program to create
a query of the clients, charges, credits, or products and billing items included in the report. You can use the
query later in other areas of Accounts Receivable.

Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Client Attributes filter, only clients with the selected attributes appear in the report.
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On the Filters tab, you can include information based on selected criteria such as client attributes and post
statuses. For example, you can include selected client attributes, and only clients with the selected attributes
appear on the report. For more information about filtering in The Financial Edge, see the Program Basics Guide.

I Hew Service and Sales Analysis Report 1]
File Edit “iew Fawvoiter Tools Help
=== |

1. General  2: Filterz I§: Formatl

&0 0pen ) Clear &l Filers

Filters I Include Selected Filkers

Clients all <Al Clients=

Client Attributes all <hll Client attribubes =

Charges all <hll Charges=

Credits all <Al Credits =

Invoices all <Al Invoices>

Returns all <hll Returns =

Transaction Attributes all <Al Transaction Attributes =

Post Statuses all <Al Post Statuses=

Products and Biling Items all <l Products and Biling Items >

Product and Billing Item At... Al <Al Product and Biling Item Attributes =

< Back | Mest » | Cancel | Frint | Prewiew Layout

Tip: You can double-click a filter in the grid to open the selection screen.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can
select specific filters for the report.

Clear All Filters. To reset each filter to include all, click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you select how you want the report to appear.The list on the left of the screen displays
formatting options for the Service and Sales Analysis Report. When you select an item in the list, the right side of
the screen displays selections for that section of the report.

Note: The heading defaults to Service and Sales Analysis Report in the Title field. You can leave this as the title
for your report or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your

organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

IE Mew Service and Sales Analyzsis Report
File Edit “iew Fawvortes Toolz Help

S & =2

1 Generall 2: Filters 3 Farmat |

B Headings Headings

Criteria :

Page Foater — Heading Format

Report Footer Title: ISewice atd Sales &nalysis Report

Miscellaneous
Colar Scheme

Subtitle:; |

Align: IEenter 'I

[¥ Print organization name in header

W Print Page Mumber in Heading [¥ Frirt Report Date in Heading
Format: IF'age 1 j Format: IShDrt Date and Time j
Mligr: [ Right =l signe [Lett =l

[¥ Print report heading on each page

< Back et Cancel Frrint Freview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the
report.

IE Mew Service and Sales Analyzsis Report
File Edit “iew Fawvortes Toolz Help

S & =2

1 Generall 2: Filters 3 Farmat |

Headings Criteria
E Criteria
v Frint these criteria on Ia separate page 'I

Page Footer

Fh.apnrt Footer Saved report name
Mizcellaneous Dutput query name

Color Scheme ] &nalyze by

Then by

Date order

Clients ta include

Client attributes to include
Credits to include

Charges to include
Tranzaction attributes to include
Post statues to include

Billing iterms to include
Invoices ta include

Returtis ba inchude

Billing item attributes to include

< Back | | (= | Cancel | Frrint | Freview | Layout |

Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align
the text. You can include the page number and date in the footer.

lﬂ MHew Service and Sales Analysis Report
File Edit %iew Favortes Toolz Help

eI el |

1 Generall 2 Filters 2 Farmat |

Headings Page Footer

Criteria

B Page Footer — Page Footer Text
Repart Footer Text:

Miscellansous
Colar Scheme

Aligr: IEenter 'I

[ Print Page Murnber in Footer [~ Print Report D ate in Footer
Format: IF'age 1 j Farmat: IShDrt Date and Time j
Aligre [ Right Bl || Al L =

< Back | THERt Cancel FErint Preview Layout
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Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to
align the text. The report footer appears at the end of the report.

n Mew Service and Sales Analysis Report
File Edit “iew Fawvortes Toolz Help

H &S D W ?-

1 General] 2 Filterz 3 Format l

5] Headings Report Footer

] Criteria

5] Page Footer Report Footer Text
B Fieport Footer Tent:

2] Mizcellaneous

] Color Scheme

< Back | | Cancel | Frrint | Freview | Layaut |

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

n Mew Service and Sales Analysis Report
File Edit “iew Fawvortes Toolz Help

H &S D W ?-

1 General] 2 Filterz 3 Format l

] Headings Miscellaneous

] Criteria
=] Page Foater Show currency character an All amounts
=] Report Footer Show percent sigh on Al amounts
= Meqative amount format [1234.5E)

3] Color Scheme Mumber of digits after decimal for amounts 2

Mumber of digits after decimal for percentages 2

Show 1000'z zeparator Yes

Show blanks instead of zeroz Mo

Fant size 8

Sample amaunt;
Arnount [$1.234.56)
Percent 100.00%

< Back Cancel Frrint Freview Layaut
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

IE Mew Service and Sales Analyzsis Report
File Edit “iew Fawvortes Toolz Help

S & =2

1 Generall 2: Filters 3 Farmat |

Headings
Criteria

Pane Foater
Feport Footer
Miscellaneous
B Color Scheme

Color Scheme

[~ &pply a Calor Scheme
. Columnn heading back color
I_ Column heading fore caolor
I_ Group heading back calor
. Group heading fore color

Hrestore [Vefaults |

Report Name
Subtitle

Group Headings

< Back | (=

Cancel

Frrint Freview Layout

Service and Sales Trend Analysis Report

The Service and Sales Trend Analysis Report provides a comparison of transaction data. This report is useful to
compare sales data for different time periods. You can break down the data by product or client criteria. For
example, you can create a report to show the quantity and amount of sales for this month, last month, and
month before, and break down each month by product and the gender of the client buying the product.

The Service and Sales Trend Analysis Report has tabs on which you set parameters: General, Filters, and Format.
To move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you

specify information to include in the report and how the report should look. For more information about creating
a report, see “Sending an Accounts Receivable report as email” on page 18.
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General Tab

On the General tab, define parameters and select information to include in the report.

n New Service and Sales Trend Analysis Report
File Edit ‘“iew Fawortez Toolz: Help

H &= & ?-

Frint a | Detail | reportin | Partrait w | orientation

Analyze by: |F'r0c|uct.n"BiIIing Item ﬂ Sart: |Ascending ﬂ [~ Page bieak
Then by |E|ient ﬂ Sort: |Ascending ﬂ [~ Page break
Date arder: |.t'-\scending ﬂ [~ Page break

[~ Create an output querny of

| Hest » | Cancel | Prrint | Frewiew ‘ Layout |

Print a [] report in [ ] orientation. Select to create a either a Detail or Summary report, then select either a
Portrait or Landscape orientation. If you select to create a Detail report, the dates you select in Detail on the
Format tab appear in the report. If you select to create a Summary report, no time period is specified. For
more information about the Format tab, see “Format Tab” on page 77.

Analyze by. In the Analyze by field, select the primary analysis criteria. In the Sort field, select to sort the
criteria in ascending or descending order. You can mark Page break to print each on a separate page.

Then by. In the Then by field, select the secondary analysis criteria. This is optional. In the Sort field, select to
sort the criteria in ascending or descending order. You can mark Page break to print each on a separate page.

Date order. If you are creating a Detail report, the dates you select in Detail on the Format tab appear in the
report. In the Date order field, select to sort the date ranges in ascending or descending order. For more
information about the Format tab, see “Format Tab” on page 77. You can mark Page break to print each on a
separate page.

Create an output query of [ ]. If you mark Create an output query of, you can select for the program to create
a query of the clients, charges, credits, or products and billing items included in the report. You can use the
query later in other areas of Accounts Receivable.

Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Client Attributes filter, only clients with the attributes you select appear in the report.
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On the Filters tab, you can include information based on selected criteria such as client attributes and post
statuses. For example, you can include selected client attributes, and only clients with the selected attributes
appear on the report. For more information about filtering in The Financial Edge, see the Program Basics Guide.

l@ Mew Service and Sales Trend Analysis Report Eq
File Edit “iew Favortes Tools Help
=l =R |

1: General 2 Filters | 3 Format |

" Clear &ll Filters
Filters I Include Selected Filkers

Clients Al <Al Clients

Client attributes all <all Client Attributes =

Charges Al <Al Charges >

Credits All <Al Credits =

Invoices Al <All Invaices=

Returns all <all Returns=

Transaction Attributes All <Al Transaction Attribukes =

Post Statuses all <Al Post Statuses=

Products and Billing Ikems all <Al Products and Billing Tkems =

Product and BGilling Item Ak... Al <Al Product and Billing Item Atkributes =

¢ Back | Ment » | Cancel | Prrint | Presiew Layout

Tip: You can double-click a filter in the grid to open the selection screen.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can
select specific filters for the report.

Clear All Filters. To reset each filter to include all, click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you select how you want the report to appear.The list on the left of the screen displays
formatting options for the Service and Sales Trend analysis Report. When you select an item in the list, the right
side of the screen displays selections for that section of the report.

Note: The heading defaults to Service and Sales Trend Analysis Report in the Title field. You can leave this as
the title for your report or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

IQ MNew Service and Sales Trend Analysiz Report [ x|
File Edit “iew Favorites Tools Help

RS 0w ?-

1 Generall 2 Filters 2 Format |

B Headings Headings
Criteria oadia ;
Dt -~ Heading Forma

Page Footer Title: |Service and Sales Trend Analysis Report
Fhlapolt Foater S ubtitle: I
Mizcellaneous

Colar Scheme Aligr: IEenter 'I

¥ Print organization name in header

v Print Page Mumber in Heading v Print Repart D ate in Heading
Farmat; IPage 1 j Format: I Short Date and Time j
Align: IHight j Aligr: ILeft j

[ Frint report heading on each page

£ Back | Hext = | Cancel | Frrint | Preview | Layout |

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the
report.

IE Mew Service and Sales Trend Analyziz Report
File Edit “iew Fawvortes Toolz Help

S & =2

1 Generall 2: Filters 3 Farmat |

Criteria
Detail [v Fiint these criteria on Ia separate page 'I

Pane Footer Saved report name
Report Footer Dutput query name
Miscellansous Analyze by
Caolor Scheme Then by

Date order

Clients ta include

Client attributes to include
Credits to include

Charges to include

Tranzaction attributes to include
Post statues to include

Billing iterms to include

Invoices ta include

Returtis ba inchude

Billing item attributes to include

< Back | | (= | Cancel | Frrint | Freview | Layout |

Detail. Use Detail to select the dates of the transactions to analyze in the report. You can select a general time
period or enter specific dates.

Note: The dates you select in Detail on the Format tab control the dates included in the report. Dates only
appear on the report if you select to create a Detail report on the General tab.

Use the Combine transactions by [ ] option to select a general time period to include in the report, including
Months, Quarters, and Years. In the Show field, you can further define the time period to include based upon
your Months, Quarters, or Years selection. All selections are general time periods, such as Month-to-date, so
you can rerun this report for current information without having to enter specific dates each time you run the
report. In the Across field, you can include all dates or enter a specific date range.
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Use the Combine transactions by specific dates option to enter specific dates to include in the report. In the
Transaction Date column, select a general time period, such as Month-to-date. If you select <Specific range>,
you can modify the start and end dates of the Start and End columns.

IE Mew Service and Sales Trend Analyziz Report
File Edit “iew Fawvortes Toolz Help

S & =2

1 Generall 2: Filters 3 Farmat |

Headings Detail
Criteria

B Detai

* Combine transactions by IMonths j

Page Footer
Report Foater Show IA” manths 'I
Miscellaneous Aoioss:

C | Include all dates v
Colar Scheme I [

" Combine tranzactions by specific dates

Transaction Date I Skart; End

< Back | | (= | Cancel | Frrint | Freview | Layout |

Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align
the text. You can include the page number and date in the footer.



lﬂ New Service and Sales Trend Analysis Report x|

File Edit ‘“fiew Favortes

S el |

Tool: Help

1 Generall 2: Filters  2: Format |

Headings
Criteria
Detail

o
Report Footer
Miscellaneous
Color Scheme

Page Footer

—Page Footer Text
Test:

Aligr: ICentel 'I

~ I Prirt Page Number in Foater

[~ Print Report Date in Footer
Farmat: I FPage 1 j Farmat: IShDrt Date and Time j
Algre [ Right = | A fLeit =
< Back | [ (= | Cancel | FErint | Presview | Layout |
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. Report Footer. Use Report

Footer to enter a maximum of 254 characters in the report footer and select how to align the text. The report
footer appears at the end of the report.

IE Mew Service and Sales Trend Analyziz Report
File Edit “iew Fawvortes Toolz Help

S & =2

1 Generall 2: Filters 3 Farmat |

Headings
Criteria
Detail
Page Footer
E Report Footer

Miscellaneous
Colar Scheme

Report Footer

Report Footer Text
Test:

Aligr: | Left ¥ [

< Back

et

Cancel Frrint Freview Layout
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

lQ Mew Service and Sales Trend Analysis Report x|
File Edit “iew Favorites Toolz Help

= D= N gl R

1 Generall 2: Filters  2: Farmat |

Headings Miscellaneous
Criteria

Detail Show currency character an All amaunts

Page Foater Show percent sign an All amounts
Report Footer

Megative amount format [1234.5E)
Color Sohems Mumber of digits after decimal for amaunts 2

Mumber of digits after decimal for percentages 2

Show 1000%: separator Tes

Show blanks instead of zeros Mo

Font size 2

Sample amaunt:

Amount [$1.234.56)
Percent 100.00%
< Back | Herts | Cancel | FErint | F'levieyl Layout |

Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.
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Reporting categories in Accounts Receivable include Action Reports, Analysis Reports, Bank Account Reports,
Client Reports, Deposit and Receipt Reports, Pivot Reports, Product and Billing Item Reports, and Transaction
Reports. This chapter discusses Bank Account Reports. For information about other report categories, see the
chapter for that category. For information about Pivot Reports, see the Pivot Reports Guide for The Financial
Edge.

Note: We recommend you read the documentation for The Financial Edge thoroughly. Information presented
here provides you with basic information about bank account reports in Accounts Receivable. Hands-on
experience is the best way to learn, so we encourage you to try various options with your database.

Bank Account Reports in Accounts Receivable include:
¢ Bank Profile Report

¢ Bank Reconciliation Report

¢ Bank Register Report

Bank Profile Report

The Bank Profile Report presents a summary profile of each designated bank. It provides basic bank account
information including account number, routing number, and address information. This report shows the total
debits and credits associated with each account. Adjustment transactions can also be included to further
facilitate the reconciliation process.

The Bank Profile Report has three tabs on which you set parameters: General tab, Filters tab, and Format tab. To
move among the tabs in a report, use Next and Back at the bottom of the screen or select the tab itself. On these
tabs you specify the records to include in the report and how the report should look. For more information about
creating a report, see “Creating a report in Accounts Receivable” on page 10.

General Tab

Glossary: A parameter is any field, option, or filter that narrows information in a report and determines the
appearance of the report’s output. By specifying parameters, you customize the output results of your report.
For example, you can apply filters, create a header and footer, or choose a color scheme for the report’s
results.
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On the General tab, define parameters and select information to include in the report.

u Hew Bank Profile Report
File Edit “iew Fawaorter Tools Help

H | &= G ? -
1: General ]g: Filters] 2 Format

Include this information:

¥ Cazh account information -
W Pavrnent information

W Reqgister ending balance

V¥ Surmary by tranzaction type

W Surmary by Blackbaud system

W Surmmary by post status j

Include tranzactions with these dates
Tranzaction date: |Inc|ude all dates ﬂ

Report orientation: | Landscape

| Hewut » ‘ Cancel

Frint Prewiew Layout

Include this information. Mark the checkboxes in this box to select bank information to include in the report.
Some options are available only if you have the optional module Cash Management.

Include transactions with these dates. In the Transaction date field of the Include transactions with these
dates frame, select a date or date range for the transactions to include in the report.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date forward, including
transactions with a date in the future, is included. If both fields are blank, all activity is included.

Note: Click Preview to view the report as it will print using your selections and filters. Click Layout to view a

sample layout of the report without data.

Report orientation. In the Report orientation field, select Portrait or Landscape.

Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Banks filter, only the banks you select are included in the report.
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On the Filters tab, you can filter the records appearing in the report. For more information about filtering in
The Financial Edge, see the Program Basics Guide.

I Mew Bank Profile Report E
File Edit “iew Favortes Tools Help
== R e |

1 General  2: Filters IE: Furmatl

&0 0pen 7 Clear &ll Filkers

Filkers I Include Selected Filkers
Barks all <Al Banks=>
< Back | Mext » | Cancel | Brint | Preview | Layout |

Open. Once you highlight a filter in the grid, click Open to access the Selected <Filter> screen on which you
select specific filters.

Clear All Filters. To reset each filter to include all, click Clear All Filters.
Filters. The Filters column lists all the available filters for this report. You cannot edit this column.

Include. In the Include column, if you choose Selected, the Selected <Filter> screen appears for you to designate
specific filters.

Selected Filters. After you have selected specific filters, they appear in the Selected Filters column.

Format Tab

On the Format tab, you select how you want the report to appear.The list on the left of the screen displays
formatting options for the Bank Profile Report. When you select an item in the list, the right side of the screen
displays selections for that section of the report.

Note: The heading defaults to Bank Profile Report in the Title field. You can leave this as the title for the report
or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your

organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

I Mew Bank Profile Report

File Edit “iew Fawvortes Toolz Help
SR -2 |
1 Generall 2: Filters 3 Farmat |
B Headings Headings
Criteria :
Sort — Heading Format
Pane Foater Title IBank Profile Report

Report Foater
Miscellaneous

Subtitle:; |

Align: IEenter 'I

[¥ Print organization name in header

W Print Page Mumber in Heading [¥ Frirt Report Date in Heading
Format: IF'age 1 j Format: IShDrt Date and Time j
Mligr: [ Right =l signe [Lett =l

[¥ Print report heading on each page

< Back et Cancel Frrint Freview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. All selections print in the criteria section of the report.

1@ Mew Bank Profile Report [ ]

File Edit “iew Fawvortes Toolz Help
SR -2 |
1 Generall 2 Filterz 3 Format |
Headings Criteria
B Criteria
Sort v Frint these criteria an Ia separate page 'I
Page Footer Saved report name
Fh.aport Footer Tranzaction dates ta include
Miscellaneous Banks to include
< Back | | (= | Cancel | Frrint | Freview | Layaut |

Sort. Use Sort to select the order in which information appears on the report. When you select Sort on the
Format tab, a grid appears so you can sort categories. Select a sorting category in the Sort by column and
select Ascending or Descending in the Order by column. To start the selected sorting category on a new page,
mark Page break on each new.
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If you make no selections in the Sort by column in the grid, the program sorts by the bank ID in ascending

order.
1@ Mew Bank Profile Report [ ]

File Edit “iew Fawvortes Toolz Help

e = el |

1 Generall 2 Filters

Headings
Criteria

] Sort by | Order by |
Page Footer Eank IO Azcending

Report Foater
Miscellaneous

™ Page break on each new

< Back | | (= | Cancel | Frrint | Freview | Layaut |

Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align
the text. You can include the page number and date in the footer.

I Mew Bank Profile Report
File Edit “iew Fawvortes Toolz Help

S & =2

1 Generall 2: Filters 3 Farmat |

Headings Page Footer
Criteria T
Sart — Fage Fooler | es

B Page Footer Text:
Repart Foater
Miscellaneous

Aligr: IEentel 'I

[ Print Page Murber in Footer [~ Print Report Date in Footer
Format: IF'age 1 j Format; IShDrt Date and Time j
Aligre [ Right Bl | Al fLeit =l

< Back et Cancel Frrint Freview Layout
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Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to
align the text. The report footer appears at the end of the report.

1@ Mew Bank Profile Report
File Edit “iew Fawvortes Toolz Help
EH &E %W & =

1 General] 2 Filterz 3 Format l

5] Headings Report Footer

] Criteria
5 Sot Report Footer Text
2] Page Foater Text:

I Repart Foater

2] Mizcellaneous

< Back | | Cancel | Frrint | Freview | Layaut |

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and to set the font size.

1@ Mew Bank Profile Report
File Edit “iew Fawvortes Toolz Help
EH &E %W & =

1 General] 2 Filterz 3 Format l

] Headings Miscellaneous

] Criteria
=] Sort Show currency character an All amounts
Z] Page Footer Show percent sigh on Al amounts
=] Report Footer Meqative amount format [1234.5E)
Mumber of digits after decimal for amounts 2
Mumber of digits after decimal for percentages 2
Show 1000'z zeparator Yes
Show blanks instead of zeroz Mo
Fant size 8

Sample amaunt;

Arnount [$1.234.56)
Percent 100.00%

< Back Cancel Frrint Freview Layaut
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Bank Reconciliation Report

Note: You can run the Bank Reconciliation Report from Reports and from Banks.

The Bank Reconciliation Report provides details of the reconciliation of the bank register with the bank
statement. In addition, this report lists all transactions included in the reconciliation process and all adjustments
(such as fees, interest earned, voided checks) recorded in the register at the date of reconciliation.

The Bank Reconciliation Report provides a way of trouble-shooting issues before you receive your bank
statement. From this report, you can print reconciliations from previous months, or a pre-reconciliation. With the
pre-reconciliation report, you can print a computer balance of the current account without actually reconciling
the account. This is similar to the transaction register you use to manually balance a personal checking account
until your bank account statement arrives.

The Bank Reconciliation Report has tabs on which you set parameters: General and Format. To move among the
tabs in a report, use Next and Back at the bottom of the screen or select the tab itself. On these tabs you specify
the records to include in the report and how the report should look. For more information about creating a
report, see “Creating a report in Accounts Receivable” on page 10.

General Tab

Glossary: A parameter is any field, option, or filter that narrows information in a report and determines the
appearance of the report’s output. By specifying parameters, you customize the output results of your report.
For example, you can apply filters, create a header and footer, or choose a color scheme for the report’s
results.

On the General tab, you can select parameters specific to the report and make selections about the information
included in the report.

I New Bank Reconciliation Report
File Edt “iew Favonter Tools Help

B &S & ?-

1. General ]g: Format]

Bank. account; |D|:uerating j |Dperating Account

Frint: | Reconciliation using thiz infarmation ﬂ

Beginning balance: |$0.00
Feconciliation date: {03,/10,/2002
Ending balance: $0.00

Show unreconciled tranzactions with these dates

Transaction date: |<5|;.e.;iﬁ.; range> ﬂ =| End date: ]
Report arientation: | Portrait -

Ment » Cancel Frint Prewiew Layout

Press F3 for today's date, FT for calendar
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Bank account. In the Bank account field, you can select the bank account to be included in the report.

Note: When creating a pre-reconciliation report in Banks, use the statement date from the Bank Account
Reconciliation screen in the Reconciliation date field. In Reports, use one month from the last reconciliation
date.

Print. In the Print field, select “Last completed reconciliation,” “Reconciliation using this information,” or
“Historical Reconciliation.” To review the most recent reconciliation, select Last completed reconciliation. To
create a pre-reconciliation report, select Reconciliation using this information. When you select this option,
you must enter information in additional fields.

If you select “Historical Reconciliation,” a drop-down menu appears and you can choose a historical
reconciliation from the list.

Beginning balance. The Beginning balance field is enabled only if you select Reconciliation using this
information in the Print field and the account has not been reconciled before. After you reconcile once, the
ending balance from the most recent reconciliation appears in the Beginning balance field and cannot be
edited.

Reconciliation date. The Reconciliation date field is enabled only if you select Reconciliation using this
information in the Print field. Enter the date of reconciliation.

Note: For a pre-reconciliation report, use the ending balance from the Bank Account Reconciliation screen in
Banks in the Ending balance field.

Ending balance. The Ending balance field is enabled only if you select Reconciliation using this information in
the Print field. Enter the ending balance in this field.

Show unreconciled transactions with these dates. In the Transaction date field of the Show
unreconciled transactions with these dates frame, select a date or date range for unreconciled transactions
to include in the report.

If you select <Specific range>, specify start and end dates. If the Start date field is left blank, all activity is
included up to the end date. If the End date field is left blank, all activity from the start date forward, including
transactions with a date in the future, is included. If you leave both fields blank, all activity is included.

Note: Click Preview to view the report as it will print using your selections and filters. Click Layout to view a
sample layout of the report without data.

Report orientation. In the Report orientation field, select Portrait or Landscape.

Format Tab

On the Format tab, you select how you want the report to appear.The list on the left of the screen displays
formatting options for the Bank Reconciliation Report. When you select an item in the list, the right side of the
screen displays selections for that section of the report.

Note: The heading defaults to Bank Reconciliation Report in the Title field. You can leave this as the title for
the report or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

IE Mew Bank Beconciliation Beport
File Edit “iew Fawvortes Toolz Help

S & =2

1: General 2 Format |

B esor

Criteria
Detsil — Heading Format
Sort Title: IBank Reconciliation Report
Page Footer Subiitle:

Report Foater
Mizcellansous Aligr: IEenter 'I

[¥ Print organization name in header

W Print Page Mumber in Heading [¥ Frirt Report Date in Heading
Format: IF'age 1 j Format: IShDrt Date and Time j
Mligr: [ Right =l signe [Lett =l

[¥ Print report heading on each page

< Back et Cancel Frrint Freview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. All selections print in the criteria section of the report.

lB Mew Bank Heconciliation Report [ ]

File Edit “iew Fawvortes Toolz Help
SR -2 |
1: General 2: Format |
Headings Criteria
B Criteria
Detail v Frint these criteria an Ia separate page 'I
Sort Saved report name
Page Footer Bank account
Report Foater Print
Mizcellaneous Beginning balance
Reconcilistion date
Ending balance
< Back | | (= | Cancel | Frrint | Freview | Layaut

Detail. Use Detail to select details specific to the Bank Reconciliation Report. You can mark checkboxes to print
transaction details for reconciling the bank register and cash accounts to the statement.

IE Mew Bank Beconciliation Beport
File Edit “iew Fawvortes Toolz Help

IR Tl |

1: General 2 Format |

Headings Detail

Criteria

: [¥ Print anzaction details for reconciling the register to the statement
Sart ¥ Cleared deposits o
Fage Foater ¥ Cleared deposit adiustrments

Repart Faater ¥ Cleared payments

Miscellansaus [ Cleared payment adjustrments

v Outstanding deposits
[ Outstanding deposit adjustments
[ Outstanding payments LI

[ "

¥ Piint ranzaction details for reconciling the cash account(z) to statement

¥ Cleared posted

¥ Cleared not yet posted

[ Cleared posted after statement ending date

v Outstanding posted

[+ Outstanding not et posted

[ Outstanding posted after statement ending date

< Back et Cancel Frrint Freview Layout
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Sort. Use Sort to select the order in which information appears on the report. When you select Sort on the
Format tab, a grid appears so you can sort categories. Select a sorting category in the Sort by column and

select Ascending or Descending in the Order by column.

IE Mew Bank Beconciliation Beport
File Edit Help

S & =2

Yiew Faworter Toolz

1: General 2 Format |

Headings

Criteria

Detail

D —
Page Footer

Report Foater
Miscellaneous

Sort

Sort by

Order by
Azcending

Tranzaction number

< Back | | (= | Cancel |

Frrint | Plevieﬂl Layout |

the text. You can include the page number and date in the footer.

lﬂ Mew Bank Reconciliation Report
File Edit

Yiew Faworter  Toolz

Help

eI el |

Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align

1: General 2 Format |

Headings Page Footer
Criteria ——
Detail — Fage Footer Tex
Sort Text:

B Page Footer

Report Footer
Miscellansous

Aligr: IEenter 'I

[ Print Page Murnber in Footer

[~ Print Report D ate in Footer
Format: IF'age 1 j Farmat: IShDrt Date and Time j
Aligre [ Right Bl || Al L =
< Back | THERt Cancel FErint Preview Layout
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Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to
align the text. The report footer appears at the end of the report.

n Mew Bank Heconciliation Report
File Edit “iew Fawvortes Toolz Help
EH &E %W & =

1: General 2: Format ]

=] Headings Report Footer

] Criteria

5 Detail Report Footer Text

2 St Text: |

< Back | | Cancel | Frrint | Freview | Layaut |

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and to set the font size.

n Mew Bank Heconciliation Report
File Edit “iew Fawvortes Toolz Help

H &S D W ?-

1: General 2: Format ]

] Headings Miscellaneous

] Criteria
=] Detail Show currency character an All amounts
=] Sort Show percent sign on Al amounts
=] Page Footer Meqative amount format [1234.5E)
- HportFoter Murnber of digits after decimal for amaunts 2
ad Mumber of digits after decimal for percentages 2

Show 1000'z zeparator Yes

Show blanks instead of zeroz Mo

Fant size 8

Sample amaunt;

Arnount [$1.234.56)
Percent 100.00%

< Back Cancel Frrint Freview Layaut
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Bank Register Report

The Bank Register Report presents transactions in the register of a bank account. This report provides a summary
statement or can be filtered to display specific information. For example, you can filter the report to display only
outstanding deposits posted to Accounts Receivable. In summary format, the report only gives a grand total for
each transaction type. In detail format, the report lists each item and gives a grand total.

The Bank Register Report has tabs on which you set parameters: General tab and Format tab. To move between
the tabs in a report, use Next and Back at the bottom of the screen or select the tab itself. You can filter bank
transactions by clicking the Filters button found on the General tab. On these tabs you specify the records to
include in the report and how the report should look. For more information about creating a report, see “Creating
a report in Accounts Receivable” on page 10.

General Tab

Glossary: A parameter is any field, option, or filter that narrows information in a report and determines the
appearance of the report’s output. By specifying parameters, you customize the output results of your report.
For example, you can apply filters, create a header and footer, or choose a color scheme for the report’s
results.

On the General tab, define parameters and select information to include in the report. The Bank Register Report
does not have a Filters tab; you can filter bank transactions for this report by clicking the Filters button found on
the General tab.

u Hew Bank Register Report
File Edit “iew Fawaorter Tools Help

H &S W e
1: General ]g: Format]

Feport format: Detail - Filters...

Bank account; |Dpelating ﬂ Operating Account

Show transactions with these dates
Tranzaction date: |Inc:|uc|e all dates ﬂ

[ Landscane [

| Hewut » Cancel Frint Prewiew Layout

Report format. In the Report format field, select Detail or Summary. Detail lists each transaction as a separate
item. Summary gives a total amount for each transaction type.

Bank account. In the Bank account field, select the bank account to include in the report.
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Show transactions with these dates. In the Transaction date field of the Show transactions with these
dates frame, select a specific date or date range for transactions to include in the report.

Note: Click Preview to view the report as it will print using your selections and filters. Click Layout to view a
sample layout of the report without data.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date forward, including
transactions with a date in the future, is included. If both fields are blank, all activity is included.

Report orientation. If you create the report in summary format, select Portrait or Landscape. If you create the
report in detail format, the report print in Landscape.

Note: The filters function for the Bank Register Report differs from all other reports. Click the Filters button on
the General tab to filter bank transactions.

Filters button. The filters function for the Bank Register Report differs from all other reports. When you click
the Filters button, the Transaction Filters for Bank Name screen appears. Five filter options (General, System,
Transaction Type, Transaction Status, and Post Status) are found in a list on the left side of the screen.

Filters Button

Note: The Filters button for the Bank Register Report is very similar to the Filters button found on the bank
register screen for a bank account.

When you click Filters, the Transactions Filters for Student Billing & Accounts Receivable screen appears. The list
on the left of the screen displays filters for the report. When you select an item in the list, the right side of the
screen displays selections for that filter.

General. Use General to establish date and amount ranges for payments and deposits. When you click in a
column, you can select dates from a calendar or enter amounts using a calculator.

S_l,lstem

Tranzaction Tvpe Show deposits with these dates
Tranzaction Status Show papments with these dates
Fost Status

Show deposits with these amounts

Show payments with these amounts

Beset Filters ta Show All Transactions 0k I Cancel

Note: To reset all filters on the Transaction Filters screen to show all, click Reset Filters to Show All
Transactions.



BANK ACCOUNT REPORTS 99

System. Use System to select which Blackbaud programs to include in the report. In the Show? column, mark
checkboxes for the programs to include.

% Transaction Filters for Operating Account

Lieneral System | Show? |

Tranzaction Type General Ledger 2

Trarsaction Status Accounts Payable ™2

Posgt Statuz .
Accounts Receivable I
Student Billing v
Fayrall W
Fived dzsetz v
Cash banagemsnt W
Cazh Receipts v

Beset Filkers ta Show All Transactions 0k I Cancel

Note: To quickly mark or unmark all checkboxes, click Select All or Deselect All.

Transaction Type. Use Transaction Type to select transaction types to include in the report. In the Show?
column, mark checkboxes for the transaction types to include. In the Start Number and End Number
columns, enter beginning and ending transaction numbers.

% Transaction Filters for Operating Account

General Transaction Type I Shu:uw?l Start Murnber End Mumber |
T rarsaction 1 40e b arial Check
Transaction Status Computer Check:
Post Status One-Time Check
EFT Check.
Bank Drraft
D eposit

Adjuztment-Deposit
Adjuztrent-Payment

Adjuztrent-Tranzfer in

R R R R R R A A

Adjuztrnent-Tranzfer out

Beset Filkers ta Show All Transactions 0Ok I Cancel
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Transaction Status. Use Transaction Status to select which bank register transaction statuses to include in the
report. In the Show? column, mark checkboxes for the transaction statuses to include. In the Start Date and
End Date columns, enter beginning and ending dates, or click the fields to select dates from a calendar.

% Transaction Filters for Operating Account

General Status | Shnw?l Start Date | End Drate |
System -
Tranzaction Tt Outstanding =
iran:- ! Clearad v
o s Reconciled I~
Yaided =

Beset Filkers to Show AIITransactionsl 0Ok I Cancel |

Post Status. Use Post Status to select post statuses to include in the report. In the Show? column, mark
checkboxes for the post statuses to include. In the Start Date and End Date columns, enter beginning and
ending dates, or click the fields to select dates from a calendar.

% Transaction Filters for Operating Account

ger:eral Post Status | Show? | Start D ate | End Date |
yatem
Tranzaction Type Mot pet posted V

Transactiu:un Status Pozted 7
; Do niot post I

Stabus

OF. I Cancel |

Beset Filkers ta Show All Transactions

Format Tab

On the Format tab, you select how you want the report to appear.The list on the left of the screen displays
formatting options for the Bank Register Report. When you select an item in the list, the right side of the screen
displays selections for that section of the report.

Note: The heading defaults to Bank Register Report in the Title field. You can leave this as the title for the
report or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading and whether to
include the heading on every page of the report.

IE Mew Bank Reqizter Report
File Edit “iew Fawvortes Toolz Help

S & =2

1: General 2 Format |

B esor

Criteria
Detsil — Heading Format
Sort/Break Title IBank Register Report
Page Footer Sublite: |

Report Foater

Mizcellansous Aligr: IEenter 'I

Color Schems . . .
[¥ Print organization name in header

W Print Page Mumber in Heading [¥ Frirt Report Date in Heading
Format: IF'age 1 j Format: IShDrt Date and Time j
Mligr: [ Right =l signe [Lett =l

[¥ Print report heading on each page

< Back et Cancel Frrint Freview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. All selections print in the criteria section of the report.

lB Mew Bank Hegister Report [ ]

File Edit “iew Fawvortes Toolz Help
SR -2 |

1: General 2: Format |

Headings Criteria

B Criteria

Diatail [ Print these criteria on Ia separate page 'I

Sort/Bresk Saved report name -
Page Foater Bank account to include —
Report Footer Tranzaction dates to include

Mizcellaneous Depasit dates to include

Color Scheme Payment dates to include

Deposit amounts to include

Payrment amounts to include
Blackbaud systems to include
Transaction types to include

Manual check numbers to include
Computer check numbers to include
Ore-time check numbers to include
Bank draft numbers to include

Deposit humbers to include
Adjuztment deposit numbers to include
Adjustment payment numbers to include ;I

< Back | | (= | Cancel | Frrint | Freview | Layaut

Detail. Use Detail to select details specific to the Bank Register Report. Mark the checkboxes to show distribution
by transaction characteristics. If you have the optional module Projects and Grants and have defined
transaction codes, additional checkboxes appear.

lﬂ Mew Bank Register Report
File Edit %iew Favortes Toolz Help

eI el |

1: General 2 Format |

Headings Detail

Criteria

B Detail ™ Show distribution for these characteristics
Sort/Break
Page Footer
Report Footer
Miscellansous
Colar Scheme

U|:'|
[ oo

B

< Back | THERt Cancel FErint Preview Layout
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Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall
between sets of information.

To order the information, you can select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break?
for a category, fields are enabled for you to specify more information about the break for the selected sorting
category.

In the Text before value and Text after value fields, you can enter up to 30 characters to print directly before
and after the value for the selected sorting category.

To print the number or percentage for the selected category in the footer, mark Print count per or Print count
as a percentage of total for the selected sorting category. To start the selected sorting category on a new
page, mark Page break on each new.

IE Mew Bank Reqizter Report
File Edit “iew Fawvortes Toolz Help

S & =2

1: General 2 Format |

Headings Sort/Break

Criteria

Detail Sart by | Order by | Breakz |
B S ak.

Page Footer

Report Foater
Miscellaneous
Colar Scheme

Tranzaction number Azcending

i e e

Break Header for Tranzaction number -

Text before valus: |

Tewut after walue: I

Break Footer for Tranzaction number-
™| Fiirit cournt gern Tatsaction number

[ Eritt count as & percentage of total

I=| Page break on eachinew Transaction Aumter

< Back et | Cancel | Frrint Freview Layout
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Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align
the text. You can include the page number and date in the footer.

lB Mew Bank Hegister Report [ ]

File Edit “iew Fawvortes Toolz Help
SR -2 |

1: General 2: Format |

Headings Page Footer

Criteria
Detail — Page Footer Text
Sort/Break Test:

B Page Foater

Report Foater
Miscellaneous

Calar Scheme Alige: IEenter 'l

[ Print Page Murmber in Footer [~ Print Report Date in Foater
Forrnat: IF'age 1 j Format: IShort Date and Time j
Align | Right 2 [ e =
< Back | | (= | Cancel | Frrint | Freview | Layaut |

Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to
align the text. The report footer appears at the end of the report.

IE Mew Bank Reqizter Report
File Edit “iew Fawvortes Toolz Help

S & =2

1: General 2 Format |

Headings Report Footer

Criteria
Detail Report Footer Text
Sont/Break Tent:
Page Footer

E Report Footer

Miscellaneous

Calor Scheme Aligr: ILeft ']

< Back et Cancel Frrint Freview Layout
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and to set the font size.

lQ Mew Bank Register Report x|
File Edit “iew Favorites Toolz Help

= D= N gl R

1. General 2 Format |

Headings Miscellaneous
Criteria

Detail Show currency character on All amaounts
Sort/Break Show percent sign an All amounts
Page Footer Megative amount format [1234.56]
HeportFoter Murnber of digits after decimal for amaunts 2
Calor Seme Mumber of digits after decimal for percentages 2

Show 1000%: separator Tes

Show blanks instead of zeros Mo

Font size 2

Sample amaunt:

Amount [$1.234.56)
Percent 100.00%
< Back | Herts | Cancel | FErint | F'levieyl Layout |

Color Scheme. You can apply a color scheme to the column heading and group heading of the report. When
you click in the color box next to the selection, a Color screen appears from which you can select a standard

color or define a custom color. If you leave Apply a Color Scheme checkbox unmarked, the report prints in
black.
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Reporting categories in Accounts Receivable include Action Reports, Analysis Reports, Bank Account Reports,
Client Reports, Deposit and Receipt Reports, Pivot Reports, Product and Billing Item Reports, and Transaction
Reports. This chapter discusses Client Reports. For information about other report categories, see the chapter for
that category. For information about Pivot Reports, see the Pivot Reports Guide for The Financial Edge.

Note: We recommend you read the documentation for The Financial Edge thoroughly. Information presented
here provides you with basic information about client reports in Accounts Receivable. Hands-on experience is
the best way to learn, so we encourage you to try various options with your database.

Client Reports in Accounts Receivable include:

¢ Client Account Activity List

¢ Client Account Activity Report

¢ Client Account Balance Report

¢ Client Profile Report

¢ Client Statistics Report

The Client Account Activity Report and Client Account Balance Report are versatile reports that offer your
organization numerous reporting options. To understand the full capacity of these reports, see “Payer and
Recipient Detail” on page 132.

Client Account Activity List

The Client Account Activity List is designed to match the Activity tab of a client record when no filters are applied.
The report lists all activity generated by a client, as well as any activity for which a client is responsible.

The Client Account Activity Report has tabs on which you set parameters: General, Filters, and Format. To move
among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify
information to include in the report and how the report should look.For more information about creating a
report, see “Creating a report in Accounts Receivable” on page 10.
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General Tab

On the General tab, define parameters and select information to include in the report.

IQ New Client Account Activity List E I

File Edit Wiew Favorites Tools Help
RS -2 |

1. General |2: Fillersl 3 Format |

Ihelude tranzactions with these dates.

Transaction date: |1 RS IE T

Include clients with:

v Mo activity

v & balance over: |$D.DD

[+ & credit balance

[ & zemo balance

[~ Dizplay a surnmary balance for tranzactions before: I

[~ Create an output query of clients

R eport onentation; IPortrait 'I

< Back | Hewut » | Cancel | Print | Preview | Layout |

Transaction date. In the Transaction date field, select a date or date range for the transactions to include in the
report.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date forward, including
transactions with a date in the future, is included. If both fields are blank, all activity is included.

Include clients with [ ]. You can select to include clients with no activity. You can designate a minimum
balance the client must have to be included; all clients with balances less than or equal to the amount you
enter are excluded. You can also select to include clients with a credit balance or a zero balance.

Display a summary balance for transactions before [ ]. To include a summary balance on the report,
mark the checkbox and enter a date up to which to summarize transactions.

Create an output query of clients. If you mark Create an output query of clients, the program creates a
query of clients included in the report. You can use the query later in other areas of Accounts Receivable.

Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering in
The Financial Edge, see the Program Basics Guide.

IQ Mew Client Account Ackivity List I
File Edit Wiew Favorites Tools Help
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Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you specify how the report looks. A description of each formatting option is provided.

Headings. You can enter a maximum of 60 characters in each of the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select the heading alignment and if your organization’s name
appears in the header.
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You can include other options in the header, such as the page number and the date. You can also select to

include the header on every page of the report.
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= R e =

lE New Client Account Activity List ﬂ I

il Genelall 2: Filters ~ 3: Farmat |

|

Criteria )
Detail — Heading Farmat
Sort/Break Title:  |Client Account Activity List

Page Footer

Fieport Footer
Miscellaneous
Color Scheme

Subtitles |

Align: I Center i I

v Print organization narne in header

v Print Page Number in Heading
Format; IF'age 1 j

Align: | Right =]

[v Print Report Date in Heading
Farmat: I Short Date and Time j

Align: | Left =]

¥ Print report heading on each page

< Back | Hexts | Cancel | Frrint | Preview | Layout |

Criteria. Use Criteria to help you remember the criteria you used to create the report. Mark Print these criteria

on and select a separate page or the first page. Your selections print in the criteria section of the report.

File Edit “iew Faworites Tools Help
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Detail. Use Detail to make the report match the client’s Activity tab. To make the report like the Activity tab,

mark the same checkboxes that are marked on the clients’ records.

To list payments with the charges to which the payments and credits were applied, mark Show

credits/payments with their associated charges.

If transactions are distributed to multiple clients, you can mark Show <Distributed> transactions on multiple

lines to break the distributions into separate lines.

To break invoices into line items, mark Show invoice/line item detail. With this box marked, line items are
treated like charges. In the Show field, select whether you see the invoice information or billing item

description for the line item.

lg MNew Client Account Activity List

File Edit “iew Faworites Tools Help
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Sort/Break. Use Sort/Break to select the order in which information appears on the report. When you select
Sort/Break on the Format tab, a grid displays the categories you can sort in the report. Select a sorting
category in the Sort by column and select Ascending or Descending in the Order by column.

If you make no selections in the Sort by column in the grid, the program sorts by the entire requisition

number in ascending order.
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You can also create breaks between the sections you have sorted by. In the Text before value and Text after
value fields, you can enter up to 30 characters in each field for information you want to print directly before
and after the break. If you mark Print count per Client Name or Print count as percentage of total for the
selected sort field, the number or percentage for each selected sort option appears in the footer. If you mark
Page break on each new Client Name, a new page starts for the highest level break.

lg MNew Client Account Activity List I
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field to print as the page footer. You can select the alignment
of the footer and to include other options, such as the page number and date.

lE MNew Client Account Activity List I
Fil= Edit “iew Fawvorites Tools Help
HRSRE -2
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Report Footer. Use Report Footer enter a maximum of 254 characters in the Text field and select the footer
alignment. The report footer appears at the end of the report.

Ig MNew Client Account Activity List I
File Edit Wiew Favorites Tools Help
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Miscellaneous. Use Miscellaneous to specify the font size and how numbers appear on the report.

Ig New Client Account Activity List
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears. You can select a standard color or define a custom color. If you leave

the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.
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Client Account Activity Report

Use the Client Account Activity Report to list transactions for specific clients. The Client Account Activity Report is
a versatile report you can use to report on charges generated by clients and who is responsible for the charges.
You can also run the report for charges for which clients are responsible, and who generated the charges. Many
filters are available for you to customize the output of a report.

You can use this report whether you use a single-party billing system or third-party billing system. If you use a
third-party billing system, keep the definitions of payer and recipient clients in mind:

e A payeris a client, either an individual or an organization, who is responsible for paying a bill.

¢ Arecipient is a client who receives a product or service or who has their balance reduced by a payment or
credit.

The following scenarios present common uses of the Client Account Activity Report:

Using payer and recipient client filters. On the Filters tab, you can filter by both payer and recipient clients.
If an organization pays some portion of a bill for multiple clients, you can select the insurance company as the
payer client and select the clients that are paid by the company as the recipient clients.

Using a single-party billing system. In a single-party billing system, charges incurred by a client are paid by
a client. In this case, it does not matter whether you report by payer or recipient in Detail on the Format tab.
However, to show payments along with the charges to which they were applied, report by payer and mark
Show credits/payments with their associated charges.

Also in Detail on the Format tab, you should select to report in detail, but do not select to show payer or
recipient details because that adds useless lines to the report.

Reporting on a single client. You can generate the report for a single client. For example, you can create the
report for a client calling in to dispute a charge or get an update on his activity.

To see all charges for which the client is responsible, on the Filters tab, select the client in the Payer Clients
row.

If the client is only interested in charges generated by specified clients, select those clients in the Recipient
Clients row. Otherwise, include all recipient clients.

In Detail on the Format tab, select to report by payer, in detail, and show recipient details. The report shows
every charge for which the client is responsible, and which client generated those charges. To also show all
payments and credits owned by the client, and who was the beneficiary of those payments, mark Show
credits/payments with their associated charges.

Making the report look like a statement. Statements are also versatile, but this example is for a common
statement setup to show only charges that are directly assigned to the statement recipient. To match this on
the Client Account Activity Report, on the Filters tab, select the statement recipient in the Payer Clients row.
In Detail on the Format tab, select to report by payer, in detail, and show recipient details. If you show all
charges on a statement, you can match the report results more consistently to the statement if you do not
show recipient details.

Making the report look like the Activity tab of a client record. If you have certain clients designated as
payers only and certain clients designated as recipients only, in Detail on the Format tab, report by recipient,
in detail. To match the Show <Distributed> transactions on multiple rows setting on the Activity tab, select
to show payer details on the report.

If certain clients are both the payers of their own charges and other clients charges, the only way to get the
activity to match up on a transaction-for-transaction basis is to run the report including the clients as both
payers and recipients. To run a report to match the Activity tab or a client record, regardless of whether the
client is a payer or recipient, use the Client Account Activity List. For more information, see “Client Account
Activity List” on page 108.
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The Client Account Activity Report has tabs on which you set parameters: General, Filters, and Format. To move
among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify
information to include in the report and how the report should look. For more information about creating a
report, see “Creating a report in Accounts Receivable” on page 10.

General Tab

On the General tab, define parameters and select information to include in the report.

File Edit Wiew Favorites Tools Help
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Transaction date. In the Transaction date field, select a date or date range for the transactions to include in the

report.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date forward, including
transactions with a date in the future, is included. If both fields are blank, all activity is included.

Include clients with [ ]. You can select to include clients with no activity. You can designate a minimum
balance the client must have to be included; all clients with balances less than or equal to the amount you
enter are excluded. You can also select to include clients with a credit balance or a zero balance.

Display a summary balance for transactions before [ ]. To include a summary balance on the report,
mark the checkbox and enter a date up to which to summarize transactions.

Show client balance as of [ ]. To include the client’s balance amount, mark Show client balance as of and

enter the end date for reporting the balance.

Create an output query of clients. If you mark Create an output query of clients, the program creates a
query of clients included in the report. You can use the query later in other areas of Accounts Receivable.

Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Client Attributes filter, only clients with the attributes you select appear in the report.

On the Filters tab, you can filter the records appearing in the report. For more information about filtering in
The Financial Edge, see the Program Basics Guide.

IQ Mew Client Account Activity Report E
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Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you specify how the report looks. A description of each formatting option is provided.

Note: The heading defaults to Client Account Activity Report in the Title field. You can leave this as the title for
the report or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.
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Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. All selected options print in the criteria section of the report.
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Note: The Detail panel is important in determining the output of the report. For more information about this
panel, see “Client Account Activity Report Detail Panel” on page 133.

Detail. The Detail panel is significant to the output of the report. In the Report by field, you can select Payer or
Recipient. If you select payer, you can report in detail or summary and show or not show recipient detail. If
you select recipient, you can report in detail or summary and show or not show payer detail.

IM

For more information about the Detail panel, see “Client Account Activity Report Detail Panel” on page 133.

Reporting by payer also allows you to mark Show payments/credits with their associated charges.

Invoices are summarized on the report. To show the invoices broken down to line item details instead, mark
Show invoice/return line item detail. In the Show field, you can select for the line item description to be
invoice information (invoice and line item number) or the billing item description.
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To determine how client names appear on the report, select a client salutation. Salutations are defined in

Configuration.
lB Mew Client Account Activity Report [ ]
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Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall
between sets of information.

To order the information, you can select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break?

for a category, fields are enabled for you to specify more information about the break for the selected sorting
category.

In the Text before value and Text after value fields, you can enter up to 30 characters to print directly before
and after the value for the selected sorting category.
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To print the number or percentage for the selected category in the footer, mark Print count per or Print count
as a percentage of total for the selected sorting category. To start the selected sorting category on a new
page, mark Page break on each new.
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

lﬂ MHew Client Account Activity Report
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

n Mew Client Account Activity Report
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box
next to the selection, the Color screen appears so you can select a standard color or define a custom
color. If you leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.
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Client Account Balance Report

Use the Client Account Balance Report to list account balances for specific clients.

You can use this report whether you use a single-party billing system or third-party billing system. If you use a
third-party billing system, keep the definitions of payer and recipient clients in mind:

e A payeris a client, either an individual or an organization, who is responsible for paying a bill.

e Arecipient is a client who receives a product or service or who has their balance reduced by a payment or
credit.

The Client Account Balance Report has tabs on which you set parameters: General, Filters, and Format. To move
among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify
information to include in the report and how the report should look. For more information about creating a
report, see “Creating a report in Accounts Receivable” on page 10.
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General Tab

On the General tab, define parameters and select information to include in the report.
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Calculate balance as of [ ]. Select the date up to which to calculate account balances. You can select Today or
select <Specific date> and enter the date.

Include clients with [ ]. You can select to include clients with no activity. You can designate a minimum balance
the client must have to be included; all clients with balances less than or equal to the amount you enter are
excluded. You can also select to include clients with a credit balance or a zero balance.

Create an output query of clients. If you mark Create an output query of clients, the program creates a
query of clients included in the report. You can use the query later in other areas of Accounts Receivable.

Report orientation. In the Report orientation field, select Portrait or Landscape.

Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Client Attributes filter, only clients with the attributes you select appear in the report.
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On the Filters tab, you can filter the records appearing in the report. For more information about filtering in
The Financial Edge, see the Program Basics Guide.
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< Back | Mext » | Cancel | Brint | Preview | Layout

Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you specify how the report looks. A description of each formatting option is provided.

Note: The heading defaults to Client Account Balance Report in the Title field. You can leave this as the title for
the report or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

IE Mew Client Account Balance Report
File Edit “iew Fawvortes Toolz Help

IR Tl |

1 Generall 2: Filter

B esor

Criteria
Detsil — Heading Format
Sort/Break Title: ICIient.t’-‘«ccount Balance Report
Page Footer Subiitle:

Report Foater

Mizcellansous Aligr: IEenter 'I

Color Schems . . .
[¥ Print organization name in header

W Print Page Mumber in Heading [¥ Frirt Report Date in Heading
Format: IF'age 1 j Format: IShDrt Date and Time j
Mligr: [ Right =l signe [Lett =l

[¥ Print report heading on each page

< Back et Cancel Frrint Freview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Select Criteria to print a list of criteria used to create the report. Mark Print these criteria on and select
a separate page or the first page. All selected options print in the criteria section of the report.

lB Mew Client Account Balance Report [ ]

File Edit “iew Fawvortes Toolz Help

e = el |

1 Generall 2 Filters

Headings Criteria

B Criteria

Diatail [ Print these criteria on Ia separate page 'I
Sort/Bresk Saved report name

Page Footer Dutput quen name

Report Footer Calculate aging as of

Miscellaneous Include clients with a balance greater than
Calor Scheme Inzlude cliznts with no activity

Include clients with a balance greater than a specified amount
Include clients with a credit balance

Include clients with a zero balance.

Payer clients to include

Payer client attributes to include

Payer client statuses to include

Recipient clients to include

Recipient client attibutes to include

Recipient client statuzes to include

< Back | (= Cancel Frrint Freview Layaut

Note: The Detail panel is important in determining the output of the report. For more information about this
panel, see “Client Account Balance Report Detail Panel” on page 139.

Detail. The Detail panel is significant to the output of the report. In the Report by field, you can select Payer or
Recipient. You can then select to show or not show payer or recipient details.

For more information about payer and recipient details, see “Client Account Balance Report Detail Panel” on
page 139.
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To determine how client names appear on the report, select a client salutation. Salutations are defined in

Configuration.
lB Mew Client Account Balance Report [ ]
File Edit “iew Fawvortes Toolz Help
SR -2 |
1 Generall 2 Filters
Headings Detail
Criteria
Repart by: IPaye[ j andlsh.;.w j recipient details.
Sort/Break :
Page Footer Client Salutation: ICIient name =]
Report Foater
Miscellaneous
Calor Scheme
< Back | | (= | Cancel | Frrint | Freview | Layaut |

Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall
between sets of information.

To order the information, you can select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break?
for a category, fields are enabled for you to specify more information about the break for the selected sorting
category.

In the Text before value and Text after value fields, you can enter up to 30 characters to print directly before
and after the value for the selected sorting category.
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To print the number or percentage for the selected category in the footer, mark Print count per or Print count
as a percentage of total for the selected sorting category. To start the selected sorting category on a new
page, mark Page break on each new.

IE Mew Client Account Balance Report
File Edit “iew Fawvortes Toolz Help
=R RE = el |
1 Generall 2: Filters ]
Headings Sort/Break
Criteria
Detail Sart by | Order by | Break? |
=] ek, Payer Mame Azcending il
Page Footer Recipient Mame Azcending v
Report Foater r
Miscellaneous
Color Scheme r
-
Break Header for Payer Hame:-
Text before value: |
Text after value: |
Break Footer far Payer Mame:
[ Print count per Payer Mame
[ Print count as a percentage of tatal
[" Page break on each new Paper Name
< Back | | (= | Cancel | Frrint | Freview | Layout |

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

lﬂ Mew Client Account Balance Report
File Edit %iew Favortes Toolz Help

eI el |

1 Generall 2: Filters

Headings Page Footer

Liltera Page Footer Text
Detail B

Sort/Break, Text:

B Page Footer
Report Footer
Miscellansous

Colar Scheme Aligr: Il:entel 'I

[ Print Page Murnber in Footer [~ Print Report D ate in Footer
Format: IF'age 1 j Farmat: IShDrt Date and Time j
Aligre [ Right Bl || Al L =

< Back | THERt Cancel FErint Preview Layout
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

lB Mew Client Account Balance Report [ ]
File Edit “iew Fawvortes Toolz Help
?- |

1 Generall 2: Filters

Headirgs Page Footer
Criteria —
Dretail — Fage Footer Tex

Sort/Break Text:
B Page Foater

Report Foater
Miscellaneous

Calar Scheme Alige: IEenter 'l

[ Print Page Murmber in Footer

[~ Print Report Date in Foater
Forrnat: I Page 1 j Format: IShort Date and Time j
Align | Right 2 [ e =
< Back | | (= | Cancel | Frrint | Freview | Layaut |

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

lB Mew Client Account Balance Report [ ]
File Edit “iew Fawvortes Toolz Help
r- |

1 Generall 2: Filters

Headings Miscellaneous
Criteria

Detail Show currency character an All amounts
Sort/Break Show percent sigh on All amaounts
. Page Footer Meqative amount format [1234.5E)
. HEDD“ Footer Mumber of digits after decimal for amounts 2
. 5 Color Scheme Mumber of digits after decimal for percentages 2

Show 1000'z zeparator Yes

Show blanks instead of zeroz Mo

Fant size 8

Sample amaunt;

Arnount [$1.234.56)
Percent 100.00%

< Back | (= Cancel Frrint Freview Layaut
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box
next to the selection, the Color screen appears so you can select a standard color or define a custom
color. If you leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

lB Mew Client Account Balance Report [ ]
File Edit “iew Fawvortes Toolz Help

FHEERE |
Headings Color Scheme

Criteria

Detail [ Apply a Color Scheme

Sort/Break
Page Footer

1 Generall 2 Filters

Report Name
M Column heading back calar Subtitle

Miscellaneous

B Color Scheme

[~ Group heading back colar Group Headings

. Group heading fore color

Fiestore [Vefaults |

< Back Hewts Cancel Frint Preview Lapout

Payer and Recipient Detalil

This section elaborates on the Detail panel on the Format tab of the Client Account Activity and Client Account
Balance reports. The Detail panel is a determining factor in the output of these reports. Hands-on experience is
the best way to learn, so we encourage you to try various options with your database.

Note: If you are using a single-party billing system, it does not matter whether you report by payer or
recipient. To prevent useless lines in the report, do not show payer or recipient details.

You can use these reports whether you use a single-party billing system or third-party billing system. If you use a
third-party billing system, keep the definitions of payer and recipient clients in mind:

¢ A payer is a client, either an individual or an organization, who is responsible for paying a bill.

¢ Arecipientis a client who receives a product or service or who has their balance reduced by a payment or
credit.
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Client Account Activity Report Detail Panel

The Detail panel of the Client Account Activity Report plays a key role in the output of the report. With this
screen, you determine the grouping and quantity of information appearing on the report. For more information
about this report, see “Client Account Activity Report” on page 116.

1@ New Client Account Activity Report
File Edit “iew Fawortez Toolr Help

WS G- |

1: Generall 2: Filkers

Headingz Detail
Criteria

N r——

Sort/Break : - - .
Report in: and 1ecipient details.

Page Foater [ IDeta|I j IShow j ]

Report Footer Show IF'ayrnent 1eference j in the: payment detail colurin

Miscellaneous

Colar Sch [~ Show creditz/payments with their aszociated charges
olor Scheme

[~ Show irvoice/return ling itern detail

Shaw I Irwvoice infarmation j

Client S alutation: IEIient nhame j

< Back | [dEwt | Cancel | Frint | Preview | Layout |

In the Report by field, select to group transactions by payer or recipient. Selecting Payer groups recipients who
contribute to a payer’s balance. Selecting Recipient groups all payers who make up a recipient’s balance.

The Report in field determines the layout of the report. Detail lists individual transaction information. Summary
creates a column for each transaction type charge, payment, and credit, and issues a total for each.

By selecting Show or Do not show payer/recipient details, you decide the amount of detail you want to see. Show
lists payers or recipients with their individual transaction information and balances. Do not show lists
transactions without giving recipient or payer information.

Reporting by Payer in Detail

Reporting by payer groups all recipients who make up a payer’s balance. Selecting to report in Detail lists
individual transaction that make up a payer’s balance. Use Show or Do not show to determine the amount of
information you want to see.
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Show recipient details. Select Show recipient details to see which recipients’ transactions create a payer
balance. By selecting Show, the report lists each recipient with their individual transaction information and
balances. To see the clients who compose another’s balance, you must select Show.

Detail
Repart by: IPE'PE' vl

Repot if: IDE[an j aﬁdlShow j recipient details.

Show IF'ayrnent 1eference j in the payment detail colurmn

[~ Show creditz/payments with their aszociated charges
[~ Show invoicereturn ling itemn detail

Shaw I Irwvoice infarmation j

When you select these field entries, the report will be formatted similar to this sample report:

051372003 D3:07:09 FM Community Services Inc. Page 1
Client Account Activity Report

Transaction Transaction Transaction
Transactions far Date Type o ftem Description Amourt
Cily ¥ owth Erogram
Tosh Lemy
04/16/200% CH 12 T Intervertion Program Traddng 7500
Totalfor Tosh Lemy 7500
Balwmce for Tosh Lery 7500
Tobn Willivm 5
0471652003 ¥ 15 ($1000)
04/16/2003 CH 13 EBEP Big Brother Prognm Training $100 00
D416/200% CR 2 EET Eig Brother Prognm Training (§1000)
Totalfor Tokn William s 3000
Balance for Toke William e $a0.0n
Cxavd Tetalfer Cily Youwdh Brogram F15500
Tetal Balance for Cily Youth Frogram $15500
Totalcharges: $17300
Totalcredits: $1000
Totalp vym ents: $1000
Grand Total: $15500

Do Not Show recipient details. Select Do not show recipient details to see a payer’s information without
regard to which recipients comprise the balance. Individual transactions appear on the report, but not
recipient information.

Detail
Report by IPa-"'E' vl

Report in: IDetaiI j andl[).;. ot show j recipient details.

Show IF'a_l,lment reference j in the payment detail column

[~ Show credits/payments with their associated charges
[~ Show invoice/return line item detail

Shaw I Inwoice information j
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When you select these field entries, the report will be formatted similar to this sample report:

Community Services Inc. Page 1
Client Account Activity Report
Transaction Transaction Transaction
Transactions for Date Type D ftem Description Amount
City Youth Program
04/16/2003 Y 15 (51000}
04716/2002 CH 19 EEFP Big Brother Progrmm Traming El0000
04/16/2003 CR 8 EEP Big Brother Program Training ($1000)
Total for City Youth Program £2000
Balance for City Youth Program £T000
Totalcharges: £10000
Totalcredits: £1000
Totalpaym ents : $1000
Grand Total: 2000

Reporting by Recipient in Detail

Reporting by recipient groups all payers who make up a recipient’s balance. Selecting to report in Detail lists
individual transaction information. Use Show/Do not show functionality to determine the amount of information

that you want to see.

Show payer details. Select Show payer detail to see which payers’ transactions create a recipient balance. By
selecting this option, the report lists each payer with their individual transaction information and balances.
You must select Show to see the clients who compose another’s balance.

Repart by: IHecipient "I

Repart in: IDetaiI j

and IShow j payer details.

Show IF'ayrnent 1eference j in the payment detail colurmn

[~ Show creditsdpayments with their associated charges
[~ Show invoicereturn ling itemn detail

Shaw Ilnvoice infarmation

[~

When you select these field entries, the report will be formatted similar to this sample report:

Community Services Inc.

Total for City Youth Program
Balance for City Youth Program
Grand Total for John Williams

Taotal Balancefor John Williams

Page 1
Client Account Activity Report
Transaction Transaction Transaction
Transactions for Date Type 0 tem Description Amourt
John Williams
City Yauth Pragram
04/16/200% v 135 ($1000)
04/16/2003 CH 19 EBP Big Brother Progmm Traming §100 00
04/16/200F CR 8 EEP Big Brother Prognm Training ($1000)

Totalchargas:
Totalcredits:
Totalpaym ents:
Grand Total:

$3000
7000
3000
7000

$10000
$1000
$1000
2000
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Do Not Show payer details. Select Do not show recipient details to see a payer’s information without regard
to which recipients comprise the balance. Individual transactions appear on the report, but not payer
information.

Detail
Repart by: IHecipient "I

Repot if: IDE[an j andl[).;, [ j paver details.

Show IF'ayrnent 1eference j in the payment detail colurmn

[~ Show creditsdpayments with their associated charges
[~ Show invoicereturn ling itemn detail

Shaw I Irwvoice infarmation j

When you select these field entries, the report will be formatted similar to this sample report:

Community Services Inc. Page 1
Client Account Activity Report

First Last
Transactions for Trans. Date Trans. Date Charges Credits Payments Arnourt Balance

John Williams 0451672003 04 /1652003 £10000 $1000 §1000 $8000 FF000

Total charges: §10000
Totalcredits: £1000
Totalpaym mis: 51000
CGrand Total: $0000

Reporting by Payer in Summary

Reporting by payer groups all recipients who make up a payer’s balance. Selecting to report in Summary creates a
column for each transaction type, charge, credit and payment, and issues a total for each. Use Show/Do not show
functionality to determine the amount of information you want to see.

Show recipient details. Select Show recipient detail to see which recipients’ transactions create a payer
balance. By selecting this option, the report lists each recipient with their total amount for each transaction
type. To see the clients who compose another’s balance, you must select Show.

Detail
Report by IPa-"'E' vl

Report in: Isummaf.'ﬂ j andIShgw j recipient details.

Show IF'a_l,lment reference j in the payment detail column

[~ Show credits/payments with their associated charges
[~ Show invoice/return line item detail

Shaw I Inwoice information j
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When you select these field entries, the report will be formatted similar to this sample report:

Community Services Inc. Page 1
Client Account Activity Report

First Last

Transactions for Trans. Date Trans. Date Charges Credits Fayments Amount Ealance

City Youth Program
John Wiliams 0416 /2003 0416 /2003 £10000 $1000 £10.00 $20.00 $70.00
Grand Tatal for City Youth Program $2000 $70.00
Totalcharges: £100.00
Totalcredits: $1000
Totalp wym ants: $1000
Grand Total: S0 00

Do Not Show recipient details. Select Do not show recipient details to see a payer’s information without
regard to which recipients comprise the balance. Totals for the transaction types appear on the report, but
not recipient information.

Detail
Report by: IHecipient 'I

Report in: IDetaiI j andl[).;. ot show j paver details.

Show IF'a_l,lment reference j in the payment detail column

I~ Show credits/payments with their associated charges
[~ Show invoice/return line item detail

Shaw I Inwoice information j

When you select these field entries, the report will be formatted similar to this sample report:

Community Services Inc. Page 1
Client Account Activity Report

First Last
Transactions for Trans. Date Trans. Date Charges Credits Payments Amount Balance
John wiiliams 0471672003 044162003 $100.00 $1000 £1000 $2000 7000
Totalcharges: §10000
Totalere dits: $1000
Total paym ents: $1000
Grand Toial: $0.00

Reporting by Recipient in Summary

Reporting by recipient groups all payers who make up a recipient’s balance. Selecting to report in Summary
creates a column for each transaction type, charge, credit and payment, and issues a total for each. Use Show/Do
not show functionality to determine the amount of information you want to see.
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Show payer details. Select Show payer detail to see which payers’ transactions create a recipient balance. By
selecting this option, the report lists each payer with their balances. To see the clients who compose
another’s balance, you must select Show.

Detail
Repart by: IHecipient "I

Repot if: ISummary j aﬁdlShow j paver details.

Show IF'ayrnent 1eference j in the payment detail colurmn

[~ Show creditsdpayments with their associated charges
[~ Show invoicereturn ling itemn detail

Shaw I Irwvoice infarmation j

When you select these field entries, the report will be formatted similar to this sample report:

Community Services Inc. Page 1
Client Account Activity Report

Transactions for :ll'r:':s Date 'I;::s D=te Charges Credits Payments Arnount Ezlance
City Youth Program

John inriliams 0416/2003 0471672003 $10000 $1000 $1000 £2000 7000

Grand Total for City Youth Program $80.00 F70.00

Totalcharges: $100 00

Total credite: $1000

Totalpaym ents: $1000

Grand Total: 00

Do Not Show payer details. Select Do not show payer details to see a recipient’s information without
regard to which payers comprise the balance. Totals for the transaction types appear on the report,
but not payer information.

Detail
Repart by: IPE'PE' vl

Repot if: ISummar_l,J j andl[).;, [ j recipient details.

Show IF'a_l,lment reference j in the payment detail column

[~ Show credits/payments with their associated charges
[~ Show invoice/return line item detail

Shaw I Inwoice information j

When you select these field entries, the report will be formatted similar to this sample report:

Community Services Inc. Page 1
Client Account Activity Report

First L=t
Transactions for Trans. Date Trans. Date Charges Credits Fayments Amourt Balance
City outh Frogram 04/16/2002 04/16/2003 £10000 §1000 §l000 $2000 FF000

Totalcharges: §10000
Totalere dits: $1000
Total paym ents: $1000

Grard Total: =000
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Client Account Balance Report Detail Panel

The Detail panel of the Client Account Balance Report plays a key role in the output of the report. With this
screen, you determine the grouping and quantity of information appearing on the report. For more information
about this report, see “Client Account Balance Report” on page 124.

1@ New Client Account Balance Report
File Edit “iew Fawortez Toolr Help

WS G- |

1: Generall 2: Filkers

Headingz Detail
Criteria

Report by: IPE'PE' j aﬁdlShow j recipient details.
Sort/Break .
Page Footer Client S alutation: IEIient rare j

Report Footer
Miscellaneous
Calor Scheme

< Back | [dEwt | Cancel | Frint | Preview | Layout |

In the Report by field, select to group transactions by payer or recipient. Selecting Payer groups recipients who
contribute to a payer’s balance. Selecting Recipient groups payers who make up a recipient’s balance.

By selecting Show or Do not show payer/recipient details, you decide the amount of detail you want to see. Show
lists payers or recipients with their individual transaction information and balances. Do not show lists
transactions without giving recipient or payer information.

Reporting by Payer

Reporting by payer groups all recipients who make up a payer’s balance. Use Show/Do not show functionality to
determine the amount of information you want to see.

Show. Select Show recipient details to show payers balance broken down by recipients who comprise the
balance.

Report by IPa-"'E' j andIShgw j recipient details.
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When you select these field entries, the report will be formatted similar to this sample report:

Transactions for

Community Services Inc.
Client Account Balance Report

Balance

City Youth Program

John wiilliams

Grand Total for City Youth Program

$7000
E000

Page 1

Do Not Show. Select Do not show recipient details to show payers balance without regard to which recipients

make up the balance.

Report by: IPE'PE'

j and ID.;, [ j recipient details.

When you select these field entries, the report will be formatted similar to this sample report:

Transactions for

Community Services Inc.
Client Account Balance Report

Ezlance

City Youth P rogram

7000

Reporting by Recipient

Page 1

Reporting by recipient groups all payers who make up a recipient’s balance. Use Show/Do not show functionality

to determine the amount of information you want to see.

Show. Select Show recipient details to show payers? balance broken down by recipients who comprise the

balance.

Repart by: I Recipient

j and Ishgw j payer details.

When you select these field entries, the report will be formatted similar to this sample report:

Transactions for

Community Services Inc.
Client Account Balance Report

Balance

Jobm Williams
City Youth Frogram
Grand Tatal for Jahn Williams

F7000
7000

Page 1
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Do Not Show. Select Do not show recipient details to show a payer’s balance without regard to which recipients
make up the balance.

Report by: | Recipient | and|Donatshow x| payer details.

When you select these field entries, the report will be formatted similar to this sample report:

04132003 012:49:16 P Community Services Inc. Fage 1
Client Account Balance Report

Transactions for Balance

John iliams Fa000

Client Profile Report

Note: You can run the Client Profile Report from Reports or from a client record in Records.

The Client Profile Report provides detailed information about clients. You select the information to include from
client records. The report is useful to quickly review information about clients without navigating through
numerous records.

The Client Profile Report has tabs on which you set parameters: General, Filters, and Format. To move among the
tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to
include in the report and how the report should look. For more information about creating a report, see “Creating
a report in Accounts Receivable” on page 10.
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General Tab

On the General tab, you can select parameters specific to the report and make selections about the information
included in the report.

I Mew Client Profile Report
File Edit “iew Fawaorter Tools Help

SIECINE |
| 2 Filtersl 2 Formatl
Shaow these report sections: Show these details:

¥ Address Information W 55K -

¥ Default Payers ¥ Birthdate

¥ Statement Recipients ¥ Ethnicity

™ Account Summary ¥ Gender

W Actions ¥ Religion

¥ Attributes ¥ Credit Limit

W Media W UsedD

W Mates ¥ FIN

¥ Histary af Changes ¥ CFDA Mumber: ;I

¥ Show ending balance az of -

As of date: <Specific date j Date: I jEl

Show year-to-date information as; IThiS fiscal year j <Undefined date range:

[~ Create an output querny of clients

Report anentation: IPnrtrait 'I

< Hack | Hewut » | Cancel | Frint | Prewiew | Layout |

Show these report sections. Mark the checkboxes in this box to select client information to include in the
report. Each checkbox corresponds to a tab on the client record. Each section you add appears in the report
with a separate header.

Show these details. Mark the checkboxes in this box to select personal information about clients in the report.

Show ending balance as of []. To show the client’s balance amount, mark this option. In the As of date field,
select Today or <Specific date> to specify the date for reporting ending balance. If you select <Specific date>,
in the Date field, enter the date for which you want an ending balance.

Show year-to-date information as []. If you include Account Summary information in the report, you can
mark this checkbox and select to display year-to-date information by fiscal year, calendar year, or beginning

on a date you specify.

Create an output query of clients. If you mark this checkbox, the program creates a query of the clients
included in the report. You can use the query later in other areas of Accounts Receivable.

Report orientation. In this field, select Portrait or Landscape.

Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Client Attributes filter, only clients with the attributes you select appear in the report.
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On the Filters tab, you can filter the records appearing in the report. For more information about filtering in
The Financial Edge, see the Program Basics Guide.

I New Client Profile Report E
File Edit “iew Favortes Tools Help

== R e |

1 General  2: Filters IE: Furmatl

€0 0pen 7 Clear All Filkers

Filkers I Include Selected Filkers
Clients all zall Clients:=
Client Attributes Al <Al Client Attributes:=
Client Statuses Al <Al Client Statuses =

< Back | Mext » | Cancel | Brint | F'revieyl Layout

Tip: You can also double-click a filter in the grid to open the selection screen.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can
select specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting
options for the Client Profile Report. When you select an item in the list, the right side of the screen displays
selections for that section of the report.

Note: The heading defaults to Client Profile Report in the Title field. You can leave this as the title for the
report or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

A2 New Client Profile Report I
File Edit View Favortes Tools Help

BEaIdE o= 2- |

il Generall 2 Filters 3 Format |

Criteria .

Sart — Heading Format

Page Footer Title:  |Chient Prafile Report
Report Footer S ubtitle: I

Miscelaneous
Align: IEentel 'I

¥ Print organization name in header

v Print Page Number in Heading v Print Repart D ate in Heading
Farmat: IPage 1 j Farmat: IShnrt Date and Time j
Align: | Right =] | | g Left =l

v Print report heading on each page

< Back TRt Cancel Frint Preview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Use Criteria to print data to help you remember the criteria you use to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the

report.

A2 New Client Profile Report
File Edit View Favortes Tools Help

B adDR o= 2-

il Generall 2 Filters 3 Format |

Sort

Page Footer
Report Footer
Miscelaneous

Criteria
[¥ Print theze criteria on Ia zeparate page "I

Saved report name

Output query name

Show ending balance as of

Show year-to-date information as of
Clients ta include

Client attrbutes to inchide

Client statuses ta inchude

< Back | TRt |

Cancel | Frint | Preview | Layout |

Sort. Use Sort to select the order in which information appears on the report. When you select Sort, you can sort
within categories in the grid on the right. Select a sorting category in the Sort by column and select Ascending
or Descending in the Order by column.

To print each category selected in the Sort by column on its own page, mark Page break on each new.
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If you make no selections in the Sort by column in the grid, the program sorts by the employee name in
ascending order.

12 New Client Profile Report I

File Edit Yiew Favortes Toolz Help
== |

e Generall 2 Filters  3: Format |

Headings Sort

Criteria

Sart by I Order by I
Fage Footer Client I Ascending

Fieport Footer
Miscellaneous

[~ Page break on each new Client |D

< Back | [dErt s | Cancel | Brint | Preview | Layout |

Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align
the text. You can include the page number and date in the footer.

A2 New Client Profile Report I
File Edit View Favortes Tools Help
dadaaal=2- |

il Generall 2 Filters 3 Format |

Headings Page Footer
Criteria S
Sort [ rage Foober | exl

Text:

Report Footer
Miscelaneous

Align: IEenter 'l

=1 Print Page Murmber in Footer [~ Print Repart D ate in Footer
Farmat: IPage 1 j Farmat: IShnrt [ate and Time j
Align: IHight j Align: ILeft j

< Back TRt Cancel Frint Preview Layout
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Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to
align the text. The report footer appears at the end of the report.

12 New Client Profile Report I
File Edit Yiew Favortes Toolz Help
=R |

e Generall 2 Filters 3 Format |

Headings Report Footer

Criteria S

Sort eport Footer Tex
Page Footer Text:

{5 Report Footer
Miscellaneous

Aligr: ||_eﬂ v|

< Back | [dErt s | Cancel | Brint | Preview | Layout |

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

12 New Client Profile Report I
File Edit Yiew Favortes Toolz Help

Bada =2 |
il Generall 2 Filters 3 Format |

Headros
Criteria

Sort Show currency character on Al amaurts
Fage Footer Show percent signon all amounts

E Report Footer Megative amount Format (1234.56)
d ¥ 2 Murnber of digits after decimal For amaounts 2

Mumber of digits after decimal For percentages 2

Show 1000's separatar es

Show blanks instead of zeros Mo

Faonk size 3

Sample amount:

Amount: ($1,234.56)
Percent 100, 00%

< Back L= Cancel Erint Preview Layout
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Client Statistics Report

The Client Statistics Report provides a tally of clients by criteria you select. This report is useful to find out what
percentage of clients share certain characteristics.

The Client Statistics Report has tabs on which you set parameters: General, Filters, and Format. To move among
the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to
include in the report and how the report should look. For more information about creating a report, see “Creating
a report in Accounts Receivable” on page 10.

General Tab

On the General tab, define parameters and select information to include in the report.

A& New Client Statistics Report
File Edt “iew Favonter Tools Help

WS R -2 |

1. General |2: Filtersl 2 Formatl

Shows infarmation far;
¥ City -
¥ State

¥ Country

¥ Status

¥ Client Type

¥ Statement Cade

¥ Credit Rating

¥ Service Provider

¥ Industry

¥ Temitory |
¥ Gender

V¥ Age =l

Selectall | Deselect Al |

[~ Create an output quen of clients

Report arientation: IPortrait "'I

< Hack | Ment » | Cancel | Frint | Prewiew | Layout |

Show information for. Mark checkboxes in this box to select client information to include in the report.

Create an output query of clients. If you mark Create an output query of clients, the program creates a
query of the clients included in the report. You can use the query later in other areas of Accounts Receivable.

Report orientation. In the Report orientation field, select Portrait or Landscape.

Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Client Attributes filter, only clients with the attributes you select appear in the report.
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On the Filters tab, you can filter the records appearing in the report. For more information about filtering in
The Financial Edge, see the Program Basics Guide.

I New Client Statistics Report E
File Edit “iew Favortes Tools Help

== R e |

1 General  2: Filters IE: Furmatl

€0 0pen 7 Clear All Filkers

Filkers I Include Selected Filkers
Clients all <Al Clients=
Client Attributes all <Al Client Attribubes =

< Back | Mext » | Cancel | Brint | F'revieyl Layout

Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting
options for the Client Statistics Report. When you select an item in the list, the right side of the screen displays
selections for that section of the report.

Note: The heading defaults to Client Statistics Report in the Title field. You can leave this as the title for the
report or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

I Mew Client Statistics Report
File Edit “iew Fawvortes Toolz Help

S & =2

1 Generall 2: Filters 3 Farmat |

B Headings Headings
Criteria Heading Format
Cot ~ Heading Forma

Page Footer Title: | Client Statistics Report

Report Faater Subiitle:
Miscellaneous

Colar Scherme Aligr: IEenter 'I

[¥ Print organization name in header

W Print Page Mumber in Heading [¥ Frirt Report Date in Heading
Format: IF'age 1 j Format: IShDrt Date and Time j
Mligr: [ Right =l signe [Lett =l

[¥ Print report heading on each page

< Back et Cancel Frrint Freview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Use Criteria to print data to help you remember the criteria you use to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the

report.
I Mew Client Statistics Report
File Edit “iew Fawvortes Toolz Help
= Jie= R = e |
1 Generall 2: Filters 3 Farmat |
Headings Criteria
E Criteria
Soart [v Fiint these criteria on Ia separate page 'I
Page Footer Saved report name
Fh.apnrt Foater Dutput queny narne
Miscellaneous Client to include
Colar Scheme Clietit attributes to include
< Back | | (= | Cancel | Frrint | Freview | Layout |

Sort. Use Sort to select the order for information to appear on the report. To order the information, you can
select a sorting category in the Sort by column and select Ascending or Descending in the Order by column.

I Mew Client Statistics Report
File Edit %iew Favortes Toolz Help
RS G -] 2 |
1 Generall 2 Filters 2 Farmat |
Headings Sort
Criteria
Sort by I Order by I
Fage Foater Category entry Ascending

Report Footer
Miscellansous
Colar Scheme

< Back | THERt Cancel FErint Preview Layout
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Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align
the text. You can include the page number and date in the footer.

1@ Mew Client Statistics Report [ ]

File Edit “iew Fawvortes Toolz Help
SR -2 |

1 Generall 2 Filterz 3 Format |

Headings Page Footer
Criteria Pae Footer Test
Sort - rage roober | el

Test:

Report Foater
Miscellaneous
Calor Scheme

Aligr: IEenter 'l

[ Print Page Murmber in Footer [~ Print Report Date in Foater
Forrnat: IF'age 1 j Format: IShort Date and Time j
Align | Right 2 [ e =
< Back | | (= | Cancel | Frrint | Freview | Layaut |

Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to
align the text. The report footer appears at the end of the report.

I Mew Client Statistics Report
File Edit “iew Fawvortes Toolz Help

S & =2

1 Generall 2: Filters 3 Farmat |

Headings Report Footer

Criteria
Sort Report Footer Text
Page Footer Text:

E Report Footer

Miscellaneous
Colar Scheme

Aligr: ILeft vl

< Back et Cancel Frrint Freview Layout
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

1@ Mew Client Statistics Report

File Edit “iew Fawoites

Toolz Help

= D= N gl R

1 Generall 2: Filters  2: Farmat |

Criteria
Sort Show currency character on All amaounts
Page Foater Show percent sign an All amounts
Hport Footer Megative amount format [1234.56]
o Mumber of digits after decimal for amaunts 2
Mumber of digits after decimal for percentages 2
Show 1000%: separator Tes
Show blanks instead of zeros Mo
Font size 2
Sample amaunt:
Amount [$1.234.56)
Percent 100.00%
< Back | Herts | Cancel | FErint | Preview | Layout |

Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box
next to the selection, the Color screen appears so you can select a standard color or define a custom
color. If you leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

1@ Mew Client Statistics Report [ ]

File Edit “iew Faworites

HRE QG e ?-

Toolz Help

1 Generall 2 Filterz 3 Format |

Headings
Criteria

Sort

Page Footer
Report Foater
Miscellaneous

Color Scheme

[~ &pply a Color Scheme

Report Name
Subtitle

Group Headings

. Column heading back. color
I_ Column heading fore caolor
|_ Group heading back color

. Group heading fore color

Frestone [Vefaults |

< Back | (=

Cancel Frrint Freview Layaut
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Reporting categories in Accounts Receivable include Action Reports, Analysis Reports, Bank Account Reports,
Client Reports, Deposit and Receipt Reports, Pivot Reports, Product and Billing Item Reports, and Transaction
Reports. This chapter discusses Custom Reports. For information about other report categories, see the chapter
for that category. For information about Pivot Reports, see the Pivot Reports Guide for The Financial Edge.

Custom Reports make it easy for you to access and share reports you create using Crystal Reports. Using Custom
Reports, you can link a Crystal report file with an Accounts Receivable export file and then save the linked report
in your Financial Edge database. Once the files are linked, you and other Financial Edge users can easily view or
print custom Crystal reports directly from Accounts Receivable without having to open Crystal Reports.

The Financial Edge includes one license for Crystal Reports XI. Clients creating custom reports using Export in
The Financial Edge with Crystal Reports will need a license for each person creating custom reports. In addition,
each license is associated with a particular product, which means if one person is reporting for both The Financial
Edge and The Raiser’s Edge, that individual needs two Crystal Reports Xl licenses. For information about
purchasing additional Crystal Reports Xl licenses, send an email request to solutions@blackbaud.com or contact
your account representative.

Creating Custom Reports

When setting up the Crystal report and the export file, it is important to remember that you can add as many or
as few fields as you want to the Crystal report as long as those fields are also contained in the export file. You can
add additional fields to the export file that are not included in the Crystal report, but you cannot add fields to the
Crystal report that are not included in the export file.

Make sure to format the export file in one of these *.MDB formats: Blackbaud Report Writer Database, Microsoft
Access 2.x Database, Microsoft Access 95 Database, Microsoft Access 97 Database, or Microsoft Access 2000
Database. For more information about creating export files, see the Export Guide. For more information about
creating Crystal reports, see the Crystal Reports help file.

» Creating a custom report
1. From the Accounts Receivable Reports page, click Custom Reports. The Custom Reports page appears.

% The Financial Edge
Fille Edit Yiew Go Favortes Tools Help

€ Back % Fariwvand ] Cormrmunity Services Inc, ~ ¢ Accounts Receivable ™

Shartcuts

12 Reports « Custom Reports

New ‘Dpen |Delete Reports

- At
B Custom Report Custom Report R:ploo?ts
0

d

Analysis
Repotts

m
@
=
=

Account
Repotts

Client
Reports

Cuskom
Reports

i

Deposit and
Receipt
Repotts

Pivot
Repotts

Product and
Eilling Item
Reports

F

Transaction
4 LI Reports
a Plug-Ins [~ Orly show my reports

Maonthly Reports
Web Links

‘wieloome to Accounts Receivable |

i

The Custom Repoart pravides an easy way to share Crystal reparts pou create
ﬂ fram expaort data. Just link the Crystal repart file with an expart to stare it in the
database and make it available to all users.
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2. Click New. The Custom Report screen appears.

I3 Mew Custom Report I
File Edit “iew Favortes Tools Help

BRE R0 =2 |

1: General I

Select Export: I ﬁl%l

Select Cryztal Report: I _I

¥ Refresh Export

< Blanhk | et | Catcel | Print | Praview | Layaout |

3. Inthe Select Export field, click the binoculars to locate the export file you want to use as a data source for
your custom report. The Open screen appears.

Flopen @
Find: | Export 7| Search using query: [< Defauls [

= | Dz 1i Add a Mew Export Optionz

Export bype: I j Last modified by: I j
Export format: I j Lazt modified or: Iany time j
Export name: I j
Description: I j

Hide Filters | Clear Filtersl Previous Filtersl Filters are not applied Find Mow I [Hper Cancel

|F'less F7 to zoom

Note: Only exports in saved in a Microsoft Access database file format (*.MDB) appear on the Open screen.

4. From this screen you can select an existing export file or create a new export file.

¢ To select a file, select the file name and click Open. You return to the Custom Report screen and the
selected export file name appears in the Select Export field.
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Note: Make sure to format the export file in one of these *.MDB formats: Blackbaud Report Writer Database,
Microsoft Access 2.x Database, Microsoft Access 95 Database, Microsoft Access 97 Database, or Microsoft
Access 2000 Database.

¢ To create a new export file, click Add New. The Create a New Export screen appears where you can
create an export file to use with Custom Reports. After you create and save your export file, you return
to the Custom Report screen and the selected export file name appears in the Select Export field. For
more information about creating export files, see the Export Guide.

5. Inthe Select Crystal Report field, browse to the Crystal report file you want to link to the selected export
file. The Open screen appears.

6. Select the Crystal report and click Open. You return to the Custom Report screen and the selected report
name appears in the Select Crystal Report field.

u Mew Custom Report
Eile Edit “iew Favortez Tools Help
SRR R ¥
1: General ]
Select Export: | ﬁl&l
Select Crystal Report: | J

v FRefresh Export

| | Cancel | Print | Freview | Layout |

Note: If you selected the Save Data with Report option when you created the Crystal report, this option has
no effect when the report is run from The Financial Edge — the program simply ignores it. If you want to make

the custom report “static” (the data does not update each time the report is run) you should unmark the
Refresh Export option.

7. To automatically refresh the export file every time you view the report, mark Refresh Export. If you do not
mark this checkbox, when you run the report the program checks to see if the export file is saved on your
machine. If it is, the program uses the existing export file and will not update the data each time you run
the report. If the export file is not saved to your machine, the program generates a new export file and
includes current data from the database.
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8. Click Preview to view a copy of the report on your screen before printing.

I New Custom Report
X 4 4 Tof1

r Y e G&F& [ [ |#

Total16 100z 16 i 16

- [5]]

Preview

Charge Amount  Charge Balance

0o 3 40000
1000 3 Looo o
H] 5 2000
50 3 3000
100 5 10000
200 3 20000
230 5 23000
100 3 10000
H] 3 2000
20 5 2000
H] 3 2000
50 5 4000

3 20000
50 3 5000
20 3 2000
73 3 T

Category

Por Teag Tum
Poz Teagm Tha
Fhthat Ino
FltLan o
Fhthat Ino
Por Teag Tum
Paodust
Flrkan Ino
Fhthat I
FlatEan Tum
Fhthat I
FlatEan Tum
Por Teagm Inm
FlatEan Tum
Flrkan Ino
Fhthat I

Chent Name

Dr. Mazy Vonng
€ stholic Divcorn
by $mith
Brisn Fox
ity Toudh oo yaam
o mm mudty Fo nndatisn
D pastments 13 osial Jamvis
THC A
T b W illiams
Departmento fHoalth and Hu
TeshLavy
fam MM illan
3 pringfsld £hool Dismmict
Tod fameen
fhwnl. Goodwin

Hazh Donald

9. A copy of the report appears on your screen. If the report is okay, click the Print button at the top of the
preview screen to print the report.

10. To save the report parameter file, click File, Save from the menu bar. The Save report as screen appears.

v Others can un this report
[~ Others can modify this report

Save Report as E I
Repart name: I
Description:

[Hisave | Cancel |

11. Enter a Report name and a Description. You can also mark options to allow other users to run or modify

this report.

12. Click Save. You return to the Custom Reports screen.

13. To return to the Reports page, select File, Close from the menu bar.

Editing an Export for a Custom Report

Warning: You cannot delete fields from an export file if the export is linked with a Custom Report. The
Remove button is disabled in Export. You also cannot delete an export file linked with a Custom Report. If you
try, an error message appears.

You can edit an export file directly from the Custom Reports screen by clicking the Click to edit export button.
You can add additional fields to the export file that are not included in the Crystal report, but you cannot add
fields to the Crystal report that are not included in the export file. Each time you run a saved Custom Report,
The Financial Edge checks to make sure the fields selected for the Crystal report are still included in the export

file.
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» Editing an export file from an open Custom Report

1. Open the saved Custom Report you want to edit. The report opens displaying the General tab.
1@ Charges

File Edit “iew Favortes Tools

1: General I

x|
Help

i |

Select Export: IEharges

Select Cryztal Report: IChalges.rpt

¥ Fiefresh Export

< Bachk | fest> | Cancel |

Erint

Lapout |

2. Inthe Select Export field, click the Click to edit export button next to the binoculars. The export file
appears, displaying the Filters tab.

E. Charges H=] E3 I

File Edit “iew Favortes Tools Help

ESaveandCIose-|u )(||3 &||

2. \

1: Fiters | 2 Output]

Client attributes

all

& 0pen ) Clear & Filers
Filters I Include Selected Filkers
Charges all <Al Charges=
Charge Attributes all <Al Charge Aktribubes =
Clients all Al Clients =

<Al Client Attributes=

< Back | Mest » | Eancell

Expart Noﬂl
|

3. Make any necessary changes on the Filters and Output tabs, and click Save and Close. You return to the

Custom Report screen.

4. Click Print to print the report or save and close the updated report.

| BN
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Reporting categories in Accounts Receivable include Action Reports, Analysis Reports, Bank Account Reports,
Client Reports, Custom Reports, Deposit and Receipt Reports, Pivot Reports, Product and Billing Item Reports,
and Transaction Reports. This chapter discusses Deposit and Receipt Reports. For information about other report
categories, see the chapter for that category. For information about Pivot Reports, see the Pivot Reports Guide
for The Financial Edge.

Note: We recommend you read the documentation for The Financial Edge thoroughly. Information presented
here provides you with basic information about deposit and receipt reports in Accounts Receivable. Hands-on
experience is the best way to learn, so we encourage you to try various options with your database.

Deposit and Receipt Reports in Accounts Receivable include:

¢ Cash Receipts Report

e Deposit List

e Deposit Report

Cash Receipts Report

The Cash Receipts Report lists all cash receipts activity over a specified period of time.

The Cash Receipts Report has tabs on which you set parameters: General, Filters, and Format. To move among
the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to
include in the report and how the report should look. For more information about creating a report, see “Creating
a report in Accounts Receivable” on page 10.
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General Tab

On the General tab, you can select parameters specific to the report and make selections about the information
included in the report.

IE Hew Caszh Receipts Report
File Edit “iew Fawaorter Tools Help

IR |
| 2 Filtersl 2 Formatl

Include transactions with these dates

Deposit date: Ilnclude all dates =l

Receipt date: Ilnu:lude all dates ﬂ

Entered on date: Ilnclude aldates 7|

Include deposit numbers from: | Bl To | |
Include receipt numbers from: I ﬁl To: I ﬁl

[~ Show miscellansous payment details
Include deposits from

¥ Accounts Receivable
¥ CashReceipts

[T Create an output queny of IDepusits "I
Repart arientation: IPnrtrait 'I

< Hack | Hewut » | Cancel | Frint | Prewiew | Layout |

Include transactions with these dates. In this frame, you can select a date or date range for the
transactions to include in the report. Make your selections in the Deposit date, Receipt date, and Entered on
date fields.

If you select <Specific range>, specify start and end dates. If you leave the Start date field blank, all
activity is included up to the end date. If you leave the End date field blank, all activity from the start
date forward, including transactions with a date in the future, is included. If you leave both fields
blank, all activity is included.

Include deposit numbers from [] To [ ]. You can enter a range of deposit numbers to include in the report.
If you leave both fields blank, the report includes all deposit numbers.

Include receipt numbers from [ ] To [ ]. In the Include receipt numbers from [ ] to [ ] field, enter a range of
receipt numbers to include in the report. If you leave both fields blank, the report includes all receipt
numbers.

Show miscellaneous payment details. Mark this checkbox to separate payments into separate lines for
Accounts Receivable and Cash Receipts components. This option appears only if you have Cash Receipts
installed.

Include deposits from [ ]. Mark the checkbox for each accounts receivable program whose deposits you want
to include in the report. This only appears if you have both Accounts Receivable and Cash Receipts installed.

Create an output query of [ ]. If you mark Create an output query of, select Deposits or Payments. The
program creates a query of the deposits or payments included in the report. You can use the query later in
other areas of the program.

Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Post Statuses filter, only deposits with the post statuses you select appear in the report.

On the Filters tab, you can filter the records appearing in the report. For more information about filtering in
The Financial Edge, see the Program Basics Guide.

IQ Mew Caszh Receiptz Report E
File Edit “iew Favortes Tools Help
W2 SR ]2 |

1. General IE: Furmatl

Filkers I Include Selected Filkers

Clients all <Al Clients=

Client Attributes all <Al Client Attribubes =

Barks all il Banks>

Depaosits all <Al Deposits =

Payments all <Al Payments =

< Back | Mest » | Cancel | Frint | Prewiew | Layout

Tip: You can also double-click a filter in the grid to open the selection screen.

Open. Select a filter in the grid and click Open on the action bar. The Selected <Filter> screen appears so you can
designate specific filters for the report.

Clear All Filters. To reset each filter to include all, click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting
options for the Cash Receipts Report. When you select an item in the list, the right side of the screen displays
selections for that section of the report.
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Note: The heading defaults to Cash Receipts Report in the Title field. You can leave this as the title for your
report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

lﬂ Mew Cash Receipts Report
File Edit %iew Favortes Toolz Help

eI el |

1 Generall 2: Filter

Headings
Criteria

Detail — Heading Format
Grand Totals itle: azh Receipts Repart
Titl Cash R R
Sort/Break, Subitle: |

Page Footer
Repart Footer Aligr: IEenter 'I
Miscellansous
Colar Scheme

[¥ Print organization narme in header

W Print Page Murmber in Heading [¥ Frirt Report Date in Heading
Farmat: IF'age 1 j Farmat: IShDrt Date and Time j
Align:  [Right =l i [Lett =l

[¥ Print report heading on each page

< Back | THERt Cancel FErint Preview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the
report.

IE Mew Caszh Receipts Beport
File Edit “iew Fawvortes Toolz Help

S & =2

Criteria
Detail [v Fiint these criteria on Ia separate page 'I

Grand Totals

1 Generall 2: Filter

Saved report name

Sort/Break Dutput query name

Fage Foater Deposit dates to include
Report Footer Receipt dates ta include
Mizcellaneous Entered on dates to include
Calor Scheme Include deposit number range

Include receipt number range

Show mizcellaneous payment details
Include deposits fron these systems
Clients to include

Client attributes to include

Bank accounts to include

Deposits to include

Payrnents to include

< Back | | (= | Cancel | Frrint | Freview | Layout |

Detail. Use Detail to select details specific to the Cash Receipts Report. You can mark checkboxes to show
distributions by transaction characteristic. If you have the optional module Projects and Grants and have
defined transaction codes, additional checkboxes appear.

If you select one characteristic, you can select to show it as a separate column in the report. If you do not
mark the Show characteristic as a column in the main body, the program creates additional lines in the
report. If you select more than one characteristic, an additional line is created with each characteristic as a
column.

If you select multiple characteristics, you can show the balancing account distribution. Mark Show
receivables/balancing account distribution to see the corresponding debit and credit transactions for each
receipt.

If you mark Show transaction total, the program prints an additional column for each receipt total.
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To summarize transactions, mark Include summary report for and mark the checkboxes for each item to
report on. A separate section is created at the end of the report.

n Mew Cash Heceipts Report
File Edit “iew Fawvortes Toolz Help
BHRsaw ?-
1 General] 2 Filters
£l Headings Detail
] Criteria
W Show digtribution for these characteristics
2] Grand Totals ¥ &ccount D -
2] Sort/Break Account Description
] Page Foater W Project ID Up
2] Feport Footer [ Project Description JR—
2] Miscellaneous [ Class ﬂ Drown
2] Color Scheme v
[~ Show traksaction tatal
[~ Show receivables/balancing account distribution
IV Include surnmary report for
Deposit
[V Payer
[ Source
[ Spetem
[ Bank Account ﬂ
< Back | | Cancel | Frrint | Freview | Layaut |

Grand Totals. Use Grand Totals to select combined totals for transaction characteristics. You can mark
checkboxes to show totals by transaction characteristic. If you have the optional module Projects and Grants
and have defined transaction codes, additional checkboxes appear. A section appears at the end of the report
with the grand total information.

n Mew Cash Receipts Report
File Edit %iew Favortes Toolz Help
u _5. % —a m‘I ? T
1 General] 2: Filters
=] Headings Grand Totals
=] Criteria
] Detaill [V Show arand totals for these characteristics
‘ [.3| TI:I d zaunt [0
o sort/Brea [ Account Description
=] Page Footer .
W Project ID
=] Report Foater . .
) [ Project Description
=] Miscellaneous  Class
=] Color Scheme  Mission T
[ Spendable/Mon-Spendable Q
[ Performance Dranan

< Back

Cancel FErint Preview Layout
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Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall
between sets of information.

To order the information, you can select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break?

for a category, fields are enabled for you to specify more information about the break for the selected sorting
category.

In the Text before value and Text after value fields, you can enter up to 30 characters to print directly before
and after the value for the selected sorting category.

To print the number or percentage for the selected category in the footer, mark Print count per or Print count
as a percentage of total for the selected sorting category. To start the selected sorting category on a new
page, mark Page break on each new.

IE Mew Caszh Receipts Beport
File Edit “iew Fawvortes Toolz Help

IR Tl |

1 Generall 2: Filters

Headings Sort/Break

Criteria

Detail Sart by | Order by | Breakz |
Girand T atals Receipt Date Ascending

Page Footer

Report Foater
Miscellaneous
Colar Scheme

i e e

Break Header for Receipt Date-

Text before valus: |

Tewut after walue: I

Break Footer for Feceipt D ate-

™| Fiirit cournt pen Heceipt Date

[ Eritt count as & percentage of total

™| Page break on eachinew Beceint Date

< Back et | Cancel | Frrint Freview Layout
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Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align
the text. You can include the page number and date in the footer.

lB Mew Cash Heceipts Report [ ]

File Edit “iew Fawvortes Toolz Help
m&§EM.@H- |

1 Generall 2: Filters

Headings Page Footer

Criteria
Detail — Page Footer Text
[ Grand Tatals Test:
. ] Sort/Break

Ef Heport Footer

. ] Miscellaneous Alige: IEenter 'l
Color Scheme

[ Print Page Murmber in Footer [~ Print Report Date in Foater
Forrnat: IF'age 1 j Format: IShort Date and Time j
Align | Right 2 [ e =
< Back | | (= | Cancel | Frrint | Freview | Layaut |

Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to
align the text. The report footer appears at the end of the report.

IE Mew Caszh Receipts Beport
File Edit “iew Fawvortes Toolz Help

maémm-@h-

1 Generall 2 Filters

Headings Report Footer

Criteria
Detail Report Footer Text
Grand Total: Text:
Sort/Break
[E] Page Foater

E Report Footer

3 Miscellananus &ligr: ILeft 'I
Color Schemne

< Back et Cancel Frrint Freview Layout
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

lQ Mew Cash Receipts Report x|
File Edit “iew Favorites Toolz Help

S = el |

1 Generall 2: Filters

Headings Miscellaneous
Criteria

Detail Show currency character an All amaunts
Grand Totals Show percent sign an All amounts
Sort/Break Megative amount farmat [1234.56)

Page Footer

Report Foater Mumber of digits after decimal for amaunts 2

; N Mumber of digits after decimal for percentages 2
Colar Scheme Show 1000%: separator Tes
Show blanks instead of zeros Mo

Font size 2

Sample amaunt:

Amount [$1.234.56)
Percent 100.00%
< Back | Herts | Cancel | FErint | F'levieyl Layout |

Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

IE Mew Caszh Receipts Beport
File Edit “iew Fawvortes Toolz Help

S & =2
:

Headings Color Scheme
Criteria

1 Generall 2: Filters

Diatail [ Apply a Color Scheme Report Name
g;?ﬂg;;fh . Column heading back color Subtitle

Feport Footer
Miscellaneous

[ Group heading back calar Group Headings

. Group heading fore color

Hiestore [Wefaults |

< Back et Cancel Frrint Freview Layout
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Deposit List

The Deposit List displays summarized information for deposits you select.

The Deposit List has tabs on which you set parameters: General, Filters, and Format. To move among the tabs,
click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to include
in the report and how the report should look. For more information about creating a report, see “Creating
Reports” on page 10.

General Tab

On the General tab, you can select parameters specific to the report and make selections about the information
included in the report.

M@ New Deposit List I
File Edit “iew Favortes Toolz Help

dia 3 a2 |

1: General |2: Filtersl 3 Formatl

Include deposits with theze dates

Deposit date: Include all dates

Entered on date: IIncIude all dates =]
Post date: Ilnclude all dates j

Include deposit numbers from: | A To | [

[~ Only include deposits whose amounts are greater thar: I

Include deposits from
[V &ccounts Receivable
[V Cash Receipts
[¥ Student Billing

[~ Create an output query of deposits

Report orientation: ILandscape "I

% Bach | Mewxt = | Cancel | Frint Preview Laypout

Include deposits with these dates. In this frame, you can select a date or date range for the deposits to
include in the report. Make your selections in the the Deposit date, Entered on date, and Post date fields.

If you select <Specific range>, specify start and end dates. If you leave the Start date field blank, all
activity is included up to the end date. If you leave the End date field blank, all activity from the start
date forward, including transactions with a date in the future, is included. If you leave both fields
blank, all activity is included.

Include deposit numbers from [] To [ ]. You can enter a range of deposit numbers to include in the report.
If you leave both fields blank, the report includes all deposit numbers.

Only include deposits whose amounts are greater than [ ]. You can mark this checkbox to enter a
minimum deposit amount for deposits to include in the report. Deposits less than or equal to the amount you
enter are excluded.
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Include deposits from. Mark the checkbox for each program whose deposits you want to include in the
report.

Create an output query of deposits. If you mark Create an output query of deposits, the program creates a
query of the deposits included in the report. You can use the query later in other areas of Accounts
Receivable.

Report orientation. In the Report orientation field, select Portrait or Landscape.

Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Post Statuses filter, only deposits with the post statuses you select appear in the report.

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the
Program Basics Guide.

A2 New Deposit List I
File Edit “iew Favoritez Toolz Help
FIEE =R |

1. Geheral | = Formatl

Filters I Include Selected Filkers

Deposits All <Al Deposits =

Post Statuses all <hll Post Statuses:

Barks all <Al Banks =

< Back | Hest » | Cancel | Frint | Preview | Layout

Tip: You can also double-click a filter in the grid to open the selection screen.

Open. Select afilter in the grid and click Open on the action bar. The Selected <Filter> screen appears so you can
designate specific filters for the report.

Clear All Filters. To reset each filter to include all, click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
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Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting
options for the Deposit List. When you select an item in the list, the right side of the screen displays selections for
that section of the report.

Note: The heading defaults to Deposit List in the Title field. You can leave this as the title for the report or
enter your own.

Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

I8 New Deposit List I
File Edit Yiew Favortes Toolz Help
HaIaE =2 |

il Generall 2 Filters

B Headings Headings
Criteria T
Sart —Heading Formal

Page Footer Title: IDEDDSit List

Rieport Footer Subtite: |
Mizcellaneous

Color Scheme Align; ICenter 'I

[¥ Print organization name in header

—Iv Print Page Mumber in Heading v Print Repart D ate in Heading
Farmat: IPage 1 j Farmat: IShnrt Date and Time j
align: [Right =] | | i [Lett =

v Print report heading on each page

< Back L= Cancel Erint Preview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the
report.

I8 New Deposit List I

File Edit
Basaa= - |

iz Generall 2: Filters  2: Format |

Wiew Favortes Tools Help

Headings
(B Criteria
Sart

Page Footer

Report Footer
Miscelaneous
Color Scherne

Criteria
¥ Print these criteria on Ia separate page "I

Saved report name

Output query name

Depozit dates to include
Entered on dates ta include
Pozt dates ta include

Include deposit number range
Include depost amounts
Include deposits from these systems
Include deposits

Include post statuzes

Include bank accounts

< Back | = |

Caticel |

Brrint | Previeﬂl Lapout |

Sort. Use Sort to select the order in which information appears on the report. When you select Sort, you can sort
within categories in the grid on the right. Select a sorting category in the Sort by column and select Ascending
or Descending in the Order by column.
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To print each category selected in the Sort by column on its own page, mark Page break on each new.

2 New Deposit List I
Fil= Edit View Favortes Tools Help
EIERE =R |
ik Genelall 2 Filters 3 Format |
Heading: Sort
Criteria
Sort by I Order by I
Page Footer Deposit Mumnber Ascending
Fieport Footer
Miscellaneous
Color Scherne
[” Page break on each new Deposit Mumber
< Back | = | Cancel | Print | Freview | Layout |

Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align

the text. You can include the page number and date in the footer.

B New Deposit List

File Edit Yiew Favortes Toolz Help
E I |

e Generall 2: Filters  2: Format |

Headings Page Footer
Criteria A
Sart [ rage rooler | el

Test:

B Page Footer
Report Footer
Miscellaneous
Color Scheme

Aligre: IEentel 'I

=1 Prirt Page Mumber in Footer [ Print Bepart Date in Footer
Farmat: IF'age 1 j Farmat: IShort Date and Time j
Bligne [Fiight 52 || [ =
< Back | I Cancel Erint Preview Lapout
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Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to
align the text. The report footer appears at the end of the report.

M@ New Deposit List I

File Edit WYiew Favortes Toolz Help
da I =2 |

il Generall 2: Filters  3: Format |

Headings Report Footer

Crteria Report Footer Test
Sart

Page Footer Text:
‘B Report Footer
Miscellaneous
Calor Scheme

Align: ILeft vl

< Back | [HEwts | Cancel |

FErrint | Preview | Layout |

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

M3 New Deposit List I

File Edit %iew Favortes Toolz Help
dadaw = - |

e Generall 2 Filkerz  2: Format |

Headings Miscellaneous
Criteria

Sort Show currency character on all amounts
Page Footer Show percent sign on all armounts
Repoit Faoter Megative amount Format {1234.56)
E ol Scheme Mumber of digits after decimal For amaounts z

Mumber of digits after decimal For percentages 2

Show 1000's separakar Yes

Show blanks instead of zeros Mo

Font size g

Sample amount;

Amount ($1,234.56)
Percent 100.00%
< Back | HERES Cancel Erint Preview Laypout
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to

the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

A2 New Deposit List I
File Edit View Favortes Tools Help

Badana=?- |

il Generall 2 Filters 3 Format |

Headings Color Scheme
Criteria

Sort ™ Apply a Colar Scherne Report Name
;aeii:izt;;l . Calurn heading back. color Subtitle
{8 Color Scheme

[T Group heading back calor Group Headings

. Group heading fore color

Efestame [Meratlis |

< Back TRt Cancel Frint Preview Layout

Deposit Report

The Deposit Report includes detailed information about a selection of deposits, including payment detail and
bank information.

The Deposit Report has tabs on which you set parameters: General, Filters, and Format. To move among the tabs,
click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to include

in the report and how the report should look. For more information about creating a report, see “Creating a
report in Accounts Receivable” on page 10.
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General Tab

On the General tab, you can select parameters specific to the report and make selections about the information
included in the report.

@ New Deposit Report
File Edit Wiew Favorites Tools Help

RS -2 |

1. General |2: Filtersl 3 Format |

Ihciude deposits with these dates

Depasit date: Include all dates

Entered on date: IIncIude all dates j
Post date: IIncIude all dates j

Include deposit numbers fram: | | To: | |

[~ Only include deposits whose amounts are greater thar: I
v Update the deposit printed on date when printing? [~ Close deposit after printing?
Inchude deposits fram

[ Accounts Receivable

[+ Cash Receipts

[~ Create an output query of deposits

R eport orientation: IPnrtrait 'I

< Back | Hemt » | Cancel | Frint | Preview | Layout |

Include deposits with these dates. In this frame, you can select a date or date range for the deposits to
include in the report. Make your selections in the the Deposit date, Entered on date, and Post date fields.

If you select <Specific range>, specify start and end dates. If you leave the Start date field blank, all
activity is included up to the end date. If you leave the End date field blank, all activity from the start
date forward, including transactions with a date in the future, is included. If you leave both fields
blank, all activity is included.

Include deposit numbers from [] To [ ]. You can enter a range of deposit numbers to include in the report.
If you leave both fields blank, the report includes all deposit numbers.

Only include deposits whose amounts are greater than [ ]. You can mark this checkbox to enter a
minimum deposit amount for deposits to include in the report. All deposits less than or equal to the amount

you enter are excluded.

Update the deposit printed on date when printing? Mark the checkbox to update the Deposit ticket
printed on field on the deposit record with the date the report is printed.

Close deposit after printing. Mark the checkbox to change the status of the deposit to Closed after the
Deposit Report is printed.

Include deposits from. Mark the checkbox for each accounts receivable program whose deposits you want to
include in the report. This only appears if you have both Accounts Receivable and Cash Receipts installed.

Create an output query of deposits. If you mark Create an output query of deposits, the program creates a
guery of the deposits included in the report. You can use the query later in other areas of Accounts
Receivable.



DEPOSIT AND RECEIPT REPORTS 18

Report orientation. Select Portrait for the report to appear vertically or Landscape for the report to appear
horizontally.

Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Post Statuses filter, only deposits with the post statuses you select appear in the report.

On the Filters tab, you can filter the records appearing in the report. For more information about filtering in
The Financial Edge, see the Program Basics Guide.

I Mew Deposit Report
File Edit “iew Fawaorter Tools Help
R el |

1: General  2: Filters IQ: Formatl

f®0pen ) Clear Al Filters

Filkers I Include Selected Filkers

Deposits all <ill Deposits =

Post Statuses all <Al Post Statuses=

Barks all <Al Banks=>

< Back | Hewut » Cancel Frint Prewiew Layout

Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
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Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting
options for the Deposit Report. When you select an item in the list, the right side of the screen displays selections

for that section of the report.

Note: The heading defaults to Deposit Report in the Title field. You can leave this as the title for the report or

enter your own.

Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

1@ Mew Deposit Report
File Edit “iew Fawvortes Toolz Help

HRE QG e ?-

1 Generall 2 Filterz 3 Format |

E Headings
Criteria
Datail — Heading Format
Sort Title: IDeposit Fepart

Fage Footer

Report Foater
Miscellaneous
Calor Scheme

Subtitle: |

Aligr: Il:enter 'I

[¥ Print organization name in header

v Print Page Mumber in Heading

[¥ Frirt Report Date in Heading

Formnat: IF'age 1 j Format: IShort Date and Time j
Align: [ Right =l | Adan Left =]
[¥ Frint report heading on each page
< Back | (= Cancel Frrint Freview Layaut

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on

the report.
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Criteria. Use Criteria to print data to help you remember the criteria you use to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the
report

I Mew Deposit Report
File Edit “iew Fawvortes Toolz Help

==l led R E

1 Generall 2: Filters 3 Farmat |

Headings Criteria

E Criteria

Detail [v Fiint these criteria on Ia separate page 'I

Sart Saved report name

Page Footer Output query name

Fepart Faater Deposit dates to include
Mizcellaneous Entered on dates ta include
Color Scheme Fost dates to include

Include deposit number range
Include depost amounts
Include deposits from these systems

< Back | | (= | Cancel | Frrint | Freview | Layout |

Detail. Use Detail to select and order payment methods for which to print details on the report. You can also
select to print separate pages for each payment method and deposit.

12 New Deposit Report [ x| I
File Edit WYiew Favaorites Tools Help

HRSE = ?-

1: Genelall 2 Filkers 3 Format |

Headings Detail

Criteria
[v iShow payment detail for these papment methods
sort [ Check

Page Footer

[V Cash
Report Footer .
tizcellaneous ' Credt card
[w| COD

Color Scheme ¥ Received EFT

[v| Other Up |
_ Down_|

Dlown

[~ Separate page for each payment method
™ Separate page for each deposit

< Back et = Cancel Print Freview Layout
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Sort. Use Sort to select the order in which information appears on the report. When you select Sort, you can sort
within categories in the grid on the right. Select a sorting category in the Sort by column and select Ascending
or Descending in the Order by column.

I Mew Deposit Report
File Edit “iew Fawvortes Toolz Help
H a3k == |
1 Generall 2: Filters ]
Headings Sort
Criteria
Detail Sot by | Drder by |
Tranzaction Mumber Azcending
Page Footer
Report Foater
Miscellaneous
Color Scheme
< Back | | (= | Cancel | Frrint | Freview | Layout |

Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align
the text. You can include the page number and date in the footer.

I Mew Deposit Report
File Edit %iew Favortes Toolz Help

eI el |

1 Generall 2 Filters 2 Farmat |

Headings Page Footer
Criteria ——
Detail — Fage Footer Tex

Sort Text:
B Page Faoter

Report Footer
Miscellansous

Colar Scheme Aligr: Il:entel 'I

[ Print Page Murnber in Footer

[~ Print Report D ate in Footer
Format: IF'age 1 j Farmat: IShDrt Date and Time j
Aligre [ Right Bl || Al L =

< Back | THERt Cancel FErint Preview Layout
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Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to
align the text. The report footer appears at the end of the report.

n Mew Deposit Report

File Edit “iew Fawvortes Toolz Help
H &= %W B
1 General] 2 Filterz 3 Format l
=] Headings Report Footer
] Criteria
5 Detail Report Footer Text
2] Sont Text:
2] Color Scheme l—_|
< Back | | Cancel |

Frrint | Freview | Layaut |

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

n Mew Deposit Report
File Edit “iew Faworites

H &S D W

Toolz Help

?-

1 General] 2 Filterz 3 Format l

] Criteria
=] Detail Show currency character an All amounts
=] Sort Show percent sign on Al amounts
=] Page Footer Meqative amount format [1234.5E)
- HportFoter Murnber of digits after decimal for amaunts 2
5 Color Seme Mumber of digits after decimal for percentages 2

Show 1000'z zeparator Yes

Show blanks instead of zeroz Mo

Fant size 8

Sample amaunt;

Arnount [$1.234.56)

Percent 100.00%
< Back Cancel Frrint Freview Layaut
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

I Mew Deposit Report
File Edit “iew Fawvortes Toolz Help
H a3k == |

1 Generall 2: Filters

Headings Color Scheme

Criteria
Detai I Apply a Color Scheme Report Name
Sort M Column heading back color Subtitle

Page Footer

Miselln ™ Group heading back calor Group Headings

=3

. Group heading fore color

Hrestore [Vefaults |

< Back | (= Cancel Frrint Freview Layout
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Reporting categories in Accounts Receivable include Action Reports, Analysis Reports, Bank Account Reports,
Client Reports, Custom Reports, Deposit and Receipt Reports, Pivot Reports, Product and Billing Item Reports,
and Transaction Reports. This chapter discusses Product and Billing Iltem Reports. For information about other
report categories, see the chapter for that category. For information about Pivot Reports, see the Pivot Reports
Guide for The Financial Edge.

Note: We recommend you read the documentation for The Financial Edge thoroughly. Information presented
here provides you with basic information about product and billing item reports in Accounts Receivable.
Hands-on experience is the best way to learn, so we encourage you to try various options with your database.

Product and Billing Iltem Reports in Accounts Receivable include:

¢ Product and Billing Item List

¢ Product and Billing Item Report

Product and Billing Item List

The Product and Billing Item List provides a summarized list of products and billing items.

The Product and Billing Item List has tabs on which you set parameters: General, Filters, and Format. To move
among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify
information to include in the report and how the report should look. For more information about creating a
report, see “Creating a report in Accounts Receivable” on page 10.

General Tab

On the General tab, you can select parameters specific to the report and make selections about the information
included in the report.

u Mew Product and Billing Item List
File Edit ‘“iew Favortes Took Help

H 4SS LW ?-

1 Giereral | 2 Fiters | 3 Fomet

Include products and biling itemsz with theze valid dates
Valid dates within:—[Includs ol dates 7

[ Include inactive products and billing items
[~ Show pricing schedule for products

[~ Create an output queny of product and biling itermns

Report orientation: | Portrait hd

Ment » Cancel Frint Presviewm Layout




PRODUCT AND BILLING ITEM REPORTS 18

Include products and billing items with these valid dates. In this frame, you can select a date or date
range for the products and billing items to include in the report. Make your selection in the Valid dates
within field.

If you select <Specific range>, specify start and end dates. If the Start date field is blank, all activity is included
up to the end date. If the End date field is blank, all activity from the start date forward, including
transactions with a date in the future, is included. If both fields are blank, all activity is included.

Include inactive products and billing items. You can include products and billing items with a status of
Inactive.

Show pricing schedule for products. You can mark Show pricing schedule for products to include the
pricing schedule for each product.

Create an output query of products and billing items. If you mark Create an output query of products
and billing items, the program creates a query of the products and billing items in the report. You can use the
query later in other areas of Accounts Receivable.

Report orientation. n the Report orientation field, select Portrait or Landscape.

Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Product and Billing Items filter, only the products and billing items you select are included in the report.

On the Filters tab, you can filter the records appearing on the report. For more information about filtering in
The Financial Edge, see the Program Basics Guide.

IQ Mew Product and Billing Item List E
File Edit “iew Favortes Tools Help

== R e |

1 General  2: Filters IE: Furmatl

€0 0pen 7 Clear All Filkers

Filkers I Include Selected Filkers
Products and Billing Items all =all Products and Billing Ikems =
Units of Measure Al <Al Units of Measure =
Product and Biling Itemn Attributes Al <l Product and Billing Item Aktributes

[« | 2

< Back | Mext » | Cancel | Brint | Preview | Layout |

Tip: You can also double-click a filter in the grid to open the selection screen.
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Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can
select specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting
options for the Product and Billing Item List. When you select an item in the list, the right side of the screen
displays selections for that section of the report.

Note: The heading defaults to Product and Billing Item List in the Title field. You can leave this as the title for
the report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

lﬂ Mew Product and Billing Item List
File Edit “iew Fawortes Toolz Help

SR el |

1 Generall 2 Filters 3 Farmat |

B Headings Headings

Criteria :

Sart — Heading Format

Page Footer Title:  |Product and Billing Item List
Report Footer Subitle:

Miscellansous

Color Scheme Aligr: IEenter 'I

[¥ Print organization nare in header

W Print Page Mumber in Heading [¥ Print Report Date in Heading
Farmat: IF'age 1 j Farmat: IShDrt Date and Time j
Aligre [Right =l sdan JLett |

[¥ Print report heading on each page

< Back et Cancel FErrint Freview Layaut

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Use Criteria to print data to help you remember the criteria you use to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the

report.
IE Mew Product and Billing Item List
File Edit “iew Fawvortes Toolz Help
= Jie= R = e |
1 Generall 2: Filters 3 Farmat |
Headings Criteria
E Criteria
Soart [v Fiint these criteria on Ia separate page 'I
Page Footer Saved report name
Fh.apnrt Foater Dutput queny narne
Miscellaneous [w] Az of dates ta include
Colar Scheme Include inactive products and billing items
Show pricing zchedule for products
Products and billing items to include
Irits of measure to include
Product and billing item attributes to include
< Back | | (= | Cancel | Frrint | Freview | Layout |

Sort. Use Sort to select the order in which information appears on the report. When you select Sort, you can sort
within categories in the grid on the right. Select a sorting category in the Sort by column and select Ascending
or Descending in the Order by column.
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To print each category selected in the Sort by column on its own page, mark Page break on each new.

lQ Mew Product and Billing Item List x|
File Edit “iew Favorites Toolz Help

= D= N gl R

1 Generall 2: Filters  2: Farmat |

Headirgs Sort
Criteria

Sort by | Order by |
Fage Footer [[n] Azcending

Report Footer
Mizcellaneous
Color Scheme

[ Page bieak on each new D

< Back | Herts Cancel FErint | F'levieyl Layout |

Page Footer. You can enter a maximum of 254 characters in the page footer. You can include other options, such
as the page number and date.

lB Mew Product and Billing Item List [ ]

File Edit “iew Fawvortes Toolz Help
SR -2 |

1 Generall 2 Filterz 3 Format |

Headings Page Footer

Criteria
Sort — Page Footer Text
B Pa ber Test:

Fieport Footer
Mizcellaneaus
Calar Scheme

Aligr: IEenter 'l

[ Print Page Mumber in Footer —— [~ Print Report Date in Foater
Forrnat: IF'age 1 j Format: IShort Date and Time j
Align | Right 2 [ e =

< Back | (= Cancel Frrint Freview Layaut
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Report Footer. You can enter a maximum of 254 characters in the report footer and select how to align the text.

The report footer appears at the end of the report.

n Mew Product and Billing Item List
File Edit “iew Faworites

H &S D W

1 General] 2 Filterz 3 Format l

Toolz Help

?-

5] Headings Report Footer

] Criteria

5 Sot Report Footer Text

Z] Page Foater Text:

I Repart Foater

2] Mizcellaneous

] Color Scheme

< Back | | Cancel | Frrint | Freview | Layaut |

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

n Mew Product and Billing Item List
File Edit “iew Faworites

H &S D W

1 General] 2 Filterz 3 Format l

Toolz Help

?-

] Criteria
=] Sort Show currency character an All amounts
Z] Page Footer Show percent sigh on Al amounts
=] Report Footer Meqative amount format [1234.5E)
) Color Scheme Mumber of d?g?ts after dec?mal for amaounts 2

Mumber of digits after decimal for percentages 2

Show 1000'z zeparator Yes

Show blanks instead of zeroz Mo

Fant size 8

Sample amaunt;

Arnount [$1.234.56)

Percent 100.00%
< Back Cancel Frrint Freview Layaut
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to

the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

lﬂ Mew Product and Billing Item List

[ x|

File Edit “iew Favortes Tools Help
SRR R |
1: Generall 2 Filters 3: Format |

Headings Color Scheme

Criteria

Sart [~ Apply a Color Scheme Report Name

Page Footer M Colurn heading back colar Subtitle

Report Foater

B Color Scheme [~ Group heading back colar Group Headings

. Group heading fore color
Festone [Mefaulis |
< Back | Ij [= 0 Cancel Frirt Frewview Layout

Product and Billing Iltem Report

The Product and Billing Item Report provides detailed information about products and billing items.

The Product and Billing Item Report has tabs on which you set parameters: General, Filters, and Format. To move
among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify

information to include in the report and how the report should look. For more information about creating a
report, see “Creating a report in Accounts Receivable” on page 10.
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General Tab

On the General tab, you can select parameters specific to the report and make selections about the information
included in the report.

IE Hew Product and Billing Item Report
File Edit “iew Fawaorter Tools Help

IR |
| 2 Filtersl 2 Formatl

Include products and billing items with theze valid dates

Valid dates within: —[include all dates ¥ |

Inciude the following product and billing item infarmation: -

¥ Pricing schedule details for products
[¥ Sales tax entity details For sales tax items

¥ Include inactive products and billing tems

[~ Create an output gueny of product and billing iterms

Report arientation: ILandscape 'I

< Hack | Hewut » | Cancel | Frint | Prewiew | Layout |

Include products and billing items with these valid dates. In this field, select a date or date range for
products and billing items to include in the report. These are the dates from the product or billing item
record.

If you select <Specific range>, you can specify start and end dates. The product or billing item’s date must fall
within this range. If you select Today, Yesterday, Tomorrow, or <Specific date>, the product or billing item’s
start date must be on or after the selected date. The field name changes to Valid dates on or after.

Include the following product and billing item information. You can include pricing and sales tax
information by marking checkboxes:

e Pricing schedule details for products
¢ Sales tax entity details for sales tax items

Include inactive products and billing items. You can include products and billing items with a status of
Inactive.

Create an output query of products and billing items. If you mark this checkbox, the program creates a
guery of the products and billing items included in the report. You can use the query later in other areas of
Accounts Receivable.

Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Product and Billing Items filter, only the products and billing items you select are included in the report.

On the Filters tab, you can filter the records appearing on the report. For more information about filtering in
The Financial Edge, see the Program Basics Guide.

lﬂ Mew Product and Billing Item Report [ ]

File Edit *“iew Favortes Tools Help
=R = |
1: General 2 Filters |§: Formatl
R 0pen ) Clear Al Filkers
Filkers I Include Selected Filters
Products and Billing Items all <Al Products and Biling Items=
Units of Measure Al <Al Units of Measure=
Product and Billing Item Attributes | Al <Al Product and Billing Item attributes:
K i
< Back | Mext = Cancel Frrint Preview | Layaut |

Tip: You can also double-click a filter in the grid to open the selection screen.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can
select specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting
options for the Product and Billing Item Report. When you select an item in the list, the right side of the screen
displays selections for that section of the report.

Note: The heading defaults to Product and Billing Item Report in the Title field. You can leave this as the title
for the report or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

IE Mew Product and Billing Item Report
File Edit “iew Fawvortes Toolz Help

S & =2

1 Generall 2: Filters 3 Farmat |
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Criteria
Detsil — Heading Format
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Report Foater
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< Back et Cancel Frrint Freview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Use Criteria to print data to help you remember the criteria you use to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the
report.

IE Mew Product and Billing Item Report
File Edit “iew Fawvortes Toolz Help

==l led R E

1 Generall 2: Filters 3 Farmat |

Headings Criteria

E Criteria

Detail [v Fiint these criteria on Ia separate page 'I

Sort Saved report name

Page Faoter Output query name

Fieport Footer Ag of dates to include
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Products and billing items to include
|Inits of measure to include
Product and billing item attributes to include

< Back | | (= | Cancel | Frrint | Freview | Layout |

Detail. Use Detail to select details specific to the Product and Billing Item Report. Mark the checkboxes to show
distribution by transaction characteristics. If you have the optional module Projects and Grants and have
defined transaction codes, additional checkboxes appear.

lﬂ Mew Product and Billing Item Report
File Edit %iew Favortes Toolz Help

eI el |

1 Generall 2: Filters

Headings Detail
Criteria
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Sort. Use Sort to select the order in which information appears on the report. When you select Sort, you can sort
within categories in the grid on the right. Select a sorting category in the Sort by column and select Ascending

or Descending in the Order by column. To print each category selected in the Sort by column on its own page,
mark Page break on each new.

IE Mew Product and Billing Item Report
File Edit “iew Fawvortes Toolz Help

IR Tl |
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Headings Sort
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Page Footer

Report Foater
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Page Footer. You can enter a maximum of 254 characters in the page footer. You can include other options, such
as the page number and date.

lﬂ Mew Product and Billing Item Report
File Edit %iew Favortes Toolz Help
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Report Footer. You can enter a maximum of 254 characters in the report footer and select how to align the text.
The report footer appears at the end of the report.

n Mew Product and Billing Item Report
File Edit “iew Fawvortes Toolz Help
EH &E %W & =

1 General] 2 Filterz 3 Format l

5] Headings Report Footer
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5 Detail Report Footer Text
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

n Mew Product and Billing Item Report
File Edit “iew Fawvortes Toolz Help

H &S D W ?-

1 General] 2 Filterz 3 Format l

] Headings Miscellaneous

] Criteria
=] Detail Show currency character an All amounts
=] Sort Show percent sign on Al amounts
=] Page Footer Meqative amount format [1234.5E)
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Show 1000'z zeparator Yes

Show blanks instead of zeroz Mo

Fant size 8

Sample amaunt;

Arnount [$1.234.56)
Percent 100.00%
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Reporting categories in Accounts Receivable include Action Reports, Analysis Reports, Bank Account Reports,
Client Reports, Deposit and Receipt Reports, Pivot Reports, Product and Billing ltem Reports, Reconciliation
Reports, and Transaction Reports. This chapter discusses Reconciliation Reports. For information about other
report categories, see the chapter for that category. For information about Pivot Reports, see the Pivot Reports
Guide for The Financial Edge.

Note: We recommend you reconcile your subsidiary ledger transactions monthly.

Accounts Receivable Reconciliation Reports are designed to help you reconcile your accounts receivable
subledger transactions with your general ledger. These reports have predefined defaults to help you identify the
transactions that are part of your subledger balance. Some transactions may prevent these reports from
balancing to your general ledger. You can use these reports to determine if transactions have posted properly,
and which subsidiary ledger transactions are causing a difference in your general ledger balance.

The Accounts Receivable Reconciliation Reports (Account Distribution Report, Aged Accounts Receivable Report,
and Open Item Report) are similar to the analysis and transaction reports with the same names, however the
reconciliation reports have predefined defaults to help you identify the transactions that are part of your
subledger balance.

Note: For more detailed information about reconciling subsidiary ledger transactions, please see the
Subsidiary Ledger Reconciliation Guide.

For the Reconciliation Reports category, you can create these reports:
¢ Account Distribution Report

¢ Aged Accounts Receivable Report

e Open Item Report

Account Distribution Report

The Account Distribution Report for reconciliation is similar to the transaction report with the same name,
however this report has predefined defaults to help you identify the transactions that are part of your subledger
activity.

Note: This report is designed to help you with your reconciliation process. However, if you need additional
date and filtering options for this report, see “Account Distribution Report” on page 228.

The Account Distribution Report lists debit and credit amounts, created by Accounts Receivable transactions and
adjustments, for accounts.

If you void payments from clients and create bank adjustments, they will not appear in the Account Distribution
Report. To find adjustment amounts that are part of your reconciliation, you can run a GL General Ledger Report
and filter for the journal code used when posting cash management adjustments. You can also run the Bank
Register Report and filter on cash management adjustments.

The Account Distribution Report has three tabs on which you set parameters: General, Filters, and Format. To
move among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify
information to include in the report and how the report should look. For more information about creating a
report, see “Creating a report in Accounts Receivable” on page 10.



RECONCILIATION REPORTS 20

General Tab

On the General tab, define parameters and select information to include in the report.

12 New Account Distribution Report E
File Edit View Favorites Tools Help

dada@ a7 2- |
1. General |2: Filtersl &l Formatl

Aepon ot :

Include trangactions with thesze dates -
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[~ Create an output queny of IEIients 'I
Fieport orientation: ILandscape 'I

Report format. In the Report format field, select “Detail” or “Summary”. The detail account format can be
more useful than the summary account format for locating differences.

Include transactions with these dates. Specify a start date and an end date for the posted transactions you
want to include in the report. If the Start date field is blank, all activity is included up to the end date. If the
End date field is blank, all activity from the start date until present is included. If both fields are blank, all
activity is included.

Create an output query of [ ]. If you mark Create an output query of, you can select for the program to
create a query of the included accounts, clients, charges, credits, invoices, returns, refunds, or payments. You
can use the query later in other areas of Accounts Receivable.

Report orientation. If you create the report in summary format, you can select Portrait or Landscape. If you
create the report in detail format, the report prints in Landscape.

Filters Tab

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the
Filtering Criteria chapter in the Program Basics Guide.

@ Mew Account Distribution Report E

File Edit WView Favorites Tools Help

g da@ =2 |

| 2 Format I

1: General

Filters | Indude Selected Filters
Accounts All <All Accounts =

Open. You can click this button to access the Selected Accounts screen on which you select specific accounts to
include in the report.
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Clear All Filters. Click this button to remove all previously selected accounts from the report.
Filters column. This column lists the available filters for this report. You cannot edit this column.

Include column. In the Include column, select “All” or “Selected”. If you choose “Selected,” the Selected
Accounts screen opens for you to designate specific accounts.

Selected Filters column. After you have selected specific accounts, they appear in the Selected Filters
column.

Format Tab

On the Format tab, you specify how the report looks. A description of each formatting option is provided.

Note: The heading defaults to Account Distribution Report in the Title field. You can leave this as the title for
your report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

Mg New Account Distribution Report I
File Edit View Favorites Toolz Help
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< Back et Cancel Brint Freview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of
the report.

A New Account Distribution Report
File Edit View Favorites Tools Help
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Detail. Use Detail to select details specific to the Account Distribution report. If you mark Show
distribution for these characteristics, you can select the characteristics to include. If you choose
one characteristic, you can mark Show characteristic as a column in the main report body. The
marked characteristic appears as a separate column on the report. If you choose multiple
characteristics, you can choose Show transaction total. This prints the debit or credit total for each
line item.

I New Account Distribution Report E3 I
File Edit View Favorites Tools Help
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Grand Totals. Use Grand Totals to show combined totals for transaction characteristics. If you have the optional
module Projects and Grants and have defined transaction codes, additional checkboxes appear. You can use
the Up and Down buttons to order the characteristics to appear on the report.

A New Account Distribution Report I
Fle Edit View Favorites Tools Help
= IeRE T =T |

1: General | 2 Filters 3 Format |
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Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall
between sets of information.

To order the information, you can select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break?

for a category, fields are enabled for you to specify more information about the break for the selected sorting
category.

In the Text before value and Text after value fields, you can enter up to 30 characters to print directly before
and after the value for the selected sorting category.
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To print the number or percentage for the selected category in the footer, mark Print count per or Print count
as a percentage of total for the selected sorting category. To start the selected sorting category on a new
page, mark Page break on each new.

A New Account Distribution Report I
File Edit View Favorites Tools Help
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

A& New Account Distribution Report I
File Edit View Favorites Toolz Help

dada = ?- |

1: General' 2 Filters 3 Format |

Headings Page Footer
Criteria

Dretail — Page Foater Text
Grand Totals Text:
Sart/Break,

8 Page Foater
Feport Footer

Mizcelansous Align: ICenler 'I
Color Scheme

I Print Page Number in Footer

[~ Piint Report Date in Foater
Format; IF'age 1 j Farmat: IShc-rt Date and Time j
Aligr: IHight j Align: ILeﬂ j

< Back et Cancel Erint Freview Lapout
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

M New Account Distribution Report
File Edit View Favorites Tools

= IS RE T Rl RN R

Help

5 General' 2 Filters 3 Format |

iB& Feport Footer
Miscellaneous
Color Scheme

Aligr: ILeft vl

Headings Report Footer
Criteria 5 —
Lretail eport Foaoter Tex
Grand Totals Text:

Sart/Break,

Page Foater

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

M New Account Distribution Report
File Edit View Favorites Tools

a2

Help

]|

1k General' 2 Filters 3 Format |

Headings Miscellaneous
Criteria
Dretail Show currency character on All amounts
Grand Totals Show percent sign on All amounts
IE;-:rta’BFreak Megative amount format (1234.56)
1¢
HZizrt ioojt[el Mumber of digits after decimal for amounts 2
: e Mumber of digits after decimal for percentages 2
Calar Scherm Show 1000's separator Yeg
Show blanks instead of zeros Mo
Font size 3
Sample amovint:
Amount (51,234.56)
Percent 100.00%:
< Back fewt s Cancel Brint Freview Layout
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

A New Account Distribution Report |
File Edit View Favorites Tools Help

Ha3am = |

1: General' 2 Filters 3 Format |

Headings Color Scheme

Criteria
Detail [ Apply a Colar Scheme Report Name
g;‘?;g;oafls M Column heading back color Subtitle
Page Foater ™ Column heading faore color _
E‘;igﬁ:;;;i; [” Group heading back calar Group Headings
‘B Calor Scheme M Gioup heading fore color ’

Frestore Detaulks |

< Back et Cancel Erint Freview Lapout

Aged Accounts Receivable Report

Note: This report is designed to help you with your reconciliation process. However, if you need additional
date and filtering options for this report, see “Aged Accounts Receivable Report” on page 44.

The Aged Accounts Receivable Report for reconciliation is similar to the analysis report with the same name,
however this report has predefined defaults to help you identify the transactions that are part of your subledger
balance.

Use the Aged Accounts Receivable Report to list balances distributed in aging periods defined in Configuration.
This report is useful in determining past due and current balances of clients.

The Aged Accounts Receivable Report is different than the Aged Accounts Payable Report. In Accounts Payable,
payments are included or excluded based on the “age as of date”. In Accounts Receivable, charges, payments,
and credits are included based on the transaction date filters. The “aging as of date” is independent of the
transactions.

You can use this report whether you use a single-party billing system or third-party billing system. If you use a
third-party billing system, keep the definitions of payer and recipient clients in mind:

Note: We recommend you reconcile your subsidiary ledger transactions monthly.

e A payer is a person or organization responsible for paying a bill.

¢ Arecipient is a person or organization that receives a product or service, or has its balance reduced by a
payment or credit.
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The Aged Accounts Receivable Report has two tabs on which you set parameters: General and Format. To move
among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify
information to include in the report and how the report should look. For more information about creating a
report, see “Creating a report in Accounts Receivable” on page 10.

General Tab

On the General tab, define parameters and select information to include in the report.

12 new Aged Accounts Receivable [ x]
File Edit View Favorites Tools Help

A a2 |

1. General | 2: Format I

Calculate aging as of: |<Specifi-: dater x| Dae= |

[~ Create an output queny of ICIients 'l
Report onentation: I Partrait % I

Calculate aging as of. In the Calculate aging as of field, enter a specific date for the aging period.

Create an output query of [ ]. If you mark Create an output query of, select Clients or Charges. The program
creates a query of clients or charges included in the report. You can use the query later in other areas of
Accounts Receivable.

Report orientation. In this field, you can select to print the report in Portrait or Landscape format.

Format Tab

On the Format tab, you specify appearance settings for the report. The list on the left of the screen displays
formatting options for the Aged Accounts Receivable Report. When you select an item in the list, the right side of
the screen displays selections for that section of the report.

Note: The heading defaults to Aged Accounts Receivable Report in the Title field. You can leave this as the title
for your report or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

1@ new Aged Accounts Receivable I
File Edit View Favorites Tools Help

daIaE =22 |

1: General |

B Headings Headings

Criteria :

Dretail — Heading Format

GL Sort/Break Title: |Aged Accounts Receivable
Page Footer S ublitle: I

Report Faater
Miscelaneous Aligr: IEenter 'I
Colaor Scheme

Transaction Son/Break [ Prirt organization narme in header

¥ Print Page Number in Heading [# Piint Report Date in Heading
Format; IF'age 1 j Farmat: IShc-rt Date and Time j
Aligre [Right = Aigne Lt =l

[V Print report heading on each page

< Back Ment > Cancel Print Previsw Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the

report.

A New Aged Accounts Receivable
File Edit View Favorites Tools Help

a3 - 2-

]|

1: General 2 Format |

Dretail

GL Sort/Break.

Page Footer

Fieport Footer
Mizcelansous

Color Scheme
Transaction Sort/Break

¥ Print theze criteria on Ia zeparate page 'l

Saved report name

Output query name

Calculate aging as of

Transaction dates o include

Due dates to include

Post dates to include

Include clients with a balance greater than
Feduce balances by unused payments/credits beginning with
Accounts to include

Account attributes to include

Funds to include

Classes to include

Projects ta include

Project attributes to include

Fecipient clients ta include

Payer clients to include

|»

|

< Back | [ et > |

Cancel |

Erint | Previeyl

Lapout |

Detail. The Detail panel is significant to the output of the report. In the Report by field, you can select
“Assignment” or “Ownership”. You can then select to show or not show details.

Mark Show transaction detail to list the transaction date, type, ID, due date, aging period and amount for
each transaction that composes a client’s balance.

Note: If you are using a single-party billing system, it does not matter whether you report by payer or recipient. To

prevent extra lines in the report, do not show payer or recipient details.

To summarize aging by product and billing item, mark Include summary by product and billing item. This
creates a chart on the last page of the report totaling the amount due for each product and billing item under
the appropriate aging period.
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For both individual and organization clients, you can select to include contact information and specify the
address and number type to use. To determine how client names appear on the report, select a client
salutation. Salutations are defined in Configuration.

A New Aged Accounts Receivable I
File Edit View Favorites Tools Help

=R = |

1: General 2 Format |

Headings Detail

Criteria

Report by | Assignment =] and | 5w x| recipient detals

GL Sort/Break.

Eroup ranzactions by General Ledaer receivable account infarmation

Fage Footer I | [choosing thiz aption will ignere any Payer Client fliers and exclude
Fiepart Foater unapplied payments and credits|

Miscellansous [~ Shaow transaction detail

Calor Scheme [ Include surmmary by product and billing item

Transaction Sort/Bresk For individual clients:

[~ Show the contact infarmation for this address: IHc-me VI
Shiow thiz contact number: IHgme vI

Far organizational clients:

[~ Show the contact infarmation for this address: IHc-me VI
Shiow thiz contact number: |Hgme vI

Client 5 alutation: ICIient Marmne j

< Back | fewt » | Cancel | Erint | Freview | Lapout |

GL Sort/Break. This formatting option is available only if you selected the Group transactions by General
Ledger receivable account information option on the Detail screen.

Use GL Sort/Break to select the order for information to appear on the report and where breaks fall between
sets of information. The GL Sort/Break applies to the overall report and allows for easier reconciliation with
General Ledger, whereas the Transaction Sort/Break applies to each client section within the report.

To order the information, you can select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break?
for a category, fields are enabled for you to specify more information about the break for the selected sorting
category.

In the Text before value and Text after value fields, you can enter up to 30 characters to print directly before
and after the value for the selected sorting category.
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To print the number or percentage for the selected category in the footer, mark Print count per or Print count
as a percentage of total for the selected sorting category. To start the selected sorting category on a new

page, mark Page break on each new.

]|

A3 New Aged Accounts Receivable
File Edit View Favorites Tools Help
eI ]2
1: General 2 Format |
Headings GL Sort/Break
Criteria
Detail Sort by IEI'E&E{? Iﬂ
B GL Sort Acco Jurnber =
Page Footer ]
Fieport Footer r
Mizcelansous
Color Scheme ]
Transaction Sort/Break [ ;I
Break Header for Account Mumber-
Text before value: I
Tewt after value; |
Break. Footer for Account Mumber-
[ Fritit count per Secount Mumber
[~ Print count a8 a percentage of batal
™| Page break on each new Account Humber
< Back | [ et | Cancel | Erint | Freview | Lapout |

the text. You can include the page number and date in the footer.

Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align

I new Aged Accounts Receivable

File Edit View Favorites Toolz Help

| S| | 2

1: General 2: Farmat |

Headings Page Footer
Criteria S
Dretail  FPage Footer Tex
GL Sort/Break Teat:

8 Page Footer
Report Footer
Miscellaneous
Color Scheme
Transaction Sort/Break

Align: ICenter 'l

I Print Page Number in Footer

[~ Piint Report Date in Footer
Format: IF'age 1 j Format: IShDrt [Date and Time j
Aligre | Right =1 | | A JLett =
{ Back | Mest > Cancel Frint Freview Layout
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Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to
align the text. The report footer appears at the end of the report.

M3 New Aged Accounts Receivable I
File Edit View Favorites Toolz Help

dada = ?- |

1: General 2 Farmat |

Headings Report Footer
Criteria

Detail Report Footer Text
GL Sort/Break Text:
Page Foaoter

8 Report Footer
Miscelaneous

Calar Scheme Aligr: ILeft ,I
Trangaction Sort/Break

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

1@ new Aged Accounts Receivable I
File Edit View Favorites Tools Help

= |

1: General 2 Format |

Headings Miscellaneous
Criteria

Dretai Show currency character on All amounts
GL Sart/Break Show percent sign an All amounts
Page Fouter Megative amount format (1234.58)
Hport Fcu:te Mumber of digits after dedmal for amounts 2
E Calor Sche Mumber of digits after decimal for percentages 2
Tranzaction Sort/Bresk | |Show 1000's separator Yes

Show blanks instead of zeros Mo

Font size 8

Sample amaount;

Amount (51,234.58)
Percent 100,00%

< Back et > Cancel Print Previsw Layout
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

A New Aged Accounts Receivable I
File Edit View Favorites Tools Help

B2 S ]2 |

1: General 2 Format |

Headings Color Scheme

Criteria

Detail [ Apply a Colar Scheme Report Name
E';gseo';:s;ak M Column heading back color Subtitle

Report Foster Ly o' Headings

Mizcellaneous
:§ Color Scheme

[~ Group heading back color Group Headings
Tranzaction Sart/Break . Group heading fore colar ;

Fieztone Defaults |

< Back | [ ewt > | Cancel | Erint | Freview | Lapout |

Transaction Sort/Break. Use Transaction Sort/Break to select the order for information to appear on the
report and where breaks fall between sets of information. The Transaction Sort/Break applies to each client
section within the report, whereas the GL Sort/Break applies to the overall report and allows for easier
reconciliation with General Ledger.

To order the information, you can select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break?
for a category, fields are enabled for you to specify more information about the break for the selected sorting
category.

In the Text before value and Text after value fields, you can enter up to 30 characters to print directly before
and after the value for the selected sorting category.
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To print the number or percentage for the selected category in the footer, mark Print count per or Print count
as a percentage of total for the selected sorting category. To start the selected sorting category on a new
page, mark Page break on each new.

A New Aged Accounts Receivable I
File Edit View Favorites Tools Help
DE I a2 [2- |
1: General 2 Format |
Headings Transaction Sort/Break
Criteria
Dretail Sort by | Order by | Break? Iﬂ
GL Sort/Break Payer Name Azcending v
Page Footer Redpient Name Ascending V¥
Fieport Footer -
Mizcelansous
Color Scheme r
(B Transaction Sort/Break [ LI
Break Header for Payer Mame:
Text before value: I
Test after value: |
Break Footer for Payer Mame:
[~ Print count per Payer Nare
[~ Print count as a percentage of batal
™ Page break on each new Paper Name
< Back et 2 | Cancel | Erint Freview Lapout

Open ltem Report

Note: This report is designed to help you with your reconciliation process. However, if you need additional
date and filtering options for this report, see “Open Item Report” on page 52.

The Open Item Report for reconciliation is similar to the analysis report with the same name, however this report
has predefined defaults to help you identify the transactions that are part of your subledger balance.

The Open Item Report lists charges that have not been completely paid and the amount remaining to be paid as
of a selected date. This report is useful for reconciling to the general ledger.

The Open ltem Report has two tabs on which you set parameters: General and Format. To move among the tabs,
click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to include
in the report and how the report should look. For more information about creating a report, see “Creating a
report in Accounts Receivable” on page 10.
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On the General tab, define parameters and select information to include in the report.

File Edit View Favorites Tools Help

dada@ a4 ?-

1. General | 2 Format I

Show tranzactions open az of: I(Specific date

j Date:

[~ Create an output querny of ICIients 'l
Report onientation: I Partrait e I

Show transactions open as of. In the Show transactions open as of field, specify a date for charges to

include. All charges open as of this date are included.

Create an output query of [ ]. If you mark Create an output query of, select Clients or Charges. The program
creates a query of the clients or charges included in the report. You can use the query later in other areas of

Accounts Receivable.

Report orientation. In the Report orientation field, select “Portrait” or “Landscape”.

Format Tab

On the Format tab, you select how you want the report to appear. The list on the left of the screen displays
formatting options for the Open Item Report. When you select an item in the list, the right side of the screen

displays selections for that section of the report.

Note: The heading defaults to Open Item Report in the Title field. You can leave this as the title for your report

or enter your own.



220 CHAPTER

Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

]|

I new Open Ttem Report
File

daIAE ]2 |

Edit View Favorites Tools Help

1: General |

B Headings Headings

Criteria :

Dretail — Heading Format

GL Sort/Break Title: |Dpen Item Report
Page Footer Subtitie: I

Report Faater
Miscelaneous
Colaor Scheme
Transaction Sort/Break

Aligr: IEenter 'I

[ Prirtt organization narme in header

¥ PFrint Page Mumber in Heading

[# Piint Report Date in Heading

Format; IF'age 1 j Farmat: IShc-rt Date and Timne j
Aligre |Right = A Lt =l
[V Print report heading on each page
< Back Ment > Cancel Print Previsw Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on

the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the
report.

A New Open Ttem Report I
File Edit View Favorites Tools Help

EIEREETEIEE IR |

1: General 2 Format |

Criteria
- Detil [vw Print these criteria on Ia separate page 'l

GL Sort/Break.

Saved report name

|»

Page Footer Dutput quemny name

Repart Footer Show transactions open as of
Miscellaneous Base tranzaction open date an
Calar Scheme Transaction dates o include

Transaction Sort/Break Post dates to include

Include unapplied payments and credits
Accounts to include

Account attributes to include

Funds to include

Classes to include

Post statuses to include

Projects ta include

Project attributes to include

Owner clients to include

Aszsigned ta clients to include LI

< Back [ et Cancel Erint Freview | Lapout |

Note: If you are using a single-party billing system, it does not matter whether you report by payer or
recipient. To prevent useless lines in the report, do not show payer or recipient details.

Detail. Use Detail to select details specific to the Open Item Report. If you mark Include open item information,
you can select how to report open items. In the Report by field, you can select Payer or Recipient. In the
Report in fields, you can select Detail or Summary and whether to show or not show payer or recipient
details.

If you select to report by recipient and not to show payer details, and mark Group transactions by General
Ledger receivable account information, the report gives a total for each receivable account and a grand total.
This can be helpful when you reconcile if you have multiple receivable accounts.

Mark Include summary by product and billing item to summarize aging by product and billing item.
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In the Salutation field, select how to display client names on the report. Salutations are defined in
Configuration.

A& New Open Ttem Report I
File Edit View Favorites Tools Help
da S AR a2 2- |

1: General 2 Farmat |

Headings I

Criteria

[v include chent open item informatior
GL Sort/Break Repart by IPa_'HEf vl

2] Page Foater : . :
Report Footer Report in: IDetaiI x| and IShow \=| recipient details

Miscellaneous r Group ranzactions by General Ledaer receivable account infarmation
Caolor Scheme [choosing this aption will ignare atp Eayer Client flters]

Transaction Sort/Break [~ Include surmmary by product and billing item

Client Salutation: | Client Mame j

< Back | Ewt | Cancel | Brint | Freview | Layout |

GL Sort/Break. This formatting option is available only if you selected the Group transactions by General
Ledger receivable account information option on the Detail screen.

Use GL Sort/Break to select the order that information appears on the report and where breaks fall between
sets of information. When you select GL Sort/Break on the Format tab, a grid displays the categories you can
sort in the report. Select a sorting category in the Sort by column and select Ascending or Descending in the

Order by column.

In the Break Header for <Sort by category> frame, to create breaks between the sections you have sorted by,
you can mark the checkbox in the Break? column. In the Text before value and Text after value fields, you can
enter up to 30 characters in each field for information that prints immediately before and after each break.
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In the Break Footer for <Sort by category> frame, you can mark Print count per <Sort by category> or Print
count as percentage of total to print the information in the footer. To start a new page for the highest level
break, mark Page break on each new <Sort by category>.

A New Open Ttem Report I
File Edit View Favorites Tools Help
o3 daE a2 |
1: General 2 Format |
Headings GL Sort/Break
Criteria
Detail rt by I Order by IB!'&&'{?Iﬂ
B GL Sort 3 Account Number Ascending ¥
Page Footer ]
Fieport Footer r
Mizcelansous
Color Scheme ]
Transaction Sort/Break ] ;I
Break Header for Account Mumber-
Test before value: I
Tewt after walue: |
Break. Footer for Account Mumber-
[~ Fririt count per Sccount Mumber
[~ Pritit count a8 a percentage of botal
™| Page break on each rew Account Humber
< Back | [ et > | Cancel | Erint | Freview | Lapout |

Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align
the text. You can include the page number and date in the footer.

I new Open Ttem Report [ x| I
File Edit View Favorites Tools Help

a2 |

1: General 2: Farmat |

Headings Page Footer

Liiena Page Footer Text
Detail r

GL Sort/Break Teut:
8 Page Footer
Report Footer
Miscellaneous

Color Scheme Aliare ICenter vl
Transaction Sort/Break

[ Print Page Number in Footer

[~ Piint Report Date in Footer
Format: IF'age 1 j Format: IShDrt [Date and Time j
Hligre | Right =1 | | Aiane JLett =l

{ Back | Meqt s Cancel Frint Freview Layout
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Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to
align the text. The report footer appears at the end of the report.

A& New Open Ttem Report
File Edit View Favorites Toolzs Help

| a S A a2 2- |

1: General 2 Farmat |

GL Sort/Break
Page Faoter
:E Report Footer
Miscelaneous

Color Scheme
Trangaction Sort/Break

Headings Report Footer
Criteria 5 ——
Lretail eport Foaoter Tex

Text:

Align: ILeft vl

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

lﬂ New Open Item Report I
File Edit View Favorites Tools Help
eSS a2 |
1: General 2 Format |
Headings Miscellaneous
Criteria
Dretail Show currency character on All amounts
GL Sort/Break Show percent sign an All amounts
:age F?Dte' Megative amount format (1234.58)
4 b
epro Mumber of digits after decdimal for amounts 2
: 3neaus
Colar Scher Mumber of digits after decimal for percentages 2
Trarsaction Sort/Rreak | |Show 1000's separator Yes
Show blanks instead of zeros Mo
Font size 3
Sample amoLint;
Amount (51,234.56)
Percent 100.00%
< Back [ et 2 Cancel Erint Freview Lapout
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

A& New Open Ttem Report I
File Edit View Favorites Tools Help

e =a e |

1: General 2 Format |

Headings Color Scheme

Criteria

Detail [ Apply a Colar Scheme Report Name
E';gseo';:s;ak M Column heading back colar Subtitle

iscellaneou [” Group heading back color Group Headings
E Cio Efne

Tranzaction Sart/Break . Group heading fore color

Feztone Defaults |

< Back | [ ewt | Cancel | Erint | Freview | Lapout |

Transaction Sort/Break. Use Transaction Sort/Break to select the order for information to appear on the
report and where breaks fall between sets of information. When you select Transaction Sort/Break, a grid
displays categories you can sort in sections within the report. Select a sorting category in the Sort by column
and select Ascending or Descending in the Order by column. To create breaks between the sections you have
sorted by, you can mark the checkbox in the Break? column.

In the Break Header for <Sort by category> frame, in the Text before value and Text after value fields, you

can enter up to 30 characters in each field for information that prints immediately before and after each
break.
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In the Break Footer for <Sort by category> frame, you can mark Print count per <Sort by category> or Print
count as percentage of total to print the information in the footer. To start a new page for the highest level
break, mark Page break on each new <Sort by category>.

A New Open Ttem Report I
File Edit View Favorites Tools Help

e = e |

1: General 2 Format |

Headings Transaction Sort/Break

Criteria
Dretail Sort by | Order by | Break? Iﬂ
GL Sort/Break Payer Name Azcending

Page Footer Redpient Name Ascending
Fieport Footer

Mizcelansous
Color Scheme
(B Transact

i A

Break Header for Payer Mame:

Text before value: I

Tewt after value: |

Break Footer for Payer Mame:
[~ Print count per Payer Nare

[~ Print count as a percentage of batal

™ Page break on each new Paper Name

< Back [ ewt | Cancel | Erint Freview Lapout
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Reporting categories in Accounts Receivable include Action Reports, Analysis Reports, Bank Account Reports,
Client Reports, Deposit and Receipt Reports, Pivot Reports, Product and Billing Item Reports, and Transaction
Reports. This chapter discusses Transaction Reports. For information about other report categories, see the
chapter for that category. For information about Pivot Reports, see the Pivot Reports Guide for The Financial
Edge.

Note: We recommend you read the documentation for The Financial Edge thoroughly. Information presented
here provides you with basic information about transaction reports in Accounts Receivable. Hands-on
experience is the best way to learn, so we encourage you to try various options with your database.

Transaction Reports in Accounts Receivable include:
¢ Account Distribution Report

¢ Invoice Report

¢ Project Distribution Report

e Recurring Invoice Report

¢ Sales Tax Report

e Transaction List

¢ Unapplied Credit Report

Account Distribution Report

The Account Distribution Report lists debit and credit amounts, created by Accounts Receivable transactions and
adjustments, for accounts.

The Account Distribution Report has tabs on which you set parameters: General, Filters, and Format. To move
among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify
information to include in the report and how the report should look. For more information about creating a
report, see “Creating a report in Accounts Receivable” on page 10.
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General Tab

On the General tab, define parameters and select information to include in the report.

I New Account Distribution Report
File Edt “iew Favonter Tools Help

e e |

1. General |2: Filtersl 2 Formatl

Repart farmat: I Dietail j
Include tranzactions with these dates -
Tranzaction date: IInCludE all dates j
Post date: IInc:IucIe all dates j

[T Include adjustment transactions
¥ Include miscellaneous entries

[~ Create an output guerny of ICIientS "I
R eport arientation; ILandscape 'I

< Hack | Ment » | Cancel | Frint | Prewiew Layout

Report format. In the Report format field, select Detail or Summary.

Transaction date. In the Transaction date field, select a date or date range for the transactions to include in
the report.
If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is

included up to the end date. If the End date field is blank, all activity from the start date forward, including
transactions with a date in the future, is included. If both fields are blank, all activity is included.

Post date. In the Post date field, select a date or date range of post dates of transactions to include in the
report.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date forward, including
transactions with a post date in the future, is included. If both fields are blank, all activity is included.

Include adjustment transactions. You can include adjustment transactions.
Include miscellaneous entries. You can include miscellaneous entries.

Create an output query of []. If you mark Create an output query of, you can select for the program to create
a query of the included accounts, clients, charges, credits, invoices, returns, refunds, or payments. You can
use the query later in other areas of Accounts Receivable.

Report orientation. If you create the report in summary format, you can select Portrait or Landscape. If you
create the report in detail format, the report print in Landscape.
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Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Funds filter, only transactions in the selected funds appear in the report.

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the
Filtering Criteria chapter in the Program Basics Guide.

IQ Mew Account Distribution Report E
File Edit “iew Favortes Tools Help
CIEE IR |
1. General I 3 Furmatl
&0 0pen 7 Clear &l Filers
Filkets I Include Selected Filbers Iﬂ
Accounts Al <Al Accounts =
Funds All <&l Funds>
Deparkment(s) all <Al Department(s) =
Mlissinonis) all <Al Mission(s) =
spendable/Mon-5pendabl... Al <Al spendablef/Mon-3pendableis)=
Performancels) Al <Al Performancels) >
Classes Al <Al Classes >
Projects all <Al Projecks =
Account Attributes All <Al Account Atkributes =
Project Attribukes all <Al Project Attributes =
Clients Al <Al Clients =
Client Attributes all <all Client Attributes =
Charges Al <Al Charges = j
< Back | Mest » | Cancel | Frint | Prewiew | Layout |

Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you specify how the report looks. A description of each formatting option is provided.

Note: The heading defaults to Account Distribution Report in the Title field. You can leave this as the title for
your report or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

IE Mew Account Distribution Beport
File Edit “iew Fawvortes Toolz Help

S & =2

1 Generall 2: Filters 3 Farmat |

B esor

Criteria
Detsil — Heading Format
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Sort/Break Subit: |

Page Footer
Repart Foater Align: IEenter 'I
Miscellaneous
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[¥ Print report heading on each page

< Back et Cancel Frrint Freview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of
the report.

IE Mew Account Distribution Beport
File Edit “iew Fawvortes Toolz Help

SR el |

1 Generall 2: Filters 3 Farmat |
Headings

Criteria
E Criteria
Detail [v Fiint these criteria on Ia separate page 'I

Grand Totals

Saved report name -
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Page Footer Tranzaction dates ta include
Fepart Footer Post dates to include
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Color Scheme Include miscellaneous entries

Accounts to include

Funds to include

Department(z] to include =

Mizgion(g) to include
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< Back | (= Cancel Frrint Freview | Layout |
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Detail. Use Detail to select details specific to the Account Distribution report. If you mark Show
distribution for these characteristics, you can select the characteristics to include. If you choose
one characteristic, you can mark Show characteristic as a column in the main report body. The
marked characteristic appears as a separate column on the report. If you choose multiple

characteristics, you can choose Show transaction total. This prints the debit or credit total for each
line item.

Ig New Account Distribution Report E I
File Edit WYiew Favaorites Tools Help

RS R0 2 |

1: Genelall 2 Filkers 3 Format |

Haadings Detail
Criteria

[v Show distribution for these characteristics

Grand Tatals W Projest ID

Sart/Break [ Project Description

Page Footer [T Class

Report Footer [ Mission

Mizcellaneous [T Spendable/Mon-Spendable

Colar Scheme [T Performance L

Dawn

v Show characterstic as a column in the main report body
[ Show transaction tatal

< Back et = Cancel Frint Freview Layout
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Grand Totals. Use Grand Totals to show combined totals for transaction characteristics. If you have the optional
module Projects and Grants and have defined transaction codes, additional checkboxes appear. You can use
the Up and Down buttons to order the characteristics to appear on the report.

IE Mew Account Distribution Beport
File Edit “iew Fawvortes Toolz Help

SR el |

1 Generall 2: Filters 3 Farmat |

Headings Grand Totals

Criteria

Detail ¥ Shaw grand tatals for these characteristics

B Grand Totals

Sort/Break [ Project Descriptian

Page Footer [T Class

Report Foater [ Mission

Miscellaneous [ Spendable/Non-Spendable

Color Scheme [ Performance L
Down

< Back | | (= | Cancel | Frrint | Freview | Layout |

Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall
between sets of information.

To order the information, you can select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break?
for a category, fields are enabled for you to specify more information about the break for the selected sorting
category.

In the Text before value and Text after value fields, you can enter up to 30 characters to print directly before
and after the value for the selected sorting category.
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To print the number or percentage for the selected category in the footer, mark Print count per or Print
count as a percentage of total for the selected sorting category. To start the selected sorting category on a

new page, mark Page break on each new.

IE Mew Account Distribution Beport
File Edit “iew Faworites
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

lﬂ MHew Account Distribution Report
File Edit Help

B RE G - ?-

Yiew Faworter  Toolz

1 Generall 2 Filters 2 Farmat |

Page Footer

Headings
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Detail — Page Footer Text
Grand Totals Test:
Sort/Break

B Page Footer

Report Footer
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[ Print Page Murnber in Footer

[~ Print Report D ate in Footer
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< Back | THERt Cancel FErint Preview Layout




236 CHAPTER

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

n Mew Account Distribution Report
File Edit “iew Fawortes Toolz Help
H &= %W B

1 General] 2 Filterz 3 Format l

5] Headings Report Footer

] Criteria

5 Detail Report Footer Text

Z] Grand Totals Text:

2] Sort/Break

] Page Foater
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2] Color Scheme

< Back | | Cancel | Frrint | Freview | Layaut |

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

n Mew Account Distribution Report
File Edit “iew Fawvortes Toolz Help

H &S D W ?-

1 General] 2 Filters

] Headings Miscellaneous

] Criteria
=] Detail Show currency character an All amounts
E] Grand Totals Show percent sigh on All amaounts
=] Sort/Break Meqative amount format [1234.5E)
ﬂ EZizr't:ID:Etoet;r Mumber of digits after decimal for amounts 2
e Mumber of digits after decimal for percentages 2

Z] Color Scheme Show 1000'z zeparator Yes

Show blanks instead of zeroz Mo

Fant size 8

Sample amaunt;

Arnount [$1.234.56)
Percent 100.00%

< Back Cancel Frrint Freview Layaut
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

IE Mew Account Distribution Beport
File Edit “iew Fawvortes Toolz Help

SR el |
-

Headings Color Scheme

Criteria

Detail I Apply a Calor Scheme Report Name
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< Back | (= Cancel Frrint Freview Layout

Invoice Report

Use the Invoice Report to list invoice and return information.

The Invoice Report has tabs on which you set parameters: General, Filters, and Format. To move among the tabs,
click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to include
in the report and how the report should look. For more information about creating a report, see “Creating a
report in Accounts Receivable” on page 10.
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General Tab

On the General tab, define parameters and select information to include in the report.

& New Invoice Report
File Edt “iew Favonter Tools Help
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1. General |2: Filtersl 2 Formatl
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Include. In the Include field, select to include invoices or returns, or invoices and returns in the report.

Invoice or Return date. In the Invoice date or Return date field (depending on your selection in the Include
field), select a date or date range for the invoices or returns to include in the report.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date forward, including
transactions with a date in the future, is included. If both fields are blank, all activity is included.

Ordered on or Returned on date. In the Ordered on date or Returned on date field (depending on your
selection in the Include field), select a date or date range for the invoices or returns to include in the report.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date forward, including
transactions with a date in the future, is included. If both fields are blank, all activity is included.

Invoice or Return IDs from [ ] to [ ]. In the Invoice IDs from [ ] to [ ] or Return IDs from [ ] to [ ] field
(depending on your selection in the Include field), you can enter a range of invoice or return numbers to

include.

Create an output query of [ ]. If you mark Create an output query of, you can select for the program to
create a query of clients, invoices, or returns to include in the report. You can use the query later in other

areas of Accounts Receivable.

Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Client Attributes filter, only clients with the selected attributes appear in the report.

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the
Filtering Criteria chapter in the Program Basics Guide.

I& New Invoice Report E
File Edit “iew Favortes Tools Help
CIEE IR |

1. General IE: Furmatl

Filkers I Include Selected Filkers

Clients all <Al Clients=

Client Attributes all <Al Client Attribubes =

Invoices all <Al Invoices:

Invoice Attributes all <Al Invoice Attributes =

Print Statuses all <Al Print Statuses:=

Returns all <hll Returns =

Return Attributes all <Al Return Attributes =

Rekurn Ikem Statuses all <Al Return Ikem Statuses=

< Back | Mest » | Cancel | Frint | Prewiew | Layout

Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you specify how the report looks. A description of each formatting option is provided.

Note: The heading defaults to Invoice Report in the Title field. You can leave this as the title for your report or
enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

I New Invoice Report
File Edit “iew Fawvortes Toolz Help

S & =2

1 Generall 2: Filters 3 Farmat |

B esor

Criteria
Detsil — Heading Format

Grand Totals Title: Irrvaice Repart
Sort Sublite: |

Page Footer
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W Print Page Mumber in Heading [¥ Frirt Report Date in Heading
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[¥ Print report heading on each page

< Back et Cancel Frrint Freview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of
the report.

I New Invoice Report
File Edit “iew Fawvortes Toolz Help

RS0 w2
1 Generall 2: Filters 3 Farmat |
E Criteria

Detail [v Fiint these criteria on Ia separate page 'I

Grand Totals Saved report name

Sort Output querny name
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Invoices to include
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Print statuses to include
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< Back | | (= | Cancel | Frrint | Freview | Layout

Detail. Use Detail to show information specific to the Invoice Report.

Mark Show line item detail to see the description, unit of measure and quantity of each line item. If you
choose to show the line item detail, you can mark Show line item comment. This prints the comment defined
on the line item.
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If you have chosen to show line item detail, you can mark Show distribution for these
characteristics. If you choose one characteristic, you can mark Show characteristic as a column in
the main report body. The marked characteristic appears as a separate column on the report. If you
choose multiple characteristics, you can choose Show transaction total and Show receivables
account distribution. Show transaction total prints the total for each line item. Show receivables
account distribution prints the debit and credit distributions for each line item.

I Mew Invoice Report
File Edit %iew Favortes Toolz Help
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Headngs
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Grand Totals. Use Grand Totals to show combined totals for transaction characteristics. If you have the optional
module Projects and Grants and have defined transaction codes, additional checkboxes appear.

n Mew Invoice Report
File Edit “iew Faworites
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Sort. Use Sort to select the order for information to appear on the report. You can select a sorting category in the

Sort by column and select Ascending or Descending in the Order by column.

n Mew Invoice Report
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can

enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

I New Invoice Report

File Edit “iew Fawvortes Toolz Help
= Jie= R = e |
1 Generall 2: Filters 3 Farmat |
Headings Page Footer
Criteria
Detail — Page Footer Text
Grand Totals Text:
Sort

Report Foater

Miscellaneous Aligr: IEenter 'l

I Print Page Mumber in Footer ———— [~ Print Report Date in Footer —————
Format: IF'age 1 j Format: IShDrt Date and Time j
Aligre | Riht 2 [ 2 e =

< Back | | (= | Cancel Frrint | Freview | Layout |

Report Footer. You can enter a maximum of 254 characters in the report footer and select how to align the text.
The report footer appears at the end of the report.

1@ Mew Invoice Report

File Edit %iew Favortes Toolz Help
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

1@ New Invoice Report

File Edit

Yiew Faworites

Toolz Help
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Project Distribution Report

Use the Project Distribution Report to list debit and credit amounts, created by Accounts Receivable transactions
and adjustments, for projects.

The Project Distribution Report has tabs on which you set parameters: General, Filters, and Format. To move
among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify
information to include in the report and how the report should look. For more information about creating a
report, see “Creating a report in Accounts Receivable” on page 10.
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General Tab

On the General tab, define parameters and select information to include in the report.

A& New Project Distribution Report
File Edt “iew Favonter Tools Help
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Report format. In the Report format field, select Detail or Summary.

Transaction date. In the Transaction date field, select a date or date range for the transactions to include in the
report.
If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is

included up to the end date. If the End date field is blank, all activity from the start date forward, including
transactions with a date in the future, is included. If both fields are blank, all activity is included.

Post date. In the Post date field, select a date or date range of post dates of transactions to include in the
report.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date forward, including
transactions with a date in the future, is included. If both fields are blank, all activity is included.

Include adjustment transactions. You can include adjustment transactions.
Include miscellaneous entries. You can include miscellaneous entries.

Create an output query of [ ]. If you mark Create an output query of, you can select for the program to create
a query of the included projects, clients, charges, credits, invoices, returns, refunds, or payments. You can use
the query later in other areas of Accounts Receivable.

Report orientation. If you create the report in summary format, you can select Portrait or Landscape. If you
create the report in detail format, the report prints in Landscape.
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Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Funds filter, only transactions in the selected funds appear in the report.

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the
Filtering Criteria chapter in the Program Basics Guide.
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Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you specify how the report looks. A description of each formatting option is provided.

Note: The heading defaults to Project Distribution Report in the Title field. You can leave this as the title for
your report or enter your own.



248 CHAPTER

Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.
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Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the
report.
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Detail. Use Detail to select transaction characteristics for which to show distribution information. Mark Show
distribution for these characteristics to view distributions. If you choose one characteristic, you can mark
Show characteristic as a column in the main report body. The marked characteristic appears as a separate
column on the report. If you choose multiple characteristics, you can choose Show transaction total. Show
transaction total prints a separate line containing each selected characteristic showing the debit or credit
amount.
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Grand Totals. Use Grand Totals to show combined totals for transaction characteristics. If you have the optional
module Projects and Grants and have defined transaction codes, additional checkboxes appear. You can use
the Up and Down buttons to order the characteristics to appear on the report.
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Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall
between sets of information.

To order the information, you can select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break?
for a category, fields are enabled for you to specify more information about the break for the selected sorting
category.

In the Text before value and Text after value fields, you can enter up to 30 characters to print directly before
and after the value for the selected sorting category.
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To print the number or percentage for the selected category in the footer, mark Print count per or Print count
as a percentage of total for the selected sorting category. To start the selected sorting category on a new
page, mark Page break on each new.
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

n Mew Project Distribution Report
File Edit “iew Fawortes Toolz Help
H &= %W B

1 General] 2 Filterz 3 Format l

5] Headings Report Footer

] Criteria

5 Detail Report Footer Text

Z] Grand Totals Text:

2] Sort/Break

] Page Foater

I Repart Foater

2] Miscellaneous l—_|

2] Color Scheme

< Back | | Cancel | Frrint | Freview | Layaut |

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.
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Recurring Invoice Report

Use the Recurring Invoice Report to list information about recurring invoices.

The Recurring Invoice Report has tabs on which you set parameters: General, Filters, and Format. To move
among the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify
information to include in the report and how the report should look. For more information about creating a
report, see “Creating a report in Accounts Receivable” on page 10.
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General Tab

On the General tab, define parameters and select information to include in the report.
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Ordered on date. In the Ordered on date field, select a date or date range for invoices to include based on the
invoice order dates.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date forward, including
transactions with an order on date in the future, is included. If both fields are blank, all activity is included.

Next invoice date. In the Next invoice date field, select a date or date range for invoices to include based on
when the next invoice is scheduled.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date forward, including
transactions with a next invoice date in the future, is included. If both fields are blank, all activity is included.

Create an output query of [ ]. If you mark Create an output query of, you can select for the program to create
a query of clients or recurring invoices to include in the report. You can use the query later in other areas of
Accounts Receivable.

Report orientation. In the Report orientation field, select Portrait or Landscape.

Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Client Attributes filter, only clients with the selected attributes appear in the report.

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the
Filtering Criteria chapter in the Program Basics Guide.
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IE Hew Recurring Invoice Report
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Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you specify how the report looks. A description of each formatting option is provided.

Note: The heading defaults to Recurring Invoice Report in the Title field. You can leave this as the title for your
report or enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.
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Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the

report.
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Detail. Use Detail to select detail specific to this report. Mark Show line item detail to see category, item name,
description, unit of measure, quantity, unit price, discount and amount information about the recurring

invoice.
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If you choose to show line item detail, you can mark Show distribution for these characteristics. If you
choose one characteristic, you can mark Show characteristic as a column in the main report body. The
marked characteristic appears as a separate column on the report. If you choose multiple characteristics, you
can choose Show transaction total. Show transaction total prints an additional line containing each selected
characteristic with the debit or credit amount.
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Grand Totals. Use Grand Totals to show combined totals for transaction characteristics. If you have the optional
module Projects and Grants and have defined transaction codes, additional checkboxes appear.
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Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall
between sets of information.

To order the information, you can select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break?
for a category, fields are enabled for you to specify more information about the break for the selected sorting
category.

In the Text before value and Text after value fields, you can enter up to 30 characters to print directly before
and after the value for the selected sorting category.
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To print the number or percentage for the selected category in the footer, mark Print count per or Print count
as a percentage of total for the selected sorting category. To start the selected sorting category on a new

page, mark Page break on each new.
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.
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Sales Tax Report

The Sales Tax Report provides detailed or summarized information about sales tax transactions. This report can
be useful for auditing purposes to show the source and destination of all sales taxes.

The Sales Tax Report has tabs on which you set parameters: General, Filters, and Format. To move among the
tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to
include in the report and how the report should look. For more information about creating a report, see “Creating
a report in Accounts Receivable” on page 10.



264 CHAPTER

General Tab

On the General tab, define parameters and select information to include in the report.
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Report format. In the Report format field, select Detail or Summary. If you select Detail, the report shows every
transaction that incurred sales tax. If you select Summary, the report shows only the amount of sales tax that

is owed to each sales tax entity.

Show GL distribution to each sales tax entity. If you select Summary in the Report format field, you can
select to include a summary of the GL distribution.

Transaction date. In the Transaction date field, select a date or date range for the transactions to include in the
report.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date forward, including
transactions with a date in the future, is included. If both fields are blank, all activity is included.

Post date. In the Post date field, select a date or date range of post dates of transactions to include in the
report.
If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is

included up to the end date. If the End date field is blank, all activity from the start date forward, including
transactions with a post date in the future, is included. If both fields are blank, all activity is included.

Create an output query of [ ]. In Create an output query of field, you can select for the program to create a
qguery of the clients, charges, credits, or products and billing items included in the report. You can use the

query later in other areas of Accounts Receivable.
Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Client Attributes filter, only clients with the attributes you select appear in the report.

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the
Filtering Criteria chapter in the Program Basics Guide.
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Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you specify how the report looks. A description of each formatting option is provided.

Note: The heading defaults to Sales Tax Report in the Title field. You can leave this as the title for your report
or enter your own.



266 CHAPTER

Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.
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Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the

report.
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Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall
between sets of information.

To order the information, you can select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break?
for a category, fields are enabled for you to specify more information about the break for the selected sorting
category.

In the Text before value and Text after value fields, you can enter up to 30 characters to print directly before
and after the value for the selected sorting category.
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To print the number or percentage for the selected category in the footer, mark Print count per or Print count

as a percentage of total for the selected sorting category. To start the selected sorting category on a new
page, mark Page break on each new.
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can

enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

i@ Mew Sales Tax Report
File Edit %iew Favortes Toolz Help

eI el |

1 Generall 2 Filters 2 Farmat |

Headings Page Footer

Liltera Page Footer Text
Sort/Break, B

B Page Footer Text:
Report Footer
Miscellansous
Colar Scheme

Aligr: IEenter 'I

[ Print Page Murnber in Footer

[~ Print Report D ate in Footer
Format: IF'age 1 j Farmat: IShDrt Date and Time j
Aligre [ Right Bl || Al L =
< Back | THERt Cancel FErint Preview Layout
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

i@ Mew Sales Tax Report
File Edit “iew Fawvortes Toolz Help
EH &E %W & =

1 General] 2 Filterz 3 Format l

5] Headings Report Footer

] Criteria
5] Sort/Break Report Footer Text
2] Page Foater Text:

I Repart Foater

2] Mizcellaneous
] Color Scheme

< Back | | Cancel | Frrint | Freview | Layaut |

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

i@ Mew Sales Tax Report
File Edit “iew Fawvortes Toolz Help
EH &E %W & =

1 General] 2 Filters

] Headings Miscellaneous

] Criteria
=] Sort/Break Show currency character an All amounts
Z] Page Footer Show percent sigh on Al amounts
=] Report Footer Meqative amount format [1234.5E)
) Color Scheme Mumber of digits after decimal for amounts 2

Mumber of digits after decimal for percentages 2

Show 1000'z zeparator Yes

Show blanks instead of zeroz Mo

Fant size 8

Sample amaunt;
Arnount [$1.234.56)
Percent 100.00%

< Back Cancel Frrint Freview Layaut
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

I3 Mew Sales Tax Report
File Edit “iew Fawvortes Toolz Help

S & =2

1 Generall 2: Filters 3 Farmat |

Headings Color Scheme

Criteria
Sart/Break ™ &pply a Color Scheme Report Name
Pane Footer M Column heading back colar Subtitle

Fiepart Footer

[~ Group heading back colar Group Headings

. Group heading fore color

Hrestore [Vefaults |

< Back | (= Cancel Frrint Freview Layout

Transaction List

The Transaction List report provides a list of transactions for selected clients, over a selected period of time.

The Transaction List has tabs on which you set parameters: General, Filters, and Format. To move among the
tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to
include in the report and how the report should look. For more information about creating a report, see “Creating
a report in Accounts Receivable” on page 10.
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General Tab

On the General tab, define parameters and select information to include in the report.

M New Transaction List
File Edt “iew Favonter Tools Help

e e |

1. General |2: Filtersl 2 Formatl

Include transactions with these dates -

Tranzaction date: IInCIude all dates -

Due date: IIncIude dlldates x|
Fost date: IInc:IucIe all dates j

Include theze tranzaction types: .

W Charges
¥ Creditz
W Payments
W Irvaices
W Retumns
¥ Refunds
[T Only include finance and late charge tranzactions
I~ Only include transactions with amounts greater than | 30,00 H

[~ Create an output guerns of IEIients "I
Report anentation: IPnrtrait 'I

< Hack | Ment » | Cancel | Frint | Prewiew | Layout |

Include transactions with these dates. In this frame, you can select a date or date range for the

transactions to include in the report. Make your selections in the Transaction date, Due date, and Post dates
fields.

Note: Due dates apply only to charges and invoice line items.

If you select <Specific range>, specify start and end dates. If the Start date field is blank, all activity is included
up to the end date. If the End date field is blank, all activity from the start date forward, including transactions
with a date in the future, is included. If both fields are blank, all activity is included.

Include these transaction types. In this frame, you can select specific transactions to include in the report.
Mark the checkboxes for the transaction types to include in the report.

Note: You can use the Transaction List as a finance and late charge report.

You can mark Only include finance and late charge transactions to include only the transactions with finance
or late charge billing items. You can mark Only include transactions whose amounts are greater than [ ] and
designate a minimum amount to include. All transactions less than or equal to the amount you enter are
excluded from the report.

Create an output query of [ ]. If you mark Create an output query of, the program creates a query of clients,
charges, credits, invoices, returns, refunds, or payments included in the report. You can use the query later in
other areas of Accounts Receivable.

Report orientation. In the Report orientation field, select Portrait or Landscape.
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Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Credits filter, only credits you select appear in the report.

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the
Filtering Criteria chapter in the Program Basics Guide.

I New Transaction List
File Edit ‘“iew Favortes Took Help
== RN = |

1: General :

@ 0pen ) Clear All Filters

Filkers I Include Selected Filters

Clients Al <Al Clients =

Client Attributes Al <Al Client attributes =

Credits Al <l Credits =

Payments Al <Al Pavments =

Charges All <Al Charges=

Inwoices Al <Al Invoices =

Returns Al <hll Returns=

Refunds Al <Al Refunds >

Transaction Attributes Al <Al Transaction Attributes =

Post Statuses Al <hll Post Statusess

Products and Billing Ikems All <Al Products and Billing Ikems >

Product and Billing Tkem At... Al <Al Praduct and Billing Iterm Atkribubes =

< Back | Ment » | Cancel | Print | Presigwm | Layaut

Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Format Tab

On the Format tab, you specify how the report looks. A description of each formatting option is provided.

Note: The heading defaults to Transaction List in the Title field. You can leave this as the title for your report or
enter your own.
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Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

I Mew Transaction List
File Edit “iew Fawvortes Toolz Help

IR Tl |

1 Generall 2: Filter

B esor

Criteria
Detsil — Heading Format
Grand Total: Title: | Transaction List
Sort/Break Subit: |

Page Footer
Repart Foater Align: IEenter 'I
Miscellaneous

Coalar Schemes [¥ Print organization name in header

W Print Page Mumber in Heading [¥ Frirt Report Date in Heading
Format: IF'age 1 j Format: IShDrt Date and Time j
Mligr: [ Right =l signe [Lett =l

[¥ Print report heading on each page

< Back et Cancel Frrint Freview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on
the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the
report.

I Mew Transaction List
File Edit “iew Fawvortes Toolz Help

SR el |
!

Headings Criteria

E Criteria
Detail [v Fiint these criteria on Ia separate page 'I

Grand Totals

1 Generall 2: Filters

Saved report name -
Sart/Break Output querny name =
Page Faoter Trangzaction dates to include
Report Footer Due dates to include
Miscellaneous Fost dates to include
Calor Scheme Transaction types to include

Only include finance and late charges

Orly inchude transactions with amounts greater than
Clients ta include

Client attributes to include

Credits to include

Payrents to include

Charges to include

Invoices to include

Returns to inchude

Fefunds ta include LI

< Back | | (= | Cancel | Frrint | Freview | Layout |

Detail. Use Detail to select details specific to the Transaction List.

To show payer information for each client instead of summary information, mark Show payer
responsibility. If you mark Show payer responsibility, you can select to Separate columns for
charges and credits. Marking this prints separate columns instead of one column with charges as
positive amounts and credits as negative amounts. To include a summary of charges and credits
associated with each billing item, you can mark Print summary for products and billing items. If you
mark this option, a chart prints at the end of the report listing each billing item and the number of
transactions associated with it.

If you mark Show distribution for these characteristics, you can select the characteristics to include.
If you choose one characteristic, you can mark Show characteristic as a column in the main report
body. The marked characteristic appears as a separate column on the report. If you choose multiple
characteristics, you can choose Show transaction total and Show receivables account distribution.
Show transaction total prints the total for each line item. Show receivables account distribution
prints the debit and credit distributions for each line item.
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In the Client Salutation field, select how to display client names on the report. Salutations are

defined in Configuration.

n Mew Transaction List
File Edit “iew Fawvortes Toolz Help

H &2 %W ?-

1 Generall 2: Filters

2 Hesdrgs
=] Criteria
[~ Show payer responsibility
5] Grand Totals [ Separate columng for charges and credits
] Sort/Break [ Print suromary for products and billing items
5] Page Faoter [ Shaw distribution for these characteristics
2] Report Footer -
2] Miscellaneous
] Color Scheme
[

-

=

=

Client Salutation: |Client hame ﬂ
< Back | | Cancel | Frrint | Freview | Layout |

Grand Totals. Use Grand Totals to show combined totals for transaction characteristics. If you have the optional

module Projects and Grants and have defined transaction codes, additional checkboxes appear. You can use

the Up and Down buttons to order the characteristics to appear on the report.

i@ Mew Transaction List

File Edit “iew Favorites Toolz Help
= RN E- = B

1 General] 2: Filters

=] Headings Grand Totals
Z] Criteria

5] Detail [ Show grand totals for these characteristics

I Grand Totals s
2] Sort/Break
2] Page Footer
2] Report Footer
2] Miscellaneous
=

] Color Scheme

< Back Cancel FErint Preview Layout
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Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall
between sets of information.

To order the information, you can select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break?
for a category, fields are enabled for you to specify more information about the break for the selected sorting

category.

In the Text before value and Text after value fields, you can enter up to 30 characters to print directly before

and after the value for the selected sorting category.

To print the number or percentage for the selected category in the footer, mark Print count per or Print count
as a percentage of total for the selected sorting category. To start the selected sorting category on a new
page, mark Page break on each new.

I Mew Transaction List
File Edit “iew Faworites

Toolz Help

S & =2

1: General I 2 Filters §F0rma

Headings Sort/Break
Criteria
Detail Sart by | Order by | Breakz |
Grand Totals Activity for Azcending v
r
Page Footer r
Report Foater
Miscellaneous r
Colar Scheme r
Break Header for Activity for-
Text before value: |
Tewut after walue: I
Break Footer far Activity for-
[~ Print count per Activity for
[~ Print count as a percentage of total
™ Page break on each new Activity for
< Back et | Cancel | Frrint Freview Layout
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Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

I Mew Transaction List
File Edit “iew Fawvortes Toolz Help
H a3k == |
1 Generall 2: Filters ]
Headings Page Footer
Criteria
Detail — Page Footer Text
Grand Totals Text:
Sort/Break

Report Foater

Miscellaneous Aligr: IEenter 'l
Color Scheme

I Print Page Mumber in Footer ———— [~ Print Report Date in Footer —————
Format: I Fage 1 j Format: IShDrt Date and Time j
Aligre | Riht 2 [ 2 e =

< Back | | (= | Cancel | Frrint | Freview | Layout |

Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

I Mew Transaction List
File Edit %iew Favortes Toolz Help

eI el |

1 Generall 2: Filters

Headings Report Footer
Criteria

Detail Report Footer Text
Grand Totals Test:

Sort/Break

Page Footer

B Feport Footer

Mizcellaneous Align: ILeft 'I
Color Scheme

< Back | THERt Cancel FErint Preview Layout
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Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

i@ Mew Transaction List x|
File Edit “iew Favorites Toolz Help

S = el |

1 Generall 2: Filters

Headings Miscellaneous
Criteria

Detail Show currency character an All amaunts
Grand Totals Show percent sign an All amounts
Sort/Break Megative amount farmat [1234.56)

Page Footer

Report Foater Mumber of digits after decimal for amaunts 2

; N Mumber of digits after decimal for percentages 2
Colar Scheme Show 1000%: separator Tes
Show blanks instead of zeros Mo

Font size 2

Sample amaunt:

Amount [$1.234.56)
Percent 100.00%
< Back | Herts | Cancel | FErint | F'levieyl Layout |

Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

I Mew Transaction List
File Edit “iew Fawvortes Toolz Help

S & =2
:

Headings Color Scheme
Criteria

1 Generall 2: Filters

Diatail [ Apply a Color Scheme Report Name
g;?ﬂg;;fh . Column heading back color Subtitle

Feport Footer
Miscellaneous

[ Group heading back calar Group Headings

. Group heading fore color

Hiestore [Wefaults |

< Back et Cancel Frrint Freview Layout
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Unapplied Credit Report

The Unapplied Credit Report provides a list of payments and credits that have not been applied to a charge.

The Unapplied Credit Report has tabs on which you set parameters: General, Filters, and Format. To move among
the tabs, click Next and Back at the bottom of the screen or select a tab. On these tabs you specify information to
include in the report and how the report should look. For more information about creating a report, see “Creating
a report in Accounts Receivable” on page 10.

General Tab
On the General tab, define parameters and select information to include in the report.
Ig Hew Unapplied Credit Report

File Edit “iew Fawvoiter Tools Help

EH &2 %W i

1. General ]g: Filters] K3 Formatl

Ihiciude credits and payments with these dates

Transaction date: |Inc:|uc|e all dates ﬂ

Post date: |Inc:|uc|e all dates ﬂ

Inciude unapplied

[v Credits

v Payrients

[ Only include transactions with an unapplied amount greater than (40,00 Frri
Include account balance as of: |T-:n:|ay ﬂ 0941242002

[~ Create an output query of
Fepart arientation: | Fortrait 7

| Mest » ‘ Cancel | Frint Prewiew Layout |

Include credits and payments with these dates. In this frame, you can select a date or date range for
unapplied credit transactions to include in the report. Make your selection in the Transaction date and Post
date fields.

If you select <Specific range>, specify start and end dates. If you leave the Start date field blank, all activity is
included up to the end date. If you leave the End date field blank, all activity from the start date forward,
including transactions with a date in the future, is included. If you leave both fields blank, all activity is
included.

Include unapplied. In this frame, mark Credits, Payments, or Only include transactions with an unapplied
amount greater than [ ] and enter the minimum amount to include. All unapplied amounts less than or equal
to the amount you enter are excluded from the report.

Include account balance as of [ ]. You can calculate the account balance up to a date you specify in the
Include balance as of [ ] field.

Create an output query of clients. If you mark Create an output query of clients, the program creates a
query of clients included in the report. You can use the query later in other areas of Student Billing.
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Note: Click Preview to view the report as it will print using your selections and filters. Click Layout to view a
sample layout of the report without data.

Report orientation. In the Report orientation field, select Portrait or Landscape.

Filters Tab

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Credits filter, only credits you select appear in the report.

On the Filters tab, you can filter the records appearing in the report. For more information about filtering, see the
Filtering Criteria chapter in the Program Basics Guide.

IQ Mew Unapplied Credit Report E
File Edit “iew Favortes Tools Help
eI |
IE: Furmatl
Filkers I Include Selected Filkers
Clients all <Al Clients=
Client Attributes all <Al Client Attribubes =
Credits all <hll Credits =
Payrments all <Al Payments
Post Statuses all <Al Post Statuses=
Products and Biling Items all <Al Products and Billing Items >
Product and Biling Itemn Ak, All <l Product and Biling Item Aktribubes =
< Back | Mext » | Cancel | Brint | Preview Layout

Tip: You can double-click a filter in the grid to open the selection screen.

Open. Select a filter in the grid and click Open on the action bar to access the selection screen where you can
select specific filters for the report.

Clear All Filters. Click Clear All Filters to remove all previously selected filters from the report.

Glossary: A filter is a requirement records must meet to be included in a report. For example, if you apply the
Post statuses filter, only post statuses you select appear in the report.

Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
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On the Format tab, you specify how the report looks. A description of each formatting option is provided.

Note: The heading defaults to Unapplied Credit Report in the Title field. You can leave this as the title for your

report or enter your own.

Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

lﬂ Mew Unapplied Credit Report
File Edit “iew Fawotes Toolz

B RE G - ?-

Help

1 Generall 2 Filters 2 Farmat |

B Headings H eadings

Criteria :

Detail — Heading Format

Sart/Break Title: |Unapplied Credit Fieport
Page Footer Cubitle: I

Report Footer
Miscellansous
Colar Scheme

Aligr: IEenter 'I

[¥ Print organization narme in header

W Print Page Murmber in Heading

[¥ Frirt Report Date in Heading

Farmat: IF'age 1 j Farmat: IShDrt Date and Time j
Align:  [Right =l i [Lett =l
[¥ Print report heading on each page
< Back | THERt Cancel | FErint | Preview | Layout |

Note: The program automatically selects all criteria. Unmark the checkbox for any you do not want to print on

the report.
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Criteria. Use Criteria to print data to help you remember the criteria you used to create the report. Mark Print
these criteria on and select a separate page or the first page. Your selections print in the criteria section of the
report.

IE Mew Unapplied Credit Beport
File Edit “iew Fawvortes Toolz Help

RS0 w2
1 Generall 2: Filters 3 Farmat |

Headings Criteria

E Criteria

Diatail v Frint these criteria on Ia separate page 'I
Sort/Bresk Saved report name

Fage Foater Dutput query name

Report Faater Tranzaction dates bo include

Mizcellaneous Past dates to include

Calar Scheme Inciude unapplied credits

Include unapplied payments

Include credits and payment which have an unapplied amount greater than
Include account balance as of date

Clients ta include

Client attributes to include

Credits to include

Payrents to include

Charges to include

Post ztatuses to include

< Back | | (= | Cancel | Frrint | Freview | Layout

Detail. Use Detail to select details specific to the Unapplied Credit Report.

In the Display data by field, you which data to appear in the first column of the report. You can select
Payments/Credits or Payments/Credits by. You can mark Show payment/credit detail to include details of
payments and credits.
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In the Client Salutation field, select how to display client names on the report. Salutations are
defined in Configuration.

n Mew Unapplied Credit Beport
File Edit “iew Fawvortes Toolz Help

H &2 %W ?-

1 Generall 2: Filters 3 Farmat l

] Headings Detail
=] Criteria
Diplay data by:

) Grand Total |F'a_l,lments.f’Eredits far ﬂ ¥ Show payment/credit detail
rand Tatals

2] Sort/Break
] Page Footer
2] Report Footer
2] Miscellaneous
] Color Scheme

Client 5 alutation: |Salutation 1 ﬂ

< Back | | Cancel | Frrint | Freview | Layout |

Grand Totals. Use Grand Totals to show combined totals for transaction characteristics. If you have the optional
module Projects and Grants and have defined transaction codes, additional checkboxes appear. You can use
the Up and Down buttons to order the characteristics to appear on the report.

n Mew Unapplied Credit Report
File Edit “iew Favorites Toolz Help

H &2 LW ?-

1 General] 2: Filters  2: Farmat l

5] Headings Grand Totals

Z] Criteria

] Detail Iv Shaw grand totals for these characteristics

B Grand Totals Aceount 1D

2] Sort/Break [T Account Description

2] Page Footer [ Project ID

2] Report Footer [ Project Description

2] Miscellaneous [ Class u

=] Color Scheme [ Mission 2
[ Spendable/Mon-Spendable ﬂ Drawsary

< Back Cancel FErint Preview Layout
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Note: To have one line per transaction on the report, do not select any sorting categories or options in the sort
grid.

Sort/Break. Use Sort/Break to select the order for information to appear on the report and where breaks fall
between sets of information.

To order the information, you can select a sorting category in the Sort by column and select Ascending or
Descending in the Order by column.

To create breaks, you can mark the checkbox in the Break? column for a sorting category. If you mark Break?
for a category, fields are enabled for you to specify more information about the break for the selected sorting
category.

In the Text before value and Text after value fields, you can enter up to 30 characters to print directly before
and after the value for the selected sorting category.

To print the number or percentage for the selected category in the footer, mark Print count per or Print count
as a percentage of total for the selected sorting category. To start the selected sorting category on a new
page, mark Page break on each new.

Page Footer. Use Page Footer to create a footer to appear at the bottom of each page of the report. You can
enter a maximum of 254 characters in the Text field for the page footer. You can also select how to align the
text and include the page number and date in the footer.

lB Mew Unapplied Credit Report [ ]

File Edit “iew Fawvortes Toolz Help
SR -2 |

1 Generall 2 Filterz 3 Format |

Headings Page Footer

Citeria Page Footer Text
Detail B

Sort/Break Text:
B Page Foater
Report Foater
Miscellaneous

Color Scheme Align: I[:enter 'l

[ Print Page Mumber in Footer

[~ Print Report Date in Footer
Format: IF'age 1 j Farmat: IShort Date and Time j
Aligr: IHight j Aligr: ILeft j

< Back Hewts Cancel Frint Preview Lapout
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Report Footer. Use Report Footer to create a footer to appear at the bottom of the last page of the report. You
can enter a maximum of 254 characters in the Text field for the report footer and select how to align the text.

n Mew Unapplied Credit Report
File Edit “iew Fawvortes Toolz Help
EH &E %W & =

1 General] 2 Filterz 3 Format l

=] Headings Report Footer

] Criteria

5 Detail Report Footer Text

Z] Sort/Break Text:

2] Color Scheme l—_|

< Back | | Cancel | Frrint | Freview | Layaut |

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and set the font size.

n Mew Unapplied Credit Report
File Edit “iew Fawvortes Toolz Help

H &S D W ?-

1 General] 2 Filterz 3 Format l

] Headings Miscellaneous
] Criteria

=] Detail Show currency character on All arnounts
E] Grand Totals Show percent sigh on All amaounts
=] Sort/Break Megative amount format [1234.5E)
] Pags Footer Mumnber of digits after decimal for amounts 2

] Feport Footer

T Murnber of digits after decimal for percentages 2
5] Color Scheme Show 1000'z zeparator Yes
Show blanks instead of zeroz Mo

Fant size 8

Sample amaunt;

Arnount [$1.234.56)
Percent 100.00%

< Back Cancel Frrint Freview Layaut
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Color Scheme. Use Color Scheme to select colors for report headings. When you click in the color box next to
the selection, the Color screen appears so you can select a standard color or define a custom color. If you
leave the Apply a Color Scheme checkbox unmarked, the report prints in black and gray.

IE Mew Unapplied Credit Beport
File Edit “iew Fawvortes Toolz Help

S & =2

1 Generall 2: Filters 3 Farmat |

Headings Color Scheme

Criteria
Cetail [ Apply a Color Scheme Report Name
ﬁz-r_::;BFrzz:er . Columnn heading back color Subtitle
Report Foater I_ Column heading fore caolor _
ellenus [T Group heading back color Group Headings
. Group heading fore color
Festare [efaults |

< Back | (= Cancel Frrint Freview Layout

EFT Report

The EFT Report provides a detailed view of any EFT files created from Accounts Receivable. You can use this
report to review and archive payroll EFT transactions for your school.

The EFT Report has tabs on which you set parameters: General and Format. To move among the tabs, click Next
and Back at the bottom of the screen or select a tab. On these tabs you specify information to include in the
report and how the report should look. For more information about creating a report, see “Creating a report in
Accounts Receivable” on page 10.
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General Tab

On the General tab, define parameters and select information to include in the report.

I3 Mew EFT Report !
File Edt “iew Favontes Toolz Help
dadaE a4 2-

1: General ]g: Format]

SEIECt an EFT F|IE Name ..................................................................................................................................................
EFT file name : | ______J

Tl BT e s Dielion Uking Wﬁ e

i Logon Card Mumber | Logon Card Length

[¥ Thiz EFT file was created with a camiage return/line feed

R eport Orientation: Portrait

| Hewt » I Cancel | Print J Preview Layout

Press F7 to browse the file

Select an EFT File Name. In the Select an EFT File Name frame, enter the name of the EFT file or click the
binoculars to search for the file to include in the report.

Note: Click Preview at any time to view the report as it will print using your selections and filters. Click Layout
to view a sample layout of the report without data.

This EFT File Was Created Using [ ] Logon Cards. If logon cards were used to create the EFT file, in this
field, select the number of cards.

This EFT file was created using a carriage return/line feed. If the EFT file was created using a carriage
return or line feed, mark the checkbox.

Format Tab

On the Format tab, you select how the report will look. The list on the left of the screen displays formatting
options for the EFT Report. When you select an item in the list, the right side of the screen displays selections for
that section of the report.

Note: The heading defaults to EFT Report in the Title field. You can leave this as the title for the report or enter
your own.
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Headings. Use Headings to enter a maximum of 60 characters in the Title and Subtitle fields. The title and
subtitle appear at the top of the report. You can select how to align the heading and whether to include your
organization’s name in the header. You can include the page number and date in the heading. You can also
select to include the heading on every page of the report.

I3 Mew EFT Report I
File Edt “iew Fawortes Toolz Help

B adam =2 |

1: General

Headings
Criteria 5
Page Footer — Heading Format
Report Footer Title:  [EFT Repart

Miscellaneaus

Subtitle: I

Align: I Center i I

[¥ Print organization narne in header

¥ Print Page Number in Heading ¥ Print Report Date in Heading
Format: IF'age 1 j Format: I Short Date and Time j
Align: |Right =] | A JLet =]

¥ Print report heading on each page

< Back | [dEnts Cancel Print Freview Layout

Note: The program automatically selects all criteria. Unmark the checkbox for any criteria that should not
print on the report.
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Criteria. Use Criteria to print data to help you remember the criteria you use to create the report. Mark Print

these criteria on and select a separate page or the first page. Your selections print in the criteria section of the
report.

M@ Hew EFT Report I
File Edt “iew Fawaortes Toolz Help

dads 42 |

1: General 2: Format |

| Criteria
B Cier: [opooerose ]
Fage Foater [V Print these criteria on | a separate page e

Hl.Elel Faoter Saved report name
Miscellaneaus

EFT file name

< Back | [dEnts | Cancel | Print | Freview | Layout |

Page Footer. Use Page Footer to enter a maximum of 254 characters in the page footer and select how to align
the text. You can include the page number and date in the footer.

I Mew EFT Report I
File Edit Wiew Favorites Tools Help
dadam o ?- |
1: General 2 Format |
Headings Page Footer
Criteria
‘B Page Footer — Page Footer Text
Fiepart Foater Tent:

Miscelaneous

Aligr: I Center i I

= Print Page Mumber in Footer

[ Print Repart Date in Footer
Format: IF'age 1 j Farmat: I Short Date and Time j
Aligre | Fiight = || e Lot =
< Back | [Hexts Cancel Print Preview Layout
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Report Footer. Use Report Footer to enter a maximum of 254 characters in the report footer and select how to
align the text. The report footer appears at the end of the report.

I Mew EFT Report ’
Fil= Edit Wiew Favortes Tools Help
IR

1: General 2 Format ]

Report Footer

_-| Page Footer g--Heport Footer Text
= Text;

Report Footer
_'| Miscellaneous

< Back 1 [dEwEs j Cancel | Frrint J Preview ] Layout 4

Miscellaneous. Use Miscellaneous to specify how numbers appear on the report and to set the font size.

n Mew EFT Report ’
File Edit “iew Fawortes Toolz Help
= =l

1. General 2 Format ]

Miscellaneous

Show currency character on All amounts
[ Show percent sign on All amounts
Meqgative amount Format (1234.56)

Murnber of digits after decimal For amounts 4

Murmber of digits after decimal For percertages 2

Show 1000's separatar Yes

Show blanks instead of zeros Mo

Font size g

Sample amount;
Arnount ($1,234.56)
Percent 100, 00%

< Back ‘ [dEnt Caticel Erint J Freview Lapout
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